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La Bibliothèque Mary Baker Eddy 

Chronologie des événements jalonnant la vie de Mary Baker Eddy 

1821, 16 juillet  Naissance de Mary Morse Baker, un lundi, dans une ferme du New 
Hampshire, près du fleuve Merrimack, à Bow, une petite commune rurale, 
proche de Concord, dans le New Hampshire.1 Elle est la fille d’Abigail 
Ambrose (née le 18 avril 1784)2 et de Mark Baker (né le 2 mai 1785).3  

Ses parents se sont mariés en mai 1807.4 Elle est la plus jeune de leurs six 
enfants – trois garçons (Samuel Dow, 8 juillet 1808 ; Albert, 5 février 
1810 ; George Sullivan, 7 août 1812), et trois filles (Abigail Ambrose,  
15 janvier 1816 ; Martha Smith, 19 janvier 1819 ; et Mary).5 

1822-1829 Mark Baker remplit la fonction de secrétaire de l’Union Church à Bow.6 

1829-1830 Mary Baker Eddy affirme entendre une voix inconnue l’appeler par son 
prénom. Ce phénomène se reproduit durant une période de douze mois. 
Mehitable Huntoon, une cousine de Mary âgée de 24 ans, entend 
également cette voix.7 Mehitable (née le 2 mai 1806) est la fille d’Hannah, 
sœur de Mark Baker.8 

1831, 26 avril Mark et Abigail Baker deviennent officiellement membres de l’Eglise 
congrégationaliste de Concord.9 

1832, 20 mars Samuel, frère de Mary, épouse Eliza Ann Glover,10 sœur de George 

                                                
1 Mary Baker Eddy, Rétrospection et Introspection, publié à l’origine en anglais avec le titre Retrospection and 
Introspection (Boston: Trustees Under the Will of Mary Baker Eddy, 1920), 5. 
2 Registre des actes de naissance du New Hampshire, 1659-1900 ; emplacement dans la Collection de la Bibliothèque 
Mary Baker Eddy : Subject file, Eddy, Mary Baker – Family – Bakers – Abigail A. Baker. 
3 Reverend M. T. Runnels, History of Sanbornton, New Hampshire [Histoire de Sanbornton, New Hampshire], 
tome 2 (Boston: Alfred Mudge & Son, 1881), 16. 
4 Ibid., 17. 
5 Registre des actes de naissance et de décès des enfants de Joseph Baker et de Mark Baker, ville de Bow, New 
Hampshire ; Subject file, Eddy, Mary Baker – Family – Maurice E. Waldron Material. 
6 Archives de l’Union Church of Christ à Bow, New Hampshire, 1806-1829, Longyear Museum, Chestnut Hill, 
Massachusetts. 
7 Mary Baker Eddy, Rétrospection, 8-9. 
8 Index du Registre des actes de décès et d’inhumation, 1654-1949 ; Subject file, Eddy, Mary Baker – Ancestry – 
Genealogical Notes – White Family – McNeill – Huntoon – Baker. 
9 Manual of the First Congregational Church [Manuel de la première Eglise congrégationaliste] (Concord, NH: 
Independent Press Association, 1871) 33 ; Subject File, Eddy, Mary Baker – Family – Bakers – Mark Baker. 
10 Registre des actes de mariage, 20 mars 1832 ; Subject File, Eddy, Mary Baker – Family – Bakers – Samuel Dow 
Baker. 
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Washington Glover, futur époux de Mary, dont celle-ci fait la 
connaissance lors de ce mariage. Samuel divorce d’Eliza pour abandon  
du domicile conjugal en 1857.11 

1834 Son frère, Albert, se diplôme au Dartmouth College (où il est entré en 
1830).12 

1835, 27 janvier  Mort de sa grand-mère, Mary Ann Moore Baker (à 91 ans).13 Elle vivait 
chez les Baker, à Bow. Son grand-père, Joseph Baker, était décédé en 
1816.14 

1835 juillet Son frère, George, quitte la maison de Bow pour s’installer dans le 
Connecticut.15 

1836, 11 janvier La famille Baker emménage dans une ferme près de Sanbornton Bridge.16 

(Sanbornton Bridge sera rebaptisé Tilton en juin 1869.)17 

1837  C’est durant cette année qu’elle a indiqué avoir commencé à écrire pour 
des journaux.18 Mark Baker est élu au Conseil d’administration de la 
Sanbornton Academy (l’une des écoles locales). Il est président du Conseil 
d’administration pendant trois ans et démissionne en 1847.19 

1837, 27 juillet  Sa sœur, Abigail, épouse Alexander Hamilton Tilton.20 

1838, 17 juin Mark et Abigail Baker deviennent membres de l’Eglise congrégationaliste 

                                                
11 Libelle de divorce ; Subject File, Eddy, Mary Baker – Family – Bakers – Samuel Dow Baker. 
12 Catalogus Collegii Dartmuthensis (Boston: Typis Perkins Et Marvin, 1837), 30 ; Subject File, Eddy, Mary Baker – 
Family – Bakers – Albert Baker. 
13 Genealogical and Family History of the State of New Hampshire [Histoire généalogique et familiale de l’Etat du 
New Hampshire], vol. 1 (New York: The Lewis Publishing Company, 1908), 115 ; Subject file, Eddy, Mary Baker – 
Family – Bakers – Joseph Baker. 
14 Ibid. 
15 Albert Baker et Abigail Baker Tilton à George Sullivan Baker, 1er août 1835, Baker Family Letters [Lettres de la 
famille Baker], Longyear Museum ; Martha S. Baker à George Sullivan Baker, 7 septembre 1835, Baker Family 
Letters, Longyear Museum. 
16 Martha S. Baker et Mark Baker à George Sullivan Baker, 20 janvier 1836 ; Baker Family Letters, Longyear 
Museum. 
17 Laws of the State of New Hampshire: An Act to constitute the town of Tilton from a part of the Town of 
Sanbornton [Lois de l’Etat du New Hampshire : Acte de création de la ville de Tilton en lieu et place d’une partie de 
la ville de Sanbornton] ; Subject File, Sanbornton Bridge and Tilton, NH – Folder – General – Miscellaneous. 
18 Mary Baker Eddy, « To Whom it Concerns » [A toute personne intéressée], The Christian Science Journal, juillet 
1903, 253. 
19 Record Book of Sanbornton Academy [Archives de Sanbornton Academy], Longyear Museum. 
20 Runnels, History of Sanbornton, New Hampshire, vol. 2, 805. 
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(trinitaire) de Sanbornton Bridge.21 

1838, 26 juillet Mary devient membre de l’Eglise congrégationaliste (trinitaire) de 
Sanbornton Bridge.22 Elle recueillait des informations à ce sujet depuis 
l’année précédente.23 

1841, 17 octobre Mort de son frère, Albert, à Hillsborough, dans le New Hampshire.24 

1842  Elle fréquente la Sanbornton Academy à Sanbornton Bridge.25 

1843 juillet Voyage avec son frère, George, dans les Montagnes Blanches du  
New Hampshire.26 

1843, 10 décembre 1843  Elle épouse George Washington Glover (né le 2 août 1811)27 dans la 
maison des Baker, à Sanbornton Bridge.28 

1843, 25 décembre  Les Glover prennent le bateau de Boston à Charleston, en Caroline du 
Sud ;29 peut-être font-ils escale à Wilmington, en Caroline du Nord.30 

1844 début février Les Glover emménagent à Wilmington, en Caroline du Nord.31 

1844, 27 juin Mort de George Washington Glover à Wilmington.32 Selon la notice 
nécrologique, il est mort de la fièvre bilieuse.33 Mary écrira plus tard qu’il 
s’agissait de la fièvre jaune.34 Elle quitte Wilmington vers le 20 juillet 
pour retourner vivre dans la maison de ses parents, à Sanbornton Bridge.  
Le voyage dure quatre jours.35 

                                                
21 Archives de l’Eglise congrégationaliste de Sanbornton Bridge, New Hampshire, Compte rendu mensuel des 
adhésions et des réunions, 80, Longyear Museum. 
22 Ibid. 
23 Albert Baker à Mary Baker, 27 mars 1838, Baker Family Letters, Longyear Museum. 
24 « Deaths » [Décès] ; Subject File, Eddy, Mary Baker – Family – Bakers – Albert Baker. 
25 Record Book of Sanbornton Academy, Longyear Museum. 
26 Mary Baker Eddy, cahier, n.d., A09002, 94. 
27 Abigail Evans Holmes à Edith Augusta Holmes Swasey, 13 décembre 1843 ; Subject File, Glover, George 
Washington – Marriage. 
28 Ibid. 
29 Journal de George Baker, 25 décembre 1843, 19, Longyear Museum. 
30 Ibid. 
31 Abigail Tilton et Martha Baker à Mary Baker Eddy, 6 février 1844, Baker Family Letters, Longyear Museum. 
32 « Died » [Décédé], Wilmington Chronicle, 3 juillet 1844. 
33 Ibid. 
34 Mary Baker Eddy, La Première Eglise du Christ, Scientiste, et Miscellanées, publié à l’origine en anglais avec le 
titre The First Church of Christ, Scientist, and Miscellany (Boston: The Writings of Mary Baker Eddy, 1941), 335. 
35 Mary Baker Eddy, cahier, juillet 1844, A09002, 52-53. 
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1844, 12 septembre Naissance de son fils, George Washington Glover II, chez les Baker.36 

1845 décembre Début de sa collaboration en tant qu’auteure avec The Covenant, magazine 
consacré à la loge International Order of Odd Fellows.37 

1846  Elle crée une école expérimentale (de courte durée) pour enfants à 
Sanbornton, l’une des premières du genre dans le New Hampshire.38 

1847  Mark Baker démissionne du Conseil d’administration de la Sanbornton 
Academy.39 

 Elle se rend à Boston.40 

1848 eté Elle assiste à la remise de diplôme d’un ami de longue date qui la courtise, 
John H. Bartlett, étudiant à la Harvard Law School, à Cambridge, dans le 
Massachusetts.41 

1849 mi-juin-août Elle séjourne durant deux mois à Warner, dans le New Hampshire, où elle 
suit le traitement médical de Parsons Whidden. Elle étudie l’allopathie 
avec lui durant son séjour.42 

1849, 4 novembre Son frère, George, épouse son amie, Martha Rand.43 

1849, 21 novembre Décès de sa mère, Abigail Ambrose Baker (née le 18 avril 1784).44 

1849, 11 décembre John H. Bartlett, à qui elle s’était fiancée,45 meurt à Sacramento,  
en Californie.46 

                                                
36 Prénoms inscrits sur la Bible familiale des Glover ; Subject File, Glover, George Washington – Delaney Material. 
37 Mrs M. M. Glover, « Thoughts at a Grave » [Pensées devant une tombe], The Covenant, décembre 1845, 537, 
Subject File, Eddy, Mary Baker – Writings – Early Writings – Pre 1866. 
38 Mary Baker Eddy, « Mrs. Eddy’s Reply to the January McClure Article » [Réponse de Mary Baker Eddy à l’article 
de McClure de janvier], Christian Science Sentinel, 5 janvier 1907, 311 ; et Ruth W. Wardwell, 1er février 1920, 
Souvenirs, Ruth W. Wardwell, 3. 
39 Record book of Sanbornton Academy, New Hampshire Historical Society [Société historique du New Hampshire]. 
(Note : Depuis le printemps 2015, le document ne figure plus dans leur collection.) 
40 Mary Baker Eddy à George Sullivan Baker, 22 janvier 1848, F00035. 
41 Abigail A. Baker à George Sullivan Baker, 2 septembre 1848, Baker Family Letters, Longyear Museum. 
42 Abigail A. Baker à George Sullivan Baker, 7 août 1849, Baker Family Letters, Longyear Museum. 
43 Runnels, History of Sanbornton, New Hampshire, vol. 2, 19. 
44 Notice nécrologique, New Hampshire Patriot and State Gazette, 6 décembre 1849 ; Subject File, Eddy, Mary 
Baker – Family – Bakers – Abigail A. Baker. 
45 Mary Baker Eddy, album, SB001, 75. 
46 « Died » ; Subject File, Bartlett, John Harriman. 
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1849, décembre ou  Elle quitte la ferme de Sanborton Bridge, avec son père et son fils, pour 
  janvier 1850 emménager en ville, à West Main Street.47 

1850, 5 décembre Son père épouse Elizabeth Patterson.48 

1851, 9 mai C’est peut-être à cette date que son fils est confié à Mahala et Russell 
Cheney, qui demeurent à North Groton, à quelque 50 km de Sanbornton 
Bridge. Mary Glover écrit le poème « The Mother at Parting with her 
Child » [La mère séparée de son enfant].49 

1853, 21 juin  Mariage avec Daniel Patterson, dentiste itinérant.50 C’est un neveu de la 
nouvelle belle-mère de Mary.51 Il est probable qu’ils vivent à Franklin,  
à 8 km à l’ouest de Sanbornton Bridge.52 

1853 novembre Les Patterson emménagent dans leur maison au 34 Main Street, à 
Franklin.53 

1855 fin avril Ils déménagent à North Groton pour être près du fils de Mary, George.54 

1856 Elle écrit qu’elle est alitée durant la majeure partie des six années 
suivantes.55 

1856 avril  Les Cheney partent avec son fils, George, qui a presque douze ans, pour 
aller vivre dans le Minnesota.56 Selon Mary Baker Eddy, on raconte à son 
fils que sa mère est morte.57 Ils ne se reverront plus avant 1879.58 Dans une 
lettre datée du 6 juin 1856, Elizabeth Baker (la deuxième épouse de Mark 
Baker) déclare que les Cheney et George ont fait une halte chez eux avant 

                                                
47 Mark Baker à George Sullivan Baker, 10 janvier 1850, Baker Family Letters, Longyear Museum. 
48 « Marriages » [Mariages] ; Subject File, Eddy, Mary Baker – Family – Bakers – Elizabeth Patterson. 
49 Mary Baker Eddy, cahier, 9 mai 1851, A09002, 110. 
50 Certificat de mariage ; Subject File, Patterson, Daniel – Papers – Re Marriage to Mary Baker Eddy. 
51 Janette Weller, « The Human Side of Mrs. Eddy » [Le côté humain de Mary Baker Eddy], n.d., Souvenirs, Janette 
Weller, 13. 
52 Daniel Patterson à Mary Baker Eddy, 10 avril 1853, L16249 ; Daniel Patterson à Mary Baker Eddy, 11 avril 
1853,L16250 ; Daniel Patterson à Mary Baker Eddy, 31 mars 1853, L16252. 
53 Hypothèque, 4 novembre 1853 ; Subject File, Eddy, Mary Baker – Residences – Franklin, NH. 
54 « Foreclosure of Mortgage » [Saisie d’un bien grevé d’une hypothèque], New Hampshire Patriot and State Gazette, 
26 août 1857 ; Subject File, Eddy, Mary Baker – Residences – North Groton, NH. 
55 Mary Baker Eddy à Phineas P. Quimby, 29 mai 1862, V03341. 
56 Elizabeth Patterson Baker à George Sullivan Baker, 6 juin 1856, Baker Family Letters, Longyear Museum. 
57 Mary Baker Eddy, Rétrospection, 21. 
58 Association scientiste chrétienne, compte rendu de réunion, vol. 1, 22 novembre 1879, EOR10, 54. 
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de s’acheminer vers le Minnesota.59 

1857 avril  Martha Pilsbury saisit la maison que possédaient les Patterson à 
Franklin.60 

 
1858, 2 novembre Son frère, Samuel, se marie avec sa deuxième épouse, Mary Ann Cook.61 

1859, 20 septembre « Aujourd’hui ma sœur [Martha Baker Pilsbury] vend notre propriété... »  
à North Groton.62 

1860, 19 mars Les Patterson quittent leur maison de North Groton.63 Ils emménagent à 
Rumney Depot, à 10 km de North Groton. Il est possible qu’ils aient logé 
durant plusieurs semaines chez John Herbert et sa femme.64 Ils 
emménagent ensuite dans leur nouvelle maison à Rumney Village.65 

1861, 14 octobre Daniel Patterson écrit à Phineas Parkhurst Quimby, de la part de sa 
femme, pour lui demander de l’accepter comme patiente.66 

1862  Elle commence « à écrire et à donner à des amis les résultats de son étude 
de l’Ecriture... »67 

1862 mars Daniel Patterson est capturé par les Confédérés.68 Il était chargé par le 
gouverneur du New Hampshire de « reverser aux habitants loyaux du Sud 
certaines taxes gouvernementales. »69 Elle rend visite à la famille de son 
mari, à Saco, dans le Maine, durant la captivité de ce dernier.70 

1862 juin  A l’initiative de sa sœur, Abigail Baker Tilton, elle se rend à l’Institut 
                                                
59 Elizabeth Patterson Baker à George Sullivan Baker, 6 juin 1856, Baker Family Letters, Longyear Museum. 
60 « Foreclosure of Mortgage », New Hampshire Patriot and State Gazette, 26 août 1857 ; Subject File, Eddy, Mary 
Baker – Residences – Franklin, NH. 
61 Commonwealth du Massachusetts, acte de mariage, 2 novembre 1858 ; Subject File, Eddy, Mary Baker – Family – 
Bakers – Samuel Dow Baker. 
62 Mary Baker Eddy, cahier, 20 septembre 1859, A09001, 60. 
63 Journal de Cyrus Blood, 19 mars 1860, Longyear Museum. 
64 Abbie W. Griffin à Willard S. Mattox, 13 mai 1911 ; Subject File, Eddy, Mary Baker – Residences – Rumney, NH. 
65 William McKee, « Report re Houses in Rumney, New Hampshire, formerly occupied by Dr. and Mrs. Patterson » 
[Objet du rapport : Maisons à Rumney, dans le New Hampshire, anciennement occupées par le Docteur et Madame 
Patterson], 1932 ; Subject File, Eddy, Mary Baker – Residences – Rumney, NH. 
66 Daniel Patterson à Phineas P. Quimby, 14 octobre 1861, V03340. 
67 Mary Baker Eddy, Science et Santé avec la Clef des Ecritures, publié à l’origine en anglais sous le titre Science and 
Health with Key to the Scriptures (Boston: Trustees under the Will of Mary Baker Eddy, 1934), viii. 
68 Daniel Patterson à Mary Baker Eddy, 2 avril 1862, L16248. 
69 Mary Baker Eddy, Footprints Fadeless [Empreintes indélébiles], 1902, A10402, 5. 
70 John Patterson à Mary Baker Eddy, 28 décembre 1899, IC224.37.001. 
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thermal du docteur W.T. Vail, à Hill, dans le New Hampshire, dans 
l’espoir d’une guérison.71 Elle y séjournera trois mois sans obtenir la 
guérison espérée.72 

1862, 20 septembre Daniel Patterson s’évade de prison et, après une fuite éprouvante de sept 
semaines, il parvient à gagner un endroit sûr.73 

1862 octobre Accompagnée de son frère, Samuel, et de la femme de celui-ci, Mary Ann 
Baker, elle se rend pour la première fois au cabinet de Phineas Parkhurst 
Quimby, à l’International Hotel, à Portland, dans le Maine.74 

1862, 7 novembre Sa première lettre de soutien à Phineas Parkhurst Quimby est publiée dans 
le Portland Evening Courier.75 

1862 décembre Elle donne sa première conférence publique au City Hall de Portland.  
Elle y traite du spiritisme.76 

1862, 19 décembre Daniel Patterson raconte son expérience dans le Sud, dans des conférences 
qu’il donne à Portland.77 

1863 janvier Les Patterson emménagent chez Abigail Baker Tilton, la sœur de Mary 
Baker Eddy, à Sanbornton Bridge.78 

1863 juillet Elle visite Portland.79 

1863 septembre Elle rend visite au frère de Daniel Patterson, à Saco, dans le Maine.80 

1863, 12 septembre Daniel Patterson ouvre un cabinet dentaire à Lynn (Massachusetts).81 

                                                
71 Mary Baker Eddy à Phineas P. Quimby, août 1862, V03342. 
72 Ibid. 
73 « Escape of Dr. Patterson » [Evasion du Dr Patterson], New Hampshire Patriot and State Gazette, 26 novembre 
1862 ; Subject File, Patterson, Daniel – Papers – Imprisonment. 
74 Page de journal, octobre 1862 ; Subject File, Dresser, Julius and Annetta. 
75 Mary Baker Eddy, album, SB001A, 12. 
76 Mary Baker Eddy, Footprints Fadeless, 1902, A10402, 24. 
77 « Lecture » [Conférence], Portland Daily Advertiser, 20 décembre 1862 ; Subject File, Patterson, Daniel – Papers – 
Imprisonment. 
78 Mary Baker Eddy à Phineas P. Quimby, 12 janvier 1863, V03343. 
79 « Reminiscences of Portland » [Souvenirs de Portland], Portland Daily Press, 21 octobre 1863 ; Subject File, 
Eddy, Mary Baker – Writings – Early Writings – Pre 1866. 
80 Mary Baker Eddy à Phineas P. Quimby, 14 septembre 1863, V05006. 
81 « A Card » [Une carte], Lynn Weekly Reporter, 12 septembre 1863 ; Subject File, Patterson, Daniel – Papers – 
General. 
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1864, 10 janvier Elle donne une causerie au Mechanics Hall, à Portland.82 

1864, 29 mars Elle séjourne deux mois à Warren, dans le Maine, avec Mary Ann Jarvis, 
une patiente de Phineas Parkhurst Quimby.83 Durant son séjour, elle donne 
une conférence intitulée « La Science spirituelle de P. P. Quimby guérit la 
maladie, contrairement au déisme ou au “spiritisme des coups frappés”, en 
pratique à Rochester ».84 

1864 fin mai Elle séjourne brièvement à Portland chez une certaine Madame Wilson.85 

1864 après le 9 juillet Elle séjourne plusieurs mois chez Sarah G. Crosby, autre patiente de 
Quimby, à Albion, dans le Maine.86 

1864, 6 septembre Elle donne une conférence à Waterville College, dans le Maine, sur  
« Le Sud et le Nord ».87 

1864 automne Elle retourne à Lynn.88 

1865 printemps Elle séjourne chez Thomas, Hannah et Dorr Phillips, à Lynn.89 

1865 avril Elle rend visite à Phineas Parkhurst Quimby, à Portland.90 

1865 juin Son mari et elle habitent à Buffum Court, à Lynn.91 

1865 septembre Elle rend visite à Phineas Parkhurst Quimby, à Belfast, dans le Maine.92 

C’est la dernière fois qu’elle le voit avant qu’il ne décède. 

                                                
82 Mary Baker Eddy, album, SB001A, 13. 
83 Mary Baker Eddy à Phineas P. Quimby, 31 mars 1864, V03347 ; Mary Baker Eddy à Phineas P. Quimby, 10 avril 
1864, V03349 ; Mary Baker Eddy à Phineas P Quimby, 24 avril 1864, V03350 ; Mary Baker Eddy à Phineas P. 
Quimby, mai 1864, V03351 ; Mary Baker Eddy à Phineas P. Quimby, 27 mai 1864, V03352. 
84 Mary Baker Eddy à Phineas P. Quimby, 24 avril 1864, V03350 
85 Mary Baker Eddy à Phineas P. Quimby, 27 mai 1864, V03352. 
86 Mary Baker Eddy à Phineas P. Quimby, 8 juillet 1864, V03353 ; Georgine Milmine, notes manuscrites, 26 juin 
1920, 2 ; Subject File, Milmine, Georgine Collection – Affidavits and Interviews [items 54–59]. 
87 « The South and the North » [Le Sud et le Nord], Waterville Mail, 9 septembre 1864 ; Subject File, Writings – 
Lectures and Addresses. 
88 Mary Baker Eddy, « Day after Thanksgiving » [Le lendemain du Jour d’Actions de Grâces], album, SB001A, 8. 
89 Fannie Phillips à Thomas Phillips, 3 mai 1865 ; Subject File, Phillips – Family (Fannie) – Lynn, MA. 
90 Daniel Patterson à Phineas P. Quimby, 24 avril 1865, V05007. 
91 Annuaire de la ville de Lynn, 1865 ; Subject File, Eddy, Mary Baker – Residences – Lynn, Massachusetts – 
Newsclippings and Miscellaneous ; recensement de l’Etat du Massachusetts ; Subject File, Eddy, Mary Baker – 
Residences – Lynn, Massachusetts – Newsclippings and Miscellaneous. 
92 Mary Baker Eddy à Martha Pilsbury, 7 septembre 1865, L11151. 
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1865, 6 octobre Son père, Mark Baker (né le 2 mai 1785) meurt à Sanbornton Bridge.93 

1866, 16 janvier Phineas Parkhurst Quimby (né le 16 février 1802) meurt chez lui, à 
Belfast, dans le Maine.94 

1866, 1er février Alors qu’elle se rend, ce jeudi-là, à une réunion sur la tempérance, 
organisée par la loge des Bons Templiers de Linwood, elle fait une chute 
sur le trottoir verglacé, à l’angle d’Oxford Street et de Market Street, à 
Lynn. On la transporte, inconsciente, dans la maison voisine de Samuel 
Bubier, un homme d’affaires prospère de Lynn.95 Des amis demandent au 
docteur Alvin M. Cushing, médecin homéopathe, de s’occuper d’elle.96 

1866, 2 février On la transporte chez elle, à Swampscott.97  

1866, 4 février (dimanche) Après avoir lu deux passages du Nouveau-Testament, dans la Bible, elle 
est guérie des blessures causées par la chute.98 

1866 fin mars/début avril Les Patterson emménagent dans la maison du pasteur Russell, à Lynn.99 

Daniel Patterson quitte le foyer conjugal.100 Elle est par la suite expulsée 
pour défaut de paiement du loyer.101 

1866, 19 juin Elle porte plainte contre la ville de Lynn pour divers préjudices liés à sa 
chute.102 Elle retire sa plainte le 26 décembre.103 

1866 août Elle loge dans la pension de famille de George D. Clark, à Summer Street, 
à Lynn.104 

                                                
93 Etat du New Hampshire, Service de l’état civil, 4 mars 1866 ; Subject File, Eddy, Mary Baker – Family – Bakers – 
Mark Baker. 
94 « Dr. Phineas Parkhurst Quimby », Find a Grave [Trouver une tombe] ; Subject File, Quimby, Phineas P. – 
Folder I. 
95 Mary Baker Eddy, Science et Santé, 3e éd., vol. 1 (Lynn, MA: Dr Asa G. Eddy, 1881), 155-157. 
96 Alvin M. Cushing, affidavit, 30 août 1904 ; Subject File, Eddy, Mary Baker – Lynn, February 1866 – Accident and 
Aftermath. 
97 Ibid. ; « Accidents », Lynn Reporter, 3 février 1866 ; Subject File, Eddy, Mary Baker – Lynn, February 1866 – 
Accident and Aftermath. 
98 Mary Baker Eddy, Science et Santé, 3e éd., vol. 1, 155-157. 
99 Georgine Milmine, notes sur P. R. Russell, n.d. ; Subject File, Milmine, Georgine – Research Notes [I]. 
100 Ibid. 
101 Ibid. 
102 Mary Baker Eddy au maire de Lynn, Massachusetts, 19 juin 1866, V03291. 
103 « Municipal matters » [Affaires municipales], Lynn Reporter, 29 décembre 1866 ; Subject File, Eddy, Mary Baker 
– Lynn, February 1866 – Accident and Aftermath. 
104 Alvin M. Cushing, affidavit, 30 août 1904, 2 ; Subject File, Eddy, Mary Baker – Lynn, February 1866 – Accident 
and Aftermath. 
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1866 fin Dans son autobiographie, elle écrit : « ... vers la fin de 1866 j’acquis la 
certitude scientifique que toute causation est Entendement, et tout effet,  
un phénomène mental. »105 

1867 début Elle enseigne à Hiram S. Crafts ce qu’elle a compris de la guérison 
spirituelle en étudiant la Bible ; elle se base sur son exégèse des chapitres 
14 à 17 de l’Evangile selon Matthieu.106  

1867 février Elle rend visite à sa famille, à Sanbornton Bridge, et séjourne 
probablement chez sa sœur, Martha Pilsbury.107 

1867 avril Elle déménage avec la famille d’Hiram S. Crafts à Taunton, dans le 
Massachusetts, où Crafts établit sa pratique publique de la guérison 
spirituelle au 90 Main Street.108 Cette pratique est basée sur 
l’enseignement qu’il a reçu de Mary Baker Eddy concernant ce sujet. 

1867 mai Daniel Patterson la quitte définitivement au cours de ce mois.109 Durant 
quelques années, il lui verse une pension annuelle pour subvenir à ses 
besoins.110 

1867, 6 août Elle quitte la maison d’Hiram S. Crafts pour séjourner brièvement à Lynn, 
chez Charles Winslow et sa femme.111 

1867, 21 novembre Mort de son frère, George (né le 7 août 1812).112 

1867 fin décembre Elle séjourne à Swampscott durant la période des fêtes de fin d’année.113 

1868 avril Elle reprend le nom de Glover.114 Mais elle ne l’utilise pas 
systématiquement avant le deuxième semestre de 1869. 

1868, 1-8 juin On lui demande de venir à Manchester, dans le New Hampshire, pour 

                                                
105 Mary Baker Eddy, Rétrospection, 24. 
106 Mary Baker Eddy, 22 février 1902, A10062b. 
107 Mary Baker Eddy à Martha Pilsbury, 28 février 1867, L11152. 
108 Hiram Crafts à Mary Baker Eddy, 7 janvier 1902 ; Subject File, Crafts, Hiram. 
109 Commonwealth du Massachusetts et Mary Baker Eddy, jugement de divorce, 4 novembre 1873 ; Subject File, 
Patterson, Daniel – Papers – Marriage to Mary Baker Eddy. 
110 Mary Baker Eddy à Charlotte Penniman Mulliken, 7 juin 1869, L08866. 
111 M. P. Ellis à Mary Baker Eddy, 7 août 1867, Dossier Fred O. Ellis, LMDB-4659, Longyear Museum. 
112 Runnels, History of Sanbornton, New Hampshire, vol. 2, 19. 
113 Mary Baker Eddy, 4 janvier 1868, A10019. 
114 Mrs. Nathaniel Webster, 5 avril 1868, L09794. 
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guérir Mary Gale, qui se meurt d’une pneumonie causée par la 
tuberculose.115 

1868 juillet Elle rend de nouveau visite à Mary Gale, à Manchester, dans le New 
Hampshire.116 

1868 été Au cours de l’été, Sarah O. Bagley, qui vit à Amesbury, lui fait connaître 
le poète John Greenleaf Whittier. Elle le guérit de la tuberculose.117 

1868 début septembre Elle vient habiter chez Alanson C. et Sally Wentworth à Stoughton,  
au 133 Center Street.118 Elle y demeure 18 mois, jusqu’au printemps 
1870.119 Sally Wentworth devient sa troisième élève en 1867.120 

1868, 28 septembre Son frère aîné, Samuel (né le 8 juillet 1808) meurt à Charlestown, dans  
le Massachusetts.121 

1868 octobre Elle séjourne une semaine dans sa famille, à Sanbornton Bridge,122 puis 
elle rend visite à Charles Winslow et à sa femme, à Lynn, où elle reste 
deux jours avant de revenir à Stoughton.123 

1869 juin Sanbornton Bridge est rebaptisée Tilton, New Hampshire.124 Tilton est le 
nom de famille d’Alexander Hamilton Tilton, le mari d’Abigail Baker 
Tilton. Le couple possède une grande usine textile dans cette ville.125 

1869, 7 juin Elle écrit : « Je viens d’envoyer un travail à l’imprimerie, intitulé “Science 
of Soul” [La Science de l’Ame]... Je l’ai écrit et j’ai aussi écrit des notes 
sur tout le livre de la Genèse, au cours de l’année dernière. »126 (« Science 
of Soul » est probablement une version de « The Science of Man »  
[La Science de l’homme], qu’elle a commencé à écrire en 1867.) 

                                                
115 Mary Gale à Mary Baker Eddy, 30 mai 1868 ; Subject file, Gale, Mary. 
116 Mary Baker Eddy à Sarah O. Bagley, 5 juillet 1868, L03916. 
117 Mary Baker Eddy, n.d., A11063. 
118 Mary Baker Eddy à Sarah O. Bagley, 10 septembre 1868, L07797. 
119 Mary Baker Eddy, carnet, 23 mars 1870, EF054. 
120 Mary Baker Eddy, carnet, 1867, EF109. 
121 Mary Ann Baker, Requête, 27 octobre 1868 ; Subject File, Eddy, Mary Baker – Family – Bakers – Samuel Dow 
Baker. 
122 Mary Baker Eddy à Sarah O. Bagley, 20 octobre 1868, L08306. 
123 Ibid. 
124 Etat du New Hampshire, Laws of the State of New Hampshire (Concord, NH: B. W. Sanborn & Co., 1869), 
304-305 ; Subject File, Sanbornton Bridge and Tilton, NH – Folder – General – Miscellaneous. 
125 Runnels, History of Sanbornton, New Hampshire, vol. 2, 804. 
126 Mary Baker Eddy à Charlotte Penniman Mulliken, 7 juin 1869, L08866. 
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1870-1871 Elle commence à enseigner régulièrement à des élèves un cours composé 
de douze leçons.127 Elle écrit deux textes pour son cours : « The Soul’s 
Inquiry of Man » [L’Ame interroge l’homme] et « Spiritualism and 
Individuality » [Spiritisme et Individualité], qui sont utilisés par les élèves 
en même temps que « The Science of Man, By Which the Sick are 
Healed » [La science de l’homme, par laquelle les malades sont guéris].128 

(Ce dernier texte est protégé par le droit d’auteur en 1870.129 Il sera publié 
en 1876,130 mais les éditions de 1876 et 1879 diffèrent légèrement. En 
1881, elle en fait la substance du chapitre « Récapitulation » dans Science 
et Santé avec la Clef des Ecritures. Les pages 167 à 193 sont regroupées 
avec la Préface de Science et Santé, et publiées sous le titre « The Science 
of Man » en 1883, et protégées par le droit d’auteur sous cette forme.131) 

1870, 23 mars Elle retourne chez Sarah O. Bagley, à Amesbury, pour six semaines.132 

Sarah Bagley devient sa quatrième élève.133 

1870, 13 mai Elle déménage à Lynn avec son élève Richard Kennedy. Ils habitent 
durant une courte période chez Thomas Clarkson Oliver, au 31 South 
Common Street.134 Elle réside à Lynn de mai 1870 à janvier 1882 (mis à 
part un séjour de dix mois à Boston en 1879-1880,135 et un voyage à 
Washington, D.C.,136 et à Philadelphie, en Pennsylvanie, au printemps 
1882.)137 

1870 juin-juillet Richard Kennedy et elle ont chacun une chambre dans une pension de 
famille, au 71 South Common Street, à Lynn.138 

                                                
127 Samuel Putman Bancroft, Mrs. Eddy as I Knew Her in 1870 [Mary Baker Eddy, telle que je l’ai connue en 1870] 
(Boston: George H. Ellis Co., 1923), 2. 
128 Ibid., 59-125. 
129 Mary Baker Eddy, 1876, « The Science of Man » [La Science de l’homme], A11319, 2. 
130 Mary Baker Eddy, Science of Man (Lynn, Massachusetts: Thomas P. Nichols, 1876) ; Subject File, Eddy, Mary 
Baker – Writings – Science of Man 1. 
131 Mary Baker Eddy, Science of Man (Cambridge, Massachusetts: University Press, 1883) ; Subject File, Eddy, Mary 
Baker – Writings – Science of Man 1. 
132 Mary Baker Eddy, carnet, 23 mars 1870, EF054. 
133 Mary Baker Eddy, carnet, 1870, EF109. 
134 H. A. Kelly à Mary Baker Eddy, 15 septembre 1906, IC684a.77.042 ; données du recensement américain, 1870 ; 
Subject File, Eddy, Mary Baker – Residences – Lynn, Massachusetts – Newsclippings and Miscellaneous ; Lynn, 
Massachusetts, Annuaire de la ville, 1871 ; Subject File, ibid. 
135 Mary Baker Eddy à James Ackland, 21 janvier 1880, L10638. 
136 Mary Baker Eddy à Julia Bartlett, 20 janvier 1882, L07689 ; Mary Baker Eddy à James Ackland, 13 mars 
1882,L10642. 
137 Mary Baker Eddy au Col. Eldrige J. et à Mollie Smith, 29 mars 1882, L02056 ; Mary Baker Eddy au Col. Eldrige 
J. et à Mollie Smith, 17 mars 1882, L02057. 
138 Mary Baker Eddy à Sarah O. Bagley, 6 juillet 1870, L03918. 
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1870, 18 juin Elle s’associe avec Richard Kennedy. Elle assume le rôle de professeur, et 
lui celui de premier praticien public de la Science Chrétienne.139 

1870 août Avec Richard Kennedy, elle emménage au deuxième étage de l’école 
privée pour enfants de Susie Magoun, à l’angle de South Common Street 
(no 29) et de Shepard Street (no 2), à Lynn.140  

1871 début janvier Elle séjourne dans sa famille, à Tilton, pendant une ou deux semaines.141 

1872 janvier Elle commence à écrire Science et Santé.142 Le premier titre provisoire 
qu’elle donne à ce livre est « The Science of Life » [La Science de la 
Vie].143 

1872, 20 janvier Elle rédige sa première déclaration publique pour expliquer et défendre la 
« science morale » qu’elle a découverte, qu’elle utilise pour guérir et 
qu’elle enseigne aux autres à pratiquer. Le texte est publié dans le Lynn 
Transcript,144 et constitue une réponse à une violente critique de Wallace 
W. Wright (un élève ayant suivi son cours en 1871), publiée dans le même 
journal la semaine précédente.145 

1872, 3 février Sa deuxième déclaration publique concernant la Science Chrétienne est 
publiée sous forme de lettre dans le Lynn Transcript. Cette lettre a pour 
titre « Moral Science and Mesmerism » [La Science morale et le 
mesmérisme]. Elle précise également qu’elle est en train de travailler à  
un manuscrit qui expliquera ses théories de façon très détaillée.146 

1872, 14 mars Elle enseigne à une quatrième classe, ayant notamment pour élèves Lydia 
Merrill, Elizabeth Nichols, Miranda R. Rice et Peter Sim.147 Elle 
n’enseignera plus jusqu’au printemps 1875.148 

                                                
139 Mary Baker Eddy, carnet, 18 juin 1870, EF054. 
140 Mary Baker Eddy à Sarah O. Bagley, 12 janvier 1871, L08299. 
141 Mary Baker Eddy à Sarah O. Bagley, 11 juillet 1871, L07801 ; Mary Baker Eddy à Frances Spinney, 11 juillet 
1871, L03929. 
142 Ives et Lincoln, Avocats, à Mary Baker Eddy, septembre 1877, L09048. 
143 Mary Baker Eddy à Ainsworth Spofford, 2 juin 1875, V03276. 
144 Mary Baker Eddy, 20 janvier 1872, V05002. 
145 W. W. Wright, « Moral Science, alias Mesmerism » [La Science morale, alias le Mesmérisme], Lynn Transcript ; 
Subject File, Eddy, Mary Baker – Residences – Lynn, Massachusetts – Newsclippings and Miscellaneous. 
146 Mary Baker Eddy, 2 février 1872, V05003. 
147 Mary Baker Eddy, carnet, 1872, EF109. 
148 Ibid. 
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1872, 8 mai Elle met fin à son association avec Richard Kennedy.149 

1872 mi-mai Elle rend visite à sa famille, à Tilton.150 

1872, 23 août-septembre Elle quitte la maison de Susan Chadwell, au 20 Commercial Street, à 
Lynn, parce que celle-ci lui prend trop de temps alors qu’elle est en train 
de travailler à la rédaction de son manuscrit « The Science of Life »  
[La Science de la Vie] (Science et Santé).151 

1872 octobre-novembre  Elle loue une chambre qui donne sur Broad Street, à deux pas du carrefour 
où Chestnut Street devient Atlantic Street, à Lynn.152 

1873  Elle loge à l’angle de Beach Avenue et de Mountain Avenue, à 
Swampscott.153 

1873 septembre Elle loge au 6 Broad Street, à Lynn.154 

1873 automne Le manuscrit de « The Science of Life » (Science et Santé) est refusé par 
un éditeur.155 

1873, 4 novembre Elle obtient le divorce d’avec Daniel Patterson auprès du tribunal de 
Salem, dans le Massachusetts, après vingt ans de mariage.156 Le divorce 
est prononcé le 9 décembre.157 Le motif officiel est « abandon du domicile 
conjugal », bien que l’adultère en soit la cause.158 

1874 Elle habite dans huit maisons différentes, à Lynn, au cours de l’année, 
tandis qu’elle travaille au manuscrit de « The Science of Life »  
(Science et Santé).159 

                                                
149 « Dissolution of Copartnership » [Dissolution d’association], Lynn Semi-Weekly Reporter, 8 mai 1872 ; Subject 
File, Eddy, Mary Baker – Residences – Lynn, Massachusetts – Newsclippings and Miscellaneous. 
150 Mary Baker Eddy à Fred O. Ellis, 27 mai 1872, L05664. 
151 Mary Baker Eddy, carnet, 23 août 1872, EF054 ; Lynn, Massachusetts, répertoire de la ville ; Subject File, Eddy, 
Mary Baker – Residences – Lynn, Massachusetts – Newsclippings and Miscellaneous ; Mary Baker Eddy à Mary 
Ellis, 7 octobre 1872, L05666. 
152 Ibid. 
153 Bancroft, Mrs. Eddy as I Knew Her in 1870, 10-11. 
154 L. H. Kimball, 29 mai 1917, Souvenirs, Lewis H. Kimball. 
155 Bancroft, Mrs. Eddy as I Knew Her in 1870, 46. 
156 Commonwealth du Massachusetts et Mary Baker Eddy, jugement de divorce, 4 novembre 1873 ; Subject File, 
Patterson, Daniel – Papers – Re: Marriage to Mary Baker Eddy. 
157 Ezra L. Woodbury à G. Harold Ellis, 21 février 1900 ; Subject File, Patterson, Daniel – Papers – General. 
158 Mary Baker Eddy, Miscellanées, 314. 
159 Mary Baker Eddy à Edward P. et Caroline S. Bates, 11 décembre, L08225. 

mailto:recherche@mbelibrary.org
https://www.marybakereddylibrary.org/fr/


 
 

210 Massachusetts Avenue, Boston, MA 02115, Etats-Unis ∙ +1 617 450 7218 
recherche@mbelibrary.org ∙ marybakereddylibrary.org/fr/ 

© 2002, 2017, traduction française © 2021 The Mary Baker Eddy Library 
 

15 

1874 janvier Elle séjourne brièvement chez Amos Scribner et sa femme, au 7 Broad 
Street, à Lynn,160 puis pendant quelque temps chez George H. Allen (élève 
en 1870), au 4 Garland Street, à Lynn.161 

1874 printemps Elle révise le manuscrit de « The Science of Life » (Science et Santé), 
mais il est de nouveau refusé par un éditeur.162 

1874, 7 juillet « The Science of Life » est protégé par le droit d’auteur.163 Une semaine 
plus tard, elle trouve un imprimeur qui accepte de l’imprimer.164 

1874, 5 septembre Elle remet le manuscrit à l’imprimeur.165 Elle commence la correction des 
épreuves en décembre.166 Un jour, elle découvre l’existence d’un autre 
livre intitulé « The Science of Life ». Elle change alors le titre de son livre 
pour celui de Science et Santé.167 

1874 automne Elle habite chez Amos Scribner, au 7 Broad Street, à Lynn.168 

1875 janvier Elle remarque une annonce concernant la vente d’une maison au  
8 Broad Street, de l’autre côté de la rue.169 

1875, 31 mars Elle achète la maison au 8 (aujourd’hui 12) Broad Street, à Lynn.170 Elle 
écrit seize pages (368 à 383 dans la première édition) sur le magnétisme 
animal (l’hypnotisme ou le mesmérisme).171 Elles sont insérées dans le 
dernier chapitre de Science et Santé, « Healing the Sick » [La guérison  
des malades].172 

1875 avril Elle enseigne à une classe de quatre élèves, dont Daniel H. Spofford.  

                                                
160 Mary Baker Eddy à Samuel Putnam Bancroft, 9 janvier 1874, F00347. 
161 Samuel Putnam Bancroft à Mary Beecher Longyear, 12 septembre 1920, Souvenirs, Samuel Putnam Bancroft 1. 
162 Bancroft, Mrs. Eddy as I Knew Her in 1870, 46. 
163 Mary Baker Eddy, carnet, 7 juillet 1874, EF109. 
164 Ibid., 14 juillet 1874. 
165 Ibid., 5 septembre 1874. 
166 Mary Baker Eddy à Samuel Putnam Bancroft, 15 décembre 1874, V03047. 
167 Mary Baker Eddy à Ainsworth Spofford, 2 juin 1875, V03276. 
168 Samuel Putnam Bancroft à Mary Beecher Longyear, 12 septembre 1920, Souvenirs, Samuel Putnam Bancroft 1 ; 
Mary Baker Eddy, 6 octobre 1874, A10023. 
169 Bancroft, Mrs. Eddy as I Knew Her in 1870, 31. 
170 F. E. Besse à M. M. B. Glover, acte notarié, 30 mars 1875 ; Subject File, Eddy, Mary Baker – Residences – Lynn, 
Massachusetts – Deeds. 
171 Mary Baker Eddy, Rétrospection, 38. 
172 Ibid., 37-38. 
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C’est sa première classe depuis 1872.173 

1875, 23 mai Elle donne une conférence sur la Science Chrétienne au Concert Hall, sur 
Market Street, à Lynn. Elle a pour sujet « Christ Healing the Sick »  
[Le Christ guérit les malades].174 

1875, 4 juin Science et Santé est protégé par le droit d’auteur.175 

1875, 6 juin Mary Baker Eddy commence à tenir des services religieux le dimanche, au 
Good Templars Hall, au 30 Market Street, à Lynn. Ces services sont 
supprimés après le 4 juillet.176 

1875, 13 juin Elle obtient une lettre de radiation de l’église congrégationaliste de Tilton, 
dont elle a été membre pendant 37 ans.177 

1875, 30 octobre Publication de Science et Santé dans une première édition de 1000 
exemplaires par la Christian Scientist Publishing Company.178 Elle a versé 
un acompte de 200 $ puis de 500 $ à l’imprimeur W.F. Brown and Co.179 

1876, 14 janvier Elle envoie un exemplaire de son livre à Amos Bronson Alcott (le père de 
la romancière Louisa May Alcott).180 Celui-ci lui rend visite à Lynn le  
20 janvier.181 

1876, 14 janvier Publication de The Science of Man, By Which the Sick Are Healed.182  

Le livre était protégé par le droit d’auteur depuis 1870.183 

1876, 16 février Amos Bronson Alcott lui rend visite, ainsi qu’à ses élèves, à Lynn, pour la  
 

                                                
173 Mary Baker Eddy, carnet, 12 avril 1875, EF109. 
174 Lynn Transcript, 22 mai 1875 ; Subject File, Eddy, Mary Baker – Writings – Lectures and Addresses. 
175 Mary Baker Eddy à Ainsworth Spofford, 2 juin 1875, V03276. 
176 Lynn Transcript, diverses dates ; Subject File, Eddy, Mary Baker – Residences – Lynn, Massachusetts – 
Newsclippings and Miscellaneous. 
177 Theodore C. Pratt, 13 juin 1875 ; Subject File, Eddy, Mary Baker – Church Membership – Tilton and Pembroke. 
178 Mary Baker Eddy, carnet, 30 octobre 1875, EF109 ; M. B. Eddy, Science et Santé (Lynn, MA: Christian Scientist 
Publishing Company, 1875), page de titre ; Mary Baker Eddy, Rétrospection, 37. 
179 W. F. Brown & Co. à Edward Hitchings et George M. Barry, facture, 30 octobre 1875 ; Subject File, Eddy, Mary 
Baker – Writings – Science and Health – Publication and Sale – General. 
180 Mary Baker Eddy à A. Bronson Alcott, 14 janvier 1876, L05660. 
181 Bronson Alcott, The Journals of Bronson Alcott [Les journaux de Bronson Alcott], éd. Odell Shepard (Boston: 
Little, Brown and Company, 1938), 465. 
182 Mary Baker Eddy, 1876, A11319. 
183 Ibid. 
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deuxième fois. « Nous avons passé la soirée à discuter de questions 
métaphysiques. »184 

1876 mars Elle enseigne une classe.185 

1876 printemps Elle guérit Asa Gilbert Eddy d’un problème physique.186 Il étudie avec elle 
et se fait connaître au public en tant que praticien de la guérison en quatre 
semaines.187 

1876 juin « La Clef des Ecritures » est protégée par le droit d’auteur, bien que  
le texte ne soit pas inséré dans Science et Santé avant la sixième édition, 
en 1883.188 

1876, 4 juillet Elle organise l’Association scientiste chrétienne (CSA).189 

1876 début novembre Elle se rend par bateau à Philadelphie pour la célébration du Centenaire de 
l’indépendance des Etats-Unis.190 

1877, 1er janvier Elle épouse Asa Gilbert Eddy à son domicile, au 8 Broad Street, à Lynn. 
C’est un pasteur unitarien, Samuel B. Stewart, qui célèbre leur mariage.191 

1877, 7 ou 14 février Elle commence à enseigner une classe.192 

1877 printemps George W. Barry, élève et à l’occasion copiste, lui intente un procès pour 
défaut de paiement du travail de copiste qu’il avait accompli à sa 
demande.193 Il obtient gain de cause le 3 octobre 1879.194 

1877 avril Les Eddy visitent Fairhaven (qui fait aujourd’hui partie de New Haven), 
dans le Connecticut.195 Ils séjournent chez le frère d’Asa Gilbert, 

                                                
184 Bronson Alcott, The Journals of Bronson Alcott, éd. Odell Shepard, 467. 
185 Mary Baker Eddy, carnet, mars 1876, EF109. 
186 Mary Baker Eddy à Anna I. Kingsbury, 12 janvier 1877, L08737. 
187 Ibid. 
188 Lettre de Mary Baker Eddy à un bibliothécaire du Congrès, 30 mai 1877, V03277. 
189 Association scientiste chrétienne, archives, vol. 1, n.d. EOR10, 1. 
190 « The Great Exhibition » [L’Exposition universelle], The Lynn Transcript, 25 novembre 1876 ; Subject File, Eddy, 
Mary Baker – Writings – Early Writings – Post 1866 ; E. J. Smith à Mary Baker Eddy, 14 novembre 1876, 
IC382.50.003 ; Charlotte R. Lowell, 3 octobre 1960, Souvenirs, Charlotte R. Lowell. 
191 Samuel B. Stewart, acte de mariage, 1er janvier 1877 ; Subject File, Eddy, Asa G. – Marriage. 
192 Mary Baker Eddy, carnet, février 1877, EF109 ; Mary Baker Eddy à Sarah G. Crosby, 5 février 1877, L02018. 
193 Ives et Lincoln, Avocats, à Mary Baker Eddy, septembre 1877, L09048. 
194 J. A. Gillis, jugement, 3 octobre 1879 ; Subject File, Eddy, Mary Baker – Lawsuits – Barry vs. Eddy. 
195 Mary Baker Eddy à Daniel H. Spofford, 14 avril 1877, L07816. 
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Washington, durant cinq semaines.196 

1877, 30 mai Daniel H. Spofford rompt toute relation et se lance dans une opposition 
active à Mary Baker Eddy.197 

1878 février Enrôlement du procès Glover contre Kennedy. Richard Kennedy est 
accusé de ne pas avoir rempli ses obligations financières envers Glover 
(Mary Baker Eddy) en dépit d’un accord signé en février 1870.198 

1878, 14 mars L’affaire Glover contre Kennedy passe en jugement. Le juge William Hale 
Parmenter du tribunal municipal de Boston statue en faveur de Mary 
Baker Eddy.199 Richard Kennedy fait appel de la décision et demande un 
procès avec jury, lequel aura lieu en novembre.200 

1878 avril Edward J. Arens, élève de Mary Baker Eddy, porte plainte au nom de cette 
dernière : Eddy contre Spofford, pour frais d’étude et royalties non réglés 
par Spofford pour sa pratique.201 

1878 mai Edward J. Arens porte plainte au nom de Mary Baker Eddy : Eddy contre 
Tuttle et autres, pour frais d’étude non réglés par George H. Tuttle et 
Charles S. Stanley.202 

1878, 14 mai « Ipswich Witchcraft Case » [Procès de sorcellerie d’Ipswich] intenté par 
Lucretia L. S. Brown contre Daniel H. Spofford, à Salem, dans le 
Massachusetts. Brown accuse Spofford de l’agresser avec des pensées 
négatives et haineuses destinées à lui nuire physiquement ou à la tuer.203 

L’affaire est classée sans suite le 17 mai.204 

                                                
196 Washington Eddy à Gilbert Eddy, 24 décembre 1876 ; Subject File, Eddy, Asa G. – Correspondence ; Mary Baker 
Eddy à Daniel H. Spofford, 14 avril 1877, L07816. 
197 Daniel H. Spofford à Mary Baker Eddy, 30 mai 1877, IC327.44.006. 
198 Mary Baker Eddy au tribunal municipal du comté de Suffolk, déclaration, 23 février 1878 ; Subject File, Eddy, 
Mary Baker – Lawsuits – Glover [Mary Baker] v. Kennedy. 
199 Tribunal municipal du comté de Suffolk, certificat de procédure, 15 mars 1878 ; Subject File, Eddy, Mary Baker – 
Lawsuits – Glover [Mary Baker] v. Kennedy. 
200 Verdict du jury, 8 novembre 1878 ; Subject File, Eddy, Mary Baker – Lawsuits – Glover [Mary Baker] v. 
Kennedy. 
201 Cour suprême du comté d’Essex, jugement, avril 1878 ; Subject File, Eddy, Mary Baker – Lawsuits – Eddy vs. 
Spofford. 
202 « Magnetic Healers in Trouble » [Des magnétiseurs en difficulté], Lawrence Daily Eagle, 18 mai 1878 ; Subject 
File, Eddy, Mary Baker – Lawsuits – Eddy vs. Tuttle et al. [Stanley]. 
203 « That Witchcraft Case » [Ce procès en sorcellerie], The Boston Daily Globe, 12 mai 1878 ; Subject File, 
Spofford, Daniel H. 
204 Boston Evening Transcript, 18 mai 1878 ; Subject File, ibid. 
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1878, 3 juin L’affaire Eddy contre Spofford est classée sans suite pour vice de 
procédure et service rendu insuffisant.205 

1878, 15 août Mary Baker Eddy choisit le terme « scientistes chrétiens » pour désigner 
désormais ceux qui étudient la Science Chrétienne.206 

1878 octobre Publication de la deuxième édition (connue sous le nom de « Ark » 
[Arche]) de Science et Santé par Asa G. Eddy.207 On lit à la page cinq : 
« Nul ne doit s’adresser à l’auteure pour des conseils sur les maladies ou 
pour traiter des patients. Elle ne travaille pas actuellement dans ce 
domaine d’activité. »208 (Dans une lettre de 1877, elle indique qu’elle a 
inclus « La Clef des Ecritures » dans la deuxième édition ; en réalité, cette 
partie ne sera ajoutée que dans la sixième édition, en 1883.)209 

1878, 29 octobre Gilbert Eddy et Edward J. Arens sont accusés de complot dans le meurtre 
de Daniel H. Spofford.210 L’affaire est classée sans suite le 31 janvier 
1879, lorsque Spofford est retrouvé bien vivant,211 et que l’un des 
principaux témoins reconnaît avoir menti sous serment, à la demande de 
Spofford.212 

1878, 8 novembre Le procès Glover contre Kennedy passe en jugement devant un jury de la 
Cour suprême du comté de Suffolk. Le jury se prononce en faveur de 
Richard Kennedy.213 L’avocat de Mary Baker Eddy soulève des objections 
au verdict le 6 janvier 1879.214 Ces objections sont rejetées par le tribunal 
le 23 octobre 1879.215 

1878, 24 novembre Début d’une série de sermons le dimanche après-midi dans la sacristie de 

                                                
205 Cour suprême du comté d’Essex, inscriptions au registre, n.d. ; Subject File, Milmine – Georgine Collection – 
Affidavits and Interviews [Item 71]. 
206 Association scientiste chrétienne, compte rendu de réunion, vol. 1, 15 août 1878, EOR10, 54. 
207 Mary Baker Eddy, Science et Santé, 2e éd., vol. 1 (Lynn, MA: Dr Asa G. Eddy, 1878). 
208 Ibid., 5. 
209 Mary Baker Eddy à Daniel H. Spofford, 14 avril 1877, L07816. 
210 « That Conspiracy » [Le complot], The Boston Daily Globe, 30 octobre 1878 ; Subject File, Spofford, Daniel H. – 
Info Re: “Conspiracy to Murder Daniel Spofford”. 
211 « The Conspiracy Affair » [L’affaire du complot], The Lynn Transcript, 8 février 1879, Mary Baker Eddy, album, 
8 février 1879, SB001A, 2. 
212 Asa G. Eddy, « A Personal Vindication » [Une vengeance personnelle], Boston Daily Evening Traveler, Mary 
Baker Eddy, album, 11 février, 1879, SB001A, 7. 
213 Verdict du jury, 8 novembre 1878 ; Subject File, Eddy, Mary Baker – Lawsuits – Glover [Mary Baker] vs. 
Kennedy. 
214 N. D. A. Clarker, objection de la plaignante, 6 janvier 1879 ; Subject file, ibid. 
215 Rejet des objections, 23 octobre 1879 ; Subject file, ibid. 
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l’église baptiste du Tabernacle, sur Shawmut Avenue, à Boston.216 Elle 
prononce un dernier sermon dans cette église le 2 février 1879.217 

1879, 31 janvier Le procès pour complot contre Edward J. Arens et Asa Gilbert Eddy fait 
l’objet d’un classement sans suite.218 

1879, 16 février Elle prêche à Boston, au Fraternity Hall, dans le Parker Memorial 
Building situé sur Berkeley Street (entrée sur Appleton Street),219 jusqu’au 
29 juin.220 

1879, 12 avril Quatorze ou quinze membres de l’Association scientiste chrétienne votent 
en faveur de l’organisation d’une église221 dont le gouvernement sera 
démocratique et l’assemblée souveraine. Elle est nommée au comité 
chargé de rédiger les articles de foi.222 A l’origine, l’église n’a que trois 
articles de foi.223 

1879, 4 juin L’affaire Eddy contre Tuttle et coll. est portée devant le tribunal des 
successions à Salem.224 A ce stade, George H. Tuttle n’est plus visé par la 
plainte, et Charles S. Stanley est le seul accusé. L’affaire est tranchée en 
faveur de l’accusé, Stanley.225 L’avocat de Mary Baker Eddy fait appel  
de cette décision, mais elle se désiste de cet appel en juillet 1880.226 

1879, 16 août Les membres décident d’ordonner Mary Baker Eddy pasteur de 
l’Eglise.227 Cette demande lui est faite le 22 août,228 mais elle n’y répond 
favorablement que le 1er décembre.229 

1879, 19 août L’Eglise soumet une demande officielle de charte auprès du 

                                                
216 Herald Supplement, 23 novembre 1878 ; Subject File, Eddy, Mary Baker – Writings – Lectures and Addresses. 
217 Herald Supplement, 1er février 1879 ; Subject File, ibid. 
218 « The Conspiracy Affair », The Lynn Transcript, 8 février 1879, Mary Baker Eddy, album, 8 février 1879, 
SB001A, 2. 
219 Daily Evening Transcript, 15 février 1879 ; Subject File, Eddy, Mary Baker – Writings – Lectures and Addresses. 
220 Daily Evening Traveler, 28 juin 1879 ; Subject File, ibid. 
221 Association scientiste chrétienne, compte rendu de réunion, vol. 1, 12 avril 1879, EOR10, 69. 
222 Eglise du Christ, Scientiste, archives, n.d., EOR13, 71. 
223 Ibid., 72. 
224 « A Remarkable Trial » [Un procès remarquable], Boston Daily Advertiser, 5 juin 1879 ; Subject File, Eddy, Mary 
Baker – Lawsuits – Eddy vs. Tuttle et al. [Stanley]. 
225 Dossier judiciaire, novembre 1880 ; Subject File, ibid. 
226 Ibid. 
227 Eglise du Christ, Scientiste, archives, 16 août 1879, EOR13, 89. 
228 Eglise du Christ, Scientiste, archives, 22 août 1879, EOR13, 90. 
229 Eglise du Christ, Scientiste, archives, 1er décembre 1879, EOR13, 95. 
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Commonwealth du Massachusetts.230 

1879, 23 août La charte est accordée à l’Eglise du Christ (Scientiste).231 

1879, 3 octobre George W. Barry gagne son procès.232 

1879, 16 octobre Les membres de l’Eglise acceptent de tenir des réunions le dimanche 
après-midi.233 

1879, 19 octobre Le premier service de l’Eglise du Christ (Scientiste) se tient à Charlestown 
(un quartier de Boston).234 

1879, 23 octobre Rejet des objections au verdict émises par la plaignante, dans l’affaire 
Glover contre Kennedy, en raison de la disparition inexpliquée d’un billet 
à ordre signé par Richard Kennedy en 1870, billet censé se trouver dans  
le cabinet de l’avocat de Mary Baker Eddy. Cela met fin à toute action  
en justice dans l’espèce concernée.235 

1879 novembre Les Eddy déménagent à Boston pour dix mois, mais ils n’ont pas de 
domicile fixe. Ils habitent d’abord au 133 West Newton Street (près de 
Tremont Street) pendant au moins cinq semaines.236 Elle voit son fils, 
George Washington Glover II, pour la première fois depuis 1856.237 Il vit 
à présent dans le Territoire du Dakota, et vient spécialement dans l’Est 
pour la voir. Il quitte Boston pour retourner à Deadwood le 5 février 
1880.238 

1879, 30 novembre Les services religieux de l’Eglise du Christ (Scientiste) se tiennent à 
présent au Hawthorne Hall, 2 Park Street, à Boston.239 

                                                
230 Eglise du Christ, Scientiste, archives, 23 août 1879, EOR13, 89. 
231 Ibid. 
232 J. A. Gillis, jugement, 3 octobre 1879 ; Subject File, Eddy, Mary Baker – Lawsuits – Barry vs. Eddy. 
233 Eglise du Christ, Scientiste, archives, 16 octobre 1879, EOR13, 93. 
234 Ibid. 
235 Rejet des objections, 23 octobre 1879 ; Subject File, Eddy, Mary Baker – Lawsuits – Glover [Mary Baker] vs. 
Kennedy. 
236 Eglise du Christ, Scientiste, archives, 1er décembre 1879, EOR13, 94 ; Eglise du Christ Scientiste, archives, 2 
janvier 1880, EOR13, 96. 
237 Association scientiste chrétienne, compte rendu de réunion, vol. 1, 22 novembre 1879, EOR10, 86. 
238 Mary Baker Eddy à George Choate, 12 février 1880, L04079. 
239 Daily Evening Traveler, 29 novembre 1879 ; Subject File, Eddy, Mary Baker – Writings – Lectures and 
Addresses. 
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1880 début janvier Les Eddy logent au 221 West Springfield Street pour au moins dix jours. 
Ils sont mis en demeure de quitter les lieux.240 

1880, 4 janvier L’Eglise célèbre son premier service de communion.241 

1880 fin janvier Les Eddy séjournent avec Clara Elizabeth Choate et George D. Choate à 
l’hôtel Hosmer, au 32 Hammond Street, à Boston,242 puis ils emménagent 
avec eux au 551 Shawmut Avenue, à Boston, où ils vivent pendant cinq 
mois.243 

1880 février Elle enseigne une classe.244 

1880, 14 mars Elle prononce le sermon « The People’s God and Its Effect on Health and 
Morals » [Le Dieu du peuple et Ses effets sur la santé et les mœurs].245  

1880, 18 avril Elle prononce le sermon « Christian Healing » [La guérison chrétienne]  
à Hawthorne Hall, en se basant sur l’Evangile selon Marc, 16:18.246  

1880 mai Elle enseigne une classe.247 

1880, 19 mai Son sermon La guérison chrétienne devient la première brochure sur la 
Science Chrétienne publiée pour être diffusée.248 

1880, 2 juin Edward J. Arens est expulsé de l’Association scientiste chrétienne.249 

1880 juin-août Les Eddy séjournent chez Madame Blanchard, au 34 Warren Street, à 

                                                
240 Mary Baker Eddy à James Ackland, 21 janvier 1880, L10638. 
241 Eglise du Christ, Scientiste, archives, 4 janvier 1880, EOR13, 96. 
242 Clara E. Choate, « Patience under Tribulation » [Patience dans les tribulations], n.d., Souvenirs, Clara Choate 2 ; 
Asa Eddy, carnet § 1, 75. 
243 Mary Baker Eddy à James C. Howard, 9 février 1880, L12926 ; Boston City Directory [annuaire de la ville de 
Boston] (Boston: Sampson, Davenport, and Company, 1880) ; Mary Baker Eddy: Subject File, Eddy, Mary Baker – 
Residences – Boston (Area) ; Eddy à George W. Glover, 22 août 1880, L02095. 
244 Mary Baker Eddy, carnet, février 1880, EF130. 
245 « Lectures and Meetings » [Conférences et réunions], Boston Evening Transcript, 13 mars 1880, Subject File, 
Eddy, Mary Baker – Writings – Lectures and Addresses. 
246 Mrs. Glover Eddy, Christian Healing: A Lecture [La guérison chrétienne : une conférence], (Cambridge, MA: 
John Wilson and Son, 1880). 
247 Mary Baker Eddy, carnet, mai 1880, EF130. 
248 John Wilson and Son à Mary Baker Eddy, 19 mai 1880, IC334a.45.001. 
249 Association scientiste chrétienne, compte rendu de réunion, vol. 1, 2 juin 1880, EOR10, 100. 
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Concord, dans le New Hampshire,250 mais Mary Baker Eddy retourne  
à Boston au moins une fois durant cette période.251 

1880, 21 juillet Les Eddy annulent leur demande d’appel de la décision rendue dans 
l’affaire Eddy contre Tuttle et coll.252 

1880, 15 août Les Eddy séjournent dans la famille de Mary Baker Eddy, à Tilton, 
pendant une semaine.253 

1880 septembre Les Eddy retournent au 8 Broad Street, à Lynn.254 Elle enseigne une classe 
dont fait partie Julia S. Bartlett.255 Julia Bartlett sera un soutien 
indéfectible de Mary Baker Eddy jusqu’à la fin de la vie de celle-ci.  
Elle continuera de travailler pour la Cause durant bien des années encore.  

1880, 6 octobre Un « contrat d’association » signé par Mary Baker Eddy et six élèves 
donne naissance au Massachusetts Metaphysical College.256  

1880 novembre Elle enseigne une classe.257  

1880, 29 décembre Lors d’une assemblée de l’Association scientiste chrétienne, motion est 
faite de nommer des missionnaires pour que la Science Chrétienne soit 
davantage connue et plus largement reconnue.258 

1880, 31 décembre La première assemblée des signataires du contrat d’association est tenue 
pour l’ouverture du Massachusetts Metaphysical College.259 

1881, 31 janvier Le Massachusetts Metaphysical College obtient sa charte à Boston.260 

                                                
250 Mary Baker Eddy à James C. Howard, 14 juillet 1880, L08655 ; Mary Baker Eddy à James C. Howard et « Ike », 
27 juillet 1880, L08656 ; Mary Baker Eddy à James C. Howard, 29 juillet 1880, L08657 ; Mary Baker Eddy à James 
C. Howard, 3 août 1880, L08658 ; Mary Baker Eddy à James C. Howard, 4 août 1880, L08659. 
251 Mary Baker Eddy à George D. Choate, 26 juin 1880, L02477 ; Association scientiste chrétienne, compte rendu de 
réunion, vol. 1, 30 juin 1880, EOR10, 103. 
252 Cour suprême du comté d’Essex, inscriptions au registre, n.d. ; Subject File, Milmine, Georgine Collection – 
Affidavits and Interviews [Item 71]. 
253 Abigail Tilton à Mary Baker Eddy, 22 août 1880, IC352.48.003. 
254 Mary Baker Eddy à James C. Howard, 4 août 1880, L08659. 
255 Mary Baker Eddy, carnet, septembre 1880, EF130. 
256 Mary B. G. Eddy, Charles J. Eastman, James C. Howard, Henry L. Bancroft, Hosea E. Stone, Edgar S. Woodbury 
et Hugh Hart, Contrat d’association ; Subject File, Massachusetts Metaphysical College - James C. Howard Material. 
257 Mary Baker Eddy, carnet, novembre 1880, EF130. 
258 Association scientiste chrétienne, compte rendu de réunion, vol. 1, 20 décembre 1880, EOR10, 116. 
259 Massachusetts Metaphysical College, archives, 31 décembre 1880, EOR21, 1. 
260 Commonwealth du Massachusetts, charte, 31 janvier 1881, EOR37.B. 
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Mary Baker Eddy en devient l’unique présidente et enseigne toutes les 
classes, à l’exception de six d’entre elles, au cours des huit années qui 
suivent. Asa Gilbert Eddy enseigne deux classes,261 Ebenezer J. Foster 
Eddy trois classes,262 et Erastus N. Bates une classe.263 Le College est 
fermé en 1889,264 mais la charte est conservée. Le College rouvrira « en 
tant qu’auxiliaire de son église », en 1899, lors de la création du Conseil 
d’Instruction.265 

1881 mars Elle enseigne une classe.266  

1881 fin juillet-début août Les Eddy partent en vacances pour deux ou trois semaines.267  

1881 août Publication de la troisième édition de Science et Santé (en deux 
volumes).268 Le dessein de l’emblème de la croix et de la couronne 
apparaît pour la première fois sur la couverture. 

1881, 6 septembre Elle commence à enseigner une nouvelle classe.269 

1881, 16 octobre Elle enseigne à une classe dont fait partie Calvin A. Frye.270 Il sera son 
secrétaire particulier de 1882 jusqu’à sa mort, en 1910. 

1881, 26 octobre Lors de l’assemblée de l’Association scientiste chrétienne à Lynn, huit 
élèves rebelles présentent à l’Association une lettre datée du 21 octobre 
l’accusant de mauvaise conduite. Ils démissionnent de l’Association.271 

1881, 9 novembre Chez elle, à Lynn, elle est ordonnée Pasteur de son église selon  

                                                
261 Mary Baker Eddy, Rétrospection, 43. 
262 Mary Baker Eddy à Mary E. Dillingham, 30 octobre 1888, V03099 ; Mary Baker Eddy à Sarah E. Lindsay, 29 
avril 1889, L04762 ; Mary Baker Eddy à Clara M. S. Shannon, 19 mai 1889, V04976. 
263 Calvin Frye, « College Notice » [Avis du College], The Christian Science Journal, octobre 1889, insertion. 
264 Massachusetts Metaphysical College, archives, 29 octobre 1889, EOR21, 39. 
265 Mary Baker Eddy à William B. Johnson, 24 février 1898, L00714. 
266 Mary Baker Eddy, Science et Santé avec la Clef des Ecritures (Boston: Trustees Under the Will of Mary Baker 
Eddy, 1934), xii. 
267 Les Eddy n’assistent pas aux réunions de la CSA de fin juillet ni à celle du 3 août, mais sont présents à celle du 
17 août. Nulle part il n’est fait mention de leur lieu de vacances dans la correspondance de la CSA ou dans les 
comptes rendus de réunion. 
268 Mary Baker Eddy, Science et Santé (Lynn, MA: Dr. Asa G. Eddy, 1881) ; Mary Baker Eddy à Eldridge J. Smith, 
22 novembre 1881, L02053. 
269 Mary Baker Eddy, carnet, 6 septembre 1881, EF127. 
270 Mary Baker Eddy, carnet, 16 octobre 1881, EF127. 
271 Association scientiste chrétienne, compte rendu de réunion, vol. 1, EOR10, 140 ; A. A. Draper, 26 octobre 1881, 
L09677. 

mailto:recherche@mbelibrary.org
https://www.marybakereddylibrary.org/fr/


 
 

210 Massachusetts Avenue, Boston, MA 02115, Etats-Unis ∙ +1 617 450 7218 
recherche@mbelibrary.org ∙ marybakereddylibrary.org/fr/ 

© 2002, 2017, traduction française © 2021 The Mary Baker Eddy Library 
 

25 

les lois de l’Etat du Massachusetts.272 

1882, 21 janvier Les Eddy se rendent à Washington, D.C.,273 où Mary Baker Eddy enseigne 
et donne douze conférences privées.274 Elle visite également Charles Julius 
Guiteau, l’assassin du président James A. Garfield, dans sa prison.275  

Le couple demeure à Washington environ neuf semaines. A la fin de leur 
première semaine, ils sont les hôtes de George H. et Hellen J. Durfee,  
au 13 First Street.276 

1882, 17 mars Les Eddy séjournent à Philadelphie pendant deux semaines avant de 
retourner à Boston.277 

1882, 26 mars Le Boston Sunday Globe publie en première page un article sur la Science 
Chrétienne qui couvre la moitié de la page.278 

1882, 4 avril Les Eddy retournent à Boston.279 

1882, 5 avril Clara Elizabeth Choate donne une réception chez elle, au 590 Tremont 
Street, en l’honneur des Eddy.280 

1882 mi-avril Les Eddy demeurent brièvement au 36 Bromfield Street, à Boston.281 

1882, 24 avril Les Eddy signent un bail d’habitation pour le 569 Columbus Avenue,  
à Boston.282 Elle y habitera pendant un an et dix mois. 

1882, 12 mai Ouverture du College au 569 Columbus Avenue. Elle y enseigne une 
nouvelle classe.283 

                                                
272 Eglise du Christ, Scientiste, archives, 9 novembre 1881, EOR13, 111. 
273 Mary Baker Eddy à Julia S. Bartlett, 20 janvier 1882, L07689. 
274 Circulaire, n.d. ; Subject File, Eddy, Mary Baker – Visits to – Washington, D.C. 
275 Mary Baker Eddy, Ecrits divers 1883-1896, publié à l’origine en anglais avec le titre Miscellaneous Writings 
1883–1896 (Boston: The First Church of Christ, Scientist, 1898), 112. 
276 Eva M. Perley au Bureau of History and Records [Bureau Histoire et Archives], 29 mai 1935 ; Subject File, Eddy, 
Mary Baker – Visits to – Washington, D.C. 
277 Mary Baker Eddy au Col. Eldrige J. et à Mollie Smith, 29 mars 1882, L02056 ; Mary Baker Eddy au Col. Eldridge 
J. et à Mollie Smith, 17 mars 1882, L02057. 
278 « Miracles ? », Boston Sunday Globe, 26 mars 1882 ; Subject File, Christian Science – Articles. 
279 Mary Baker Eddy à Clara Choate, 28 mars 1882, L02502. 
280 Invitation à une réception, 5 avril 1882 ; Subject File, Choate, Clara. 
281 Arthur T. Buswell à Mary Baker Eddy, 15 avril 1882, IC243.39.019. 
282 Mary Baker Eddy, carnet, 24 avril 1882, EF104. 
283 Carnet, 12 mai 1882 ; Subject File, Eddy, Mary Baker – Students by Classes – Student List Recorded by Calvin 
Frye [Second Copy]. 
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1882, 2 ou 3 juin Décès d’Asa Gilbert Eddy (né en 1832).284 

1882, 7 juillet-5 août Accompagnée d’Alice M. Sibley,285 elle demeure pendant un mois  
chez Arthur T. Buswell, à Barton, dans le Vermont, pour se remettre  
de la mort d’Asa Gilbert Eddy.286 Elle prononce son sermon « La guérison 
chrétienne » dans l’église méthodiste locale.287 (Durant cette période, elle 
se rend le 10 juillet à Concord, dans le New Hampshire, où elle passe la 
nuit,288 puis à Warren, dans le Vermont, le 11 juillet,289 et à St. Johnsbury, 
dans le Vermont, le 3 août.)290 

1882, 14 août Calvin A. Frye devient le secrétaire particulier de Mary Baker Eddy,  
et le restera jusqu’à la mort de celle-ci, soit pendant 28 ans.291 Il avait été 
engagé par Asa Gilbert Eddy.292 

1882, 16 août Elle enseigne à nouveau une classe.293 

1882, 1er octobre L’église tient à présent ses services au 569 Columbus Avenue, et ce 
jusqu’au dimanche 24 juin 1883.294 

1882, 23 octobre Elle enseigne à nouveau une classe.295 

1883, 22 janvier Elle enseigne à nouveau une classe.296 

1883, 31 janvier L’Association scientiste chrétienne crée la Compagnie d’édition des 
scientistes chrétiens en vue de la préparation d’« une publication pour le 
bien de la Cause ».297 

                                                
284 Mary Baker Eddy, carnet, n.d. EF104 ; Acte de décès, 4 juin 1882 ; Subject File, Eddy, Asa G. – Decease. 
285 Mary Baker Eddy à Alice Sibley, 4 juillet 1882, L13366. 
286 Mary Baker Eddy à Clara Choate, 16 juillet 1882, L04089. 
287 Orleans County Monitor, 24 juillet 1882 ; Subject File, Eddy, Mary Baker – Visits to – Barton, VT. 
288 Arthur T. Buswell, registre, 7 août 1882 ; Subject File, Buswell, Arthur T. 
289 Ibid. 
290 Ibid. 
291 Mary Baker Eddy, carnet, 14 mars 1882, EF131. 
292 M. Adelaide Still, « Mes années passées dans la maison de Mary Baker Eddy », Nous avons connu Mary Baker 
Eddy, édition augmentée, tome II, 483. 
293 Carnet, 16 août 1882 ; Subject File, Eddy, Mary Baker – Students by Classes – Student List Recorded by Calvin 
Frye [Second Copy]. 
294 Eglise du Christ, Scientiste, archives, 4 décembre 1882, EOR13, 131. 
295 Carnet, 23 octobre 1882 ; Subject File, Eddy, Mary Baker – Students by Classes – Student List Recorded by 
Calvin Frye [Second Copy]. 
296 Ibid., 22 janvier 1883. 
297 Association scientiste chrétienne, compte rendu de réunion, vol. 1, 17 janvier 1883, EOR10, 189 ; Association 
scientiste chrétienne, compte rendu de réunion, vol. 1, 31 janvier 1883, EOR10, 196. 
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1883, 14 mars Le Conseil des directeurs de la Compagnie d’édition des scientistes 
chrétiens se dissout, car « le rédacteur en chef et éditeur est seul juge  
de ce qu’il convient de publier ».298 C’est Mary Baker Eddy qui est la 
rédactrice en chef et l’éditrice.299 

1883 avril Elle porte plainte contre Edward J. Arens pour violation du droit d’auteur. 
Arens s’est établi à Boston comme praticien de la guérison par l’esprit, et 
ses écrits plagient Science et Santé.300 

1883, 14 avril Le premier numéro du Journal of Christian Science (bimestriel) est publié 
par la Christian Scientists’ Publishing Company. Le magazine annonce 
notamment les conférences qu’elle donne le jeudi à 15h au College. Elle 
est rédactrice en chef,301 poste qu’elle occupe jusqu’en septembre 1884.302 

1883, 21 mai Elle passe la nuit à Tilton pour prendre des dispositions concernant le 
monument qui sera érigé sur la tombe d’Asa Gilbert Eddy.303 

1883 août Publication de The People’s God: Its Effect on Health and Christianity 
[Le Dieu du peuple : Ses effets sur la santé et le christianisme] sous forme 
de brochure.304 Ce texte a également été publié dans le Journal de juin.305 

Elle avait prononcé ce sermon le 14 mars 1880.306 

1883, 20 août Elle commence à enseigner une nouvelle classe.307 

1883 septembre  Publication de la sixième édition de Science et Santé, qui inclut  
« La Clef des Ecritures » en tant que chapitre à part, semblable au 
« Glossaire » des dernières éditions.308 

1883, 23 septembre Les réunions du jeudi après-midi sont remplacées par celles  

                                                
298 Association scientiste chrétienne, compte rendu de réunion, vol. 1, 14 mars 1883, EOR10, 206. 
299 Ibid., 205-206. 
300 Mary Baker Eddy, dépôt de plainte, 6 avril 1883 ; Subject File, Eddy, Mary Baker – Lawsuits – Eddy v. Arens – 
Misc. Legal Documents. 
301 Journal of Christian Science, 14 avril 1883, 1. 
302 « Publisher’s Note » [Note de l’éditeur], Journal of Christian Science, septembre 1884, 4. 
303 Mary Baker Eddy à Eldridge J. Smith, 19 mai 1883, L02061. 
304 Certificat de dépôt, 10 août 1883 ; Subject File, Eddy, Mary Baker – Lawsuits – Eddy v. Arens – Copyright. 
305 Mary Baker Eddy, « The People’s God » [Le Dieu du peuple], Journal of Christian Science, juin 1883, 1. 
306 « Lectures and Meetings », Boston Evening Transcript, 13 mars 1880 ; Subject File, Eddy, Mary Baker – Writings 
– Lectures and Addresses. 
307 Carnet, 20 août 1883 ; Subject File, Eddy, Mary Baker – Students by Classes – Student List Recorded by Calvin 
Frye [Second Copy]. 
308 Certificat de dépôt, 21 septembre 1883 ; Subject File, Eddy, Mary Baker – Lawsuits – Eddy v. Arens – Copyright. 
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du vendredi soir.309 

1883, 24 septembre Elle gagne son procès contre Edward J. Arens.310 Le tribunal émet une 
injonction contre la brochure de celui-ci le 4 octobre.311 

1883, 4 novembre Les services religieux du dimanche ont à présent lieu à Hawthorne Hall, 
2 Park Street, à Boston, jusqu’au 18 octobre 1885, sauf pendant l’été.312 

1883, 12 novembre Elle commence à enseigner une nouvelle classe.313 

1883, 27 décembre Elle commence à enseigner une nouvelle classe.314 

1884, 13 février Décès de sa sœur, Martha, (née le 19 janvier 1819).315 

1884, 25 février Elle commence à enseigner une nouvelle classe.316 

1884, 21 mars Elle quitte le 569 Columbus Avenue pour emménager au 571 (juste à 
côté).317 C’est le siège du Massachusetts Metaphysical College, jusqu’à sa 
fermeture en 1889.318 Elle habite au College pendant trois ans et neuf 
mois.  

1884 début mai Elle se rend à Chicago « en réponse à l’appel impératif des personnes qui 
se trouvent là-bas et à mon propre sentiment de nécessité... et en trois 
semaines j’ai enseigné une classe de 25 élèves, donné une conférence... 
dans une maison pleine à craquer, obtenu 20 abonnements pour mon 
Journal, vendu trente exemplaires de Science et Santé, etc. ».319 Elle loge 
durant son séjour au 472 West Randolph Street.320 

                                                
309 « Lectures and Parlor Talks on Christian Science and Metaphysics » [Conférences et causeries privées sur la 
Science Chrétienne et la métaphysique], Journal of Christian Science, octobre 1883, 7. 
310 Cour de circuit du Massachusetts, décret, 24 septembre 1883 ; Subject File, Eddy, Mary Baker – Lawsuits – Eddy 
v. Arens – Misc. Legal Documents. 
311 Ibid. 
312 Eglise du Christ, Scientiste, archives, 22 octobre 1883, EOR13, 139. 
313 Carnet, 12 novembre 1883 ; Subject File, Eddy, Mary Baker – Students by Classes – Student List Recorded by 
Calvin Frye [Second Copy]. 
314 Ibid., 27 décembre 1883. 
315 « Died », The Decatur Herald, 14 février 1884 ; Subject File, Eddy, Mary Baker – Family – Bakers – Martha 
Baker Pilsbury and Luther Pilsbury. 
316 Carnet, 25 février 1884 ; Subject File, Eddy, Mary Baker – Students by Classes – Student List Recorded by Calvin 
Frye [Second Copy]. 
317 Mary Baker Eddy, carnet, 21 mars 1884, EF104. 
318 Mary Baker Eddy, Ecrits divers, 271-274. 
319 Mary Baker Eddy à Eldridge Smith, 25 juin 1884, L02069. 
320 Mary Baker Eddy à Julia Bartlett, 24 mai 1884, L07693. 
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1884, 13 mai Elle enseigne l’unique classe qu’elle aura à Chicago.321 

1884, 25 mai Elle donne une conférence à Hershey Hall, à Chicago, sur le thème :  
« Qui dit-on que je suis ? »322 

1884, 2 août Le Journal devient mensuel.323 

1884, 8 août Elle enseigne pour la première fois le Cours Normal au Massachusetts 
Metaphysical College.324 Les élèves diplômés du Cours Normal sont 
autorisés à enseigner la Science Chrétienne. 

1884 septembre Emma Curtis Hopkins, une élève de Mary Baker Eddy, est nommée 
rédactrice en chef du Journal.325 (Au mois d’avril de l’année suivante, 
Mary Baker Eddy reprend le poste de rédactrice en chef, et Hopkins est 
nommée rédactrice adjointe.326 Le 4 novembre 1885 Hopkins 
démissionne.)327 

1884, 2 septembre Elle commence à enseigner un Cours « Primaire ».328 Le terme permet de 
faire la distinction entre ce cours initial et le Cours « Normal ». 

1884, 3 novembre Elle commence à enseigner un Cours Primaire.329 

1884, 22 décembre Elle commence à enseigner un Cours Primaire.330 

 
1885 février Historical Sketch of Metaphysical Healing [Aperçu historique de la 

guérison métaphysique] est imprimé sous forme de brochure.331 Il s’agit 
essentiellement d’une autobiographie. Après plusieurs révisions et divers 
changements dans le titre, la brochure est étoffée et publiée en novembre 

                                                
321 Carnet, 13 mai 1884 ; Subject File, Eddy, Mary Baker – Students by Classes – Student List Recorded by Calvin 
Frye [Second Copy]. 
322 Chicago Tribune, 25 mai 1884 ; Subject File, Eddy, Mary Baker – Visits to: Chicago, Ill. 
323 Mary Baker Eddy, « Au Revoir », Journal of Christian Science, août 1884, 4. 
324 Carnet, 8 août 1884 ; Subject File, Eddy, Mary Baker – Students by Classes – Student List Recorded by Calvin 
Frye [Second Copy]. 
325 Journal of Christian Science, Septembre 1884, 4. 
326 The Christian Science Journal, avril 1885, en couverture. 
327 Association scientiste chrétienne, compte rendu de réunion, vol. 2, 4 novembre 1885, EOR11.02, 92. 
328 Carnet, 2 septembre 1884 ; Subject File, Eddy, Mary Baker – Students by Classes – Student List Recorded by 
Calvin Frye [Second Copy]. 
329 Carnet, 3 novembre 1884 ; Subject File, ibid. 
330 Ibid., 22 décembre 1884. 
331 Journal of Christian Science, février 1885, 7. 
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1891 sous le titre de Rétrospection et Introspection.332 

1885, 4 février L’Association scientiste chrétienne nomme un Comité de Publication.333 

1885, 7 février Le Journal publie pour la première fois un avis indiquant qu’elle 
n’accepte plus de patients.334 

1885, 8 février Service de communion au Odd Fellows Hall, à Boston, en présence de huit 
cents personnes.335 

1885, 16 février Elle commence à enseigner un Cours Normal.336 

1885 mars Publication de Defence of Christian Science [Apologie de la Science 
Chrétienne] dans le Journal de mars337 et sous forme de brochure.338  

Après bien des révisions et des ajouts, la brochure deviendra plus tard un 
petit livre intitulé Non et Oui, publié à l’origine en anglais avec le titre  
No and Yes.339 Defence of Christian Science est écrit en réponse à des 
attaques du clergé.340 

1885, 2 mars Elle commence à enseigner un Cours Primaire.341 

1885, 16 mars Dans le cadre de l’une des conférences du pasteur Joseph Cook à  
Tremont Temple, à Boston, on lui accorde dix minutes pour répondre  
aux critiques du clergé.342 

1885 avril Le Journal of Christian Science est rebaptisé The Christian Science 
Journal.343 Elle en est à nouveau rédactrice en chef et éditrice.344  

                                                
332 The Christian Science Journal, décembre 1891, 394. 
333 Association scientiste chrétienne, compte rendu de réunion, vol. 2, 4 février 1885, EOR11.01, 54. 
334 Journal of Christian Science, février 1885, 7. 
335 Mary Baker Eddy, Miscellanées, 54. 
336 Carnet, 16 février 1885 ; Subject File, Eddy, Mary Baker – Students by Classes – Student List Recorded by Calvin 
Frye [Second Copy]. 
337 Mary Baker Eddy, « Defence of Christian Science » [Apologie de la Science Chrétienne], Journal of Christian 
Science, mars 1885, 1. 
338 The Christian Science Journal, avril 1885, 18. 
339 « Her Latest Work » [Ses derniers écrits], août 1887, 266. 
340 Mary Baker Eddy, « Defence of Christian Science », Journal of Christian Science, mars 1885, 1. 
341 Carnet, 2 février 1885 ; Subject File, Eddy, Mary Baker – Students by Classes – Student List Recorded by Calvin 
Frye [Second Copy]. 
342 Boston Daily Advertiser, 16 mars 1885 ; Subject File – Tremont Temple. 
343 The Christian Science Journal, avril 1885, en couverture. 
344 Ibid. 
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(Elle en demeure rédactrice en chef jusqu’en janvier 1886.)345 

1885, 20 avril Elle enseigne à nouveau le Cours Primaire.346 

1885, 30 juillet James Henry Wiggin, pasteur unitarien à la retraite, est engagé en tant 
qu’assistant de rédaction.347 Il travaille avec elle sur les seizième et 
cinquantième éditions de Science et Santé avec la Clef des Ecritures.348  

Il est également rédacteur en chef du Journal de janvier à août 1886,349 et 
à nouveau de début 1887 à janvier 1889.350 

1885, 14 septembre Elle enseigne à nouveau le Cours Primaire.351 

1885, 25 octobre Les services du dimanche se tiennent à présent à Chickering Hall, 157 
Tremont Street,352 et ce jusqu’en mars 1894.353 Une école du dimanche est 
officiellement organisée.354 

1885, 4 novembre Emma Curtis Hopkins démissionne de son poste de rédactrice adjointe et 
quitte la Science Chrétienne.355 Elle aura une grande influence au sein du 
mouvement de la Nouvelle Pensée. 

1885, 16 novembre Elle enseigne à nouveau le Cours Primaire.356 

1885, 26 décembre La seizième édition de Science et Santé est protegée par le droit 
d’auteur.357 

                                                
345 The Christian Science Journal, janvier 1886, en couverture. 
346 Carnet, 20 avril 1885 ; Subject File, Eddy, Mary Baker – Students by Classes – Student List Recorded by Calvin 
Frye [Second Copy]. 
347 Mary Baker Eddy, « Mrs. Eddy’s Activity shown » [Mrs. Eddy fait état de son activité], Christian Science 
Sentinel, 1er décembre 1906, 228. 
348 Mary Baker Eddy à James Henry Wiggin, 38 juillet 1885, L02159 ; Mary Baker Eddy à James Henry Wiggin, 
1889, L07612. 
349 The Christian Science Journal, janvier 1886, en couverture ; The Christian Science Journal, septembre 1886, en 
couverture. 
350 « A Miracle? » [Un miracle ?], The Christian Science Journal, avril 1887, 50 ; Rev. James Henry Wiggin, 
« Goodbye » [Au revoir], The Christian Science Journal, janvier 1889, 536. 
351 Carnet, 14 septembre 1885 ; Subject File, Eddy, Mary Baker – Students by Classes – Student List Recorded by 
Calvin Frye [Second Copy]. 
352 Eglise du Christ, Scientiste, archives, 7 décembre 1885, EOR13, 176. 
353 Mary Baker Eddy, Miscellanées, 55. 
354 Eglise du Christ, Scientiste, archives de l’école du dimanche, 25 octobre 1885, EOR14.01, 413. 
355 Association scientiste chrétienne, compte rendu de réunion, vol. 2, 4 novembre 1885, EOR11.02, 442. 
356 Carnet, 16 novembre 1885 ; Subject File, Eddy, Mary Baker – Students by Classes – Student List Recorded by 
Calvin Frye [Second Copy]. 
357 Henry M. Baker, Archibald McLellan et Josiah E. Fernald, cession du droit d’auteur, 6 mars 1907 ; Subject File, 
Eddy, Mary Baker – Writings – Copyright. 
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1886 janvier James Henry Wiggin est nommé rédacteur en chef du Journal.358  

(Il occupe ce poste jusqu’en août,359 puis reprend ces fonctions  
au début de l’année 1887.)360 

1886, 29 janvier Création de l’Association nationale des scientistes chrétiens (NCSA).  
Elle organise une convention générale le 10 février dans la ville de New 
York.361 Les assemblées annuelles ont lieu à Boston en 1886 et 1887,362 à 
Chicago en 1888,363 à Cleveland en 1889,364 et à New York en 1890.365 En 
mai 1890, elle suggère que la NCSA se dissolve ou suspende ses activités 
pour se réunir à nouveau dans trois ans.366 L’Association se réunit à 
nouveau en septembre 1893 à Chicago, au moment du Parlement des 
religions, dans le cadre de l’Exposition universelle.367 

 Alors que la CSA est une association dont seuls ses élèves sont membres, 
la NCSA accueille ses élèves ainsi que les élèves des professeurs qui ont 
suivi le Cours Normal au Massachusetts Metaphysical College. 

1886 février Publication de la seizième édition de Science et Santé, augmentée de 
nombreux ajouts, réarrangée et imprimée en un seul volume pour la 
première fois depuis la première édition.368 Le livre comporte également 
un index préparé par James Henry Wiggin.369 

1886, 22 février Elle enseigne à nouveau le Cours Normal.370 

                                                
358 The Christian Science Journal, janvier 1886, en couverture. 
359 The Christian Science Journal, septembre 1886, en couverture. 
360 « A Miracle? », The Christian Science Journal, avril 1887, 50. 
361 « A National Association » [Une association nationale], The Christian Science Journal, février 1886, 209-210. 
362 « National Christian Scientist Association » [Association nationale des scientistes chrétiens], The Christian 
Science Journal, août 1886, 118 ; L., « National Christian Science Association », The Christian Science Journal, mai 
1887, 101. 
363 « National Convention in Chicago » [Convention nationale à Chicago], The Christian Science Journal, juillet 
1888, 206. 
364 « Official Minutes of Fourth Annual Meeting, N. C. S. Association » [Compte rendu officiel de la quatrième 
Assemblée annuelle, Association nationale des scientistes chrétiens], The Christian Science Journal, juillet 1889, 
172. 
365 « Editor’s Note Book » [Carnet du rédacteur en chef], The Christian Science Journal, juillet 1890, 163-178. 
366 Mary Baker Eddy, « To the National Christian Scientist Association » [A l’Association nationale de scientistes 
chrétiens], The Christian Science Journal, juillet 1890, 139-140. 
367 « Christian Science at the World’s Religious Congress » [La Science Chrétienne au Parlement des religions du 
monde], The Christian Science Journal, novembre 1893, 337-346. 
368 « Science and Health » [Science et Santé], The Christian Science Journal, mars 1886, 240. 
369 Mary Baker Eddy à James Henry Wiggin, 25 juin 1885, L02158. 
370 Carnet, 22 février 1886 ; Subject File, Eddy, Mary Baker – Students by Classes – Student List Recorded by Calvin 
Frye [Second Copy]. 
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1886, 29 mars Elle enseigne à nouveau le Cours Primaire.371 

1886 avril Les diplômes de C.S.B. et de C.S.D. sont mentionnés dans le Journal pour 
la première fois.372 Les élèves ayant obtenu le diplôme de C.S.D. sont 
habilités à enseigner.373 

1886, 3 mai Elle enseigne à nouveau le Cours Normal.374 

1886, 1er juillet Au nom de l’Eglise, William H. Bradley, trésorier, prend une hypothèque 
sur une parcelle de terrain située à l’angle de Falmouth Street, achetée à 
Nathan Matthews, dans le but d’y construire un édifice d’église.375 

1886, 22 août Décès de sa sœur, Abigail, (née le 15 janvier 1816).376 

1886, 30 août Elle enseigne à nouveau le Cours Primaire.377 

1886 septembre William I. Gill devient le rédacteur en chef du Journal pendant quatre 
mois.378 

1886, 4 octobre Elle enseigne à nouveau le Cours Normal.379 

1886, 29 octobre Elle vend le Journal à six de ses élèves membres de l’Association 
scientiste chrétienne afin de le publier en tant que Société d’édition  
de la Science Chrétienne.380 En octobre 1888, tous les membres de 
l’Association, à l’exception d’un seul (Calvin A. Frye) en ont démissionné 
ou en ont été exclus. (Les autres membres sont Sarah H. Crosse,381 

                                                
371 Ibid., 29 mars 1886. 
372 « Advertisements » [Annonces], The Christian Science Journal, avril 1886, 28. 
373 Mary Baker Eddy, « Degrees Conferred by the Mass. Metaphysical College » [Diplômes attribués par le 
Massachusetts Metaphysical College], The Christian Science Journal, février 1886, 215. 
374 Carnet, 3 mai 1886 ; Subject File, Eddy, Mary Baker – Students by Classes – Student List Recorded by Calvin 
Frye [Second Copy]. 
375 Actes de fiducie, 2 septembre 1886, Subject File, The First Church of Christ, Scientist – Edifices – Land 
376 New Hampshire Patriot and State Gazette, 26 août 1886 ; Subject File, Eddy, Mary Baker – Family – Bakers – 
Abigail Baker Tilton. 
377 Carnet, 30 février 1886 ; Subject File, Eddy, Mary Baker – Students by Classes – Student List Recorded by Calvin 
Frye [Second Copy]. 
378 S. H. C., « A Valedictory and Introduction » [Hommage et présentation], The Christian Science Journal, 
septembre 1886, 148. 
379 Carnet, 4 octobre 1886, Subject File, Eddy, Mary Baker – Students by Classes – Student List Recorded by Calvin 
Frye [Second Copy].]. 
380 Mary Baker Eddy à Sarah H. Crosse et autres, 29 octobre 1886, L09065. 
381 Association scientiste chrétienne, compte rendu de réunion, 8 août 1888, EOR11.03, 589. 
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William I. Gill,382 William H. Bradley,383 George H. Bradford,384 et 
Charles A. S Troup.)385 Mary Baker Eddy reprend la direction du Journal 
en octobre 1888.386 

1886, 31 octobre Service d’inauguration du premier bâtiment construit à Oconto,  
dans le Wisconsin, pour y tenir des services de la Science Chrétienne.387 

La dédicace a lieu le 20 février 1887.388 

1886, 3 décembre Elle vend la maison du 8 Broad Street, à Lynn, à Benjamin E. Curtin pour 
4 800 $.389 

1887 début James Henry Wiggin remplace William I. Gill au poste de rédacteur en 
chef.390 (Il y restera jusqu’en janvier 1889.)391 

1887 janvier Un « Free Dispensary of Christian Science Healing » [Dispensaire gratuit 
de la guérison par la Science Chrétienne] ouvre au 3 Boylston Place, à 
Boston.392 C’est une initiative personnelle d’un groupe de membres 
d’église. L’établissement n’a aucun lien officiel avec l’Eglise ou 
l’Association de Mary Baker Eddy. 

1887, 10 janvier Elle enseigne à nouveau le Cours Primaire.393 

1887, 7 février Elle enseigne à nouveau le Cours Normal.394 

1887, 6 avril L’Association scientiste chrétienne vote l’ouverture éventuelle d’« une 
salle de lecture et d’attente », à Boston.395 

                                                
382 Association scientiste chrétienne, compte rendu de réunion, 6 avril 1887, EOR11.02, 503. 
383 Association scientiste chrétienne, compte rendu de réunion, 3 octobre 1888, EOR11.04, 598. 
384 Association scientiste chrétienne, compte rendu de réunion, 12 juin 1888, EOR11.03, 568-569. 
385 Ibid. 
386 Calvin Frye, carnet, octobre 1888, EF007. 
387 Genevieve B. Sargent, « Date of Erection of Edifice » [Date de construction de l’édifice], 1950 ; emplacement 
dans les Archives de l’Eglise : Church Archives, box 530767, folder 239774. 
388 Ibid. 
389 Chain, n.d. ; Subject File, Eddy, Mary Baker – Residences – Lynn – Deeds. 
390 « A Miracle? », The Christian Science Journal, avril 1887, 50. 
391 Rev. James Henry Wiggin, « Goodbye », The Christian Journal, janvier 1889, 536. 
392 Mrs. George H. Meader, « Dispensary Work » [Activité du dispensaire], The Christian Science Journal, juin 1889, 
154-155. 
393 Carnet, 10 janvier 1887 ; Subject File, Eddy, Mary Baker – Students by Classes – Student List Recorded by Calvin 
Frye [Second Copy]. 
394 Ibid., 7 février 1887. 
395 Association scientiste chrétienne, compte rendu de réunion, 6 avril 1887, EOR11.02, 503. 
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1887, 13 et 14 avril Elle prononce un discours devant l’Association nationale des scientistes 
chrétiens au Meionaon Hall, à Tremont Temple.396 Elle commence sa 
causerie en rappelant que, deux ans plus tôt, en 1885, on lui avait accordé 
dix minutes « pour répondre à une lettre cinglante qui avait été à cette 
époque lue en public ».397 

1887, 2 mai Elle enseigne à nouveau le Cours Primaire.398 

1887 juin Dans un article intitulé « Mind-Healing History » [Histoire de la guérison 
par l’Entendement], publié dans le Journal de juin, elle offre de payer les 
frais de publication des manuscrits de Phineas Parkhurst Quimby.399 

1887, 6 juin Elle enseigne un Cours d’Obstétrique pour la première fois.400 

1887 août Publication de Christian Science: No and Yes [Science Chretienne :  
Non et Oui] – titré ensuite Non et Oui en 1891.401 (L’avis publié dans le 
Journal indique que Non et Oui fait plus que remplacer Defence of 
Christian Science, publié initialement en 1885.)402 

1887, 3 octobre Elle enseigne à nouveau le Cours Normal.403 

1887, 19 octobre Congrès des praticiens de la guérison par l’esprit, à Boston.404  

Mary Baker Eddy n’y assiste pas. 

1887, 30 octobre Elle enseigne à nouveau le Cours Normal.405 

1887 novembre La famille de George Washington Glover Jr. se rend à Boston pour huit 

                                                
396 L., « National Christian Science Association », The Christian Science Journal, mai 1887, 101-102. 
397 Mary Baker Eddy, « NCSA », n.d., A11146. 
398 Carnet, 2 mai 1887 ; Subject File, Eddy, Mary Baker – Students by Classes – Student List Recorded by Calvin 
Frye [Second Copy]. 
399 Mary Baker Eddy, « Mind-Healing History » [Histoire de la guérison par l’Entendement], The Christian Science 
Journal, juin 1887, 109-118. 
400 Carnet, 6 juin 1887 ; Subject File, Eddy, Mary Baker – Students by Classes – Student List Recorded by Calvin 
Frye [Second Copy]. 
401 « Her Latest Work », The Christian Science Journal, août 1887, 266. 
402 « Economic Hints » [Des conseils profitables], The Christian Science Journal, août 1887, 270. 
403 Carnet, 3 février 1887 ; Subject File, Eddy, Mary Baker – Students by Classes – Student List Recorded by Calvin 
Frye [Second Copy]. 
404 « The Mental Healers » [Les praticiens de la guérison par l’esprit], Boston Daily Advertiser, 20 octobre 1887. 
405 Mary Baker Eddy à Lizzie T. Harmony, 22 septembre 1887, L12252 ; M. B. Eddy à Emma A. Estes, 23 septembre 
1887, L12741 ; M. B. Eddy à Harriet V. W. Bennett Coursen, 22 septembre 1887, L127 20 ; M. B. Eddy à Ruth B. 
Ewing, 22 septembre 1887, L15648. 
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mois.406 Publication de Rudiments and Rules of Divine Science 
[Rudiments et Règles de la Science divine].407 La brochure sera rebaptisée 
Rudimental Divine Science en 1891 (ultérieurement traduite avec le titre 
Rudiments de la Science divine),408 mais ce n’est qu’en juin 1893 qu’elle 
sera mise en vente sous ce titre.409 

1887, 7 novembre Elle enseigne à nouveau le Cours Primaire.410  

1887, 5 décembre Elle enseigne à nouveau le Cours d’Obstétrique.411 

1887, 19-21 décembre Une collecte de fonds est organisée au Horticultural Hall pour financer la 
construction de l’église.412 

1887 fin décembre Elle emménage dans sa nouvelle maison au 385 Commonwealth Avenue, 
à Boston.413 Elle y habitera un an et demi. 

1888, 30 janvier Elle enseigne à nouveau le Cours Normal.414 

1888, 26 février Avant de prononcer un sermon sur « Les noms et le baptême », elle 
baptise 29 enfants, dont trois de ses petits-enfants (Gershom, Mary et 
Evelyn), lors d’une cérémonie de baptême à Chickering Hall.415 

1888 mars Publication de Unity of Good and Unreality of Evil [Unité du bien et 
irréalité du mal] (protégé par le droit d’auteur en 1887).416 La brochure 
sera retitrée Unity of Good en 1891 (ultérieurement traduite avec  

                                                
406 George W. Glover à Mary Baker Eddy, 23 octobre 1887, IC197.32.011 ; Mary Baker Glover Billings, « Memories 
of My Grandmother » [Souvenirs de ma grand-mère], 2 août 1941, Souvenirs, Mary Baker Glover Billings, 2. 
407 « Rudiments and Rules of Divine Science » [Rudiments et règles de la Science divine], The Christian Science 
Journal, novembre 1887, 432. 
408 Mary Baker Eddy, Rudiments de la Science divine, publié à l’origine en anglais avec le titre Rudimental Divine 
Science, 10e édition révisée, (Boston: E. J. Foster Eddy, 1891). 
409 The Christian Science Journal, juin 1893, troisième de couverture. 
410 Carnet, 7 novembre 1887 ; Subject File, Eddy, Mary Baker – Students by Classes – Student List Recorded by 
Calvin Frye [Second Copy]. 
411 Ibid., 5 décembre 1887. 
412 S. H. C. « Fair Matters » [Un événement important], The Christian Science Journal, décembre 1887, 478. 
413 « Change of Material Base » [Changement de base matérielle], The Christian Science Journal, janvier 1888, 532. 
414 Carnet, 30 février 1888 ; Subject File, Eddy, Mary Baker – Students by Classes – Student List Recorded by Calvin 
Frye [Second Copy]. 
415 26 février 1888, A10644 ; Mary Baker Eddy, 26 février 1888, A10665 ; « Suffer Little Children to Come unto 
Me » [Laissez les petits enfants venir à moi], The Christian Science Journal, mars 1888, 632 ; Mary Baker Glover 
Billings, « Memories of My Grandmother », 2 août 1941, Souvenirs, Mary Baker Glover Billings, 2. 
416 « Mrs. Eddy’s New Book » [Le nouveau livre de Mary Baker Eddy], The Christian Science Journal, mars 1888, 
635. 
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le titre Unité du Bien).417 

 Le trésorier, William H. Bradley, s’enfuit avec l’argent récolté pour le 
paiement de l’hypothèque sur le terrain de l’édifice original.418 

1888, 5 mars Elle enseigne à nouveau le Cours Primaire.419 

1888, 21 mai Elle enseigne à nouveau le Cours Normal.420  

1888 juin Abbie A. Corner est acquittée d’une accusation d’homicide involontaire 
après la mort de sa fille (et de l’enfant mort-né de celle-ci) qu’elle assistait 
durant son accouchement, au printemps 1888.421 

1888, 11 juin Elle se rend à Chicago, dans l’Illinois, et demeure à l’hôtel Palmer House 
pendant moins d’une semaine.422 

1888, 12 juin Des élèves dissidents de l’Association scientiste chrétienne, à Boston, 
l’accusent d’inconduite.423 36 élèves recevront une lettre de radiation au 
cours de l’année suivante.424 

1888, 13 juin Au cours de l’après-midi elle s’adresse à l’Association nationale des 
scientistes chrétiens lors du congrès de l’Association à Chicago.425 

1888, 14 juin Elle donne son allocution, « La Science et les sens », au Central Music 
Hall, à Chicago, devant trois à quatre mille personnes,426 dont  
Susan B. Anthony [militante américaine des droits de la femme].427 

1888 août Elle séjourne durant deux semaines dans le New Hampshire et donne une 

                                                
417 Henry M. Baker, Archibald McLellan et Josiah E. Fernald, cession de droits d’auteur, 6 mars 1907 ; Subject File, 
Eddy, Mary Baker – Writings – Copyright. 
418 Eglise du Christ, Scientiste, compte rendu de réunion, 31 mail 1888, EOR13.02, 224. 
419 Carnet, 5 mars 1888, Subject File, Eddy, Mary Baker – Students by Classes – Student List Recorded by Calvin 
Frye [Second Copy]. 
420 Adeline T. Ricker, mai 1888, L10437A. 
421 « The Corner Case » [L’affaire Corner], The Christian Science Journal, août 1888, 258. 
422 Mary Baker Eddy, « To Loyal Christian Scientists » [« Aux scientistes chrétiens loyaux »], The Christian Science 
Journal, juillet 1888, 212-214. 
423 Association scientiste chrétienne, compte rendu de la réunion, 12 août 1888, EOR11.03, 564. 
424 Ibid., 568-569. 
425 « National Convention in Chicago », The Christian Science Journal, juillet 1888, 206. 
426 Boston Evening Traveler, 23 juin 1888, L10452. 
427 Susan B. Anthony à Mary Baker Eddy, 19 juin 1903, IC519.56.005. 
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causerie informelle à Fabyan House, à Fabyan.428 Elle rend ensuite visite à 
Oscar et Flavia S. Knapp et leur famille dans la ville voisine de Lyman.429 

1888 septembre L’Association scientiste chrétienne ouvre une salle de lecture à l’hôtel 
Boylston, à Boston,430 au 24 Boylston Street (renuméroté plus tard  
62 Boylston Street).431 

1888, 17 septembre Elle enseigne à nouveau le Cours Primaire.432  

1888 octobre L’annonce des services religieux de l’Eglise du Christ (Scientiste), 
Boston, paraît pour la première fois dans le Journal.433 

1888, 15 octobre Elle enseigne pendant une journée le troisième Cours d’Obstétrique. 
Ebenezer J. Foster enseigne les autres jours.434 

1888, 5 novembre Ebenezer J. Foster (1847-1930)435 devient son fils adoptif.436 Il prend le 
nom d’Ebenezer J. Foster Eddy. Il est exclu de l’Eglise le 20 juin 1889.437 

1888, 12 novembre Elle commence à enseigner un Cours Primaire en sept leçons (nombre 
inférieur au nombre de leçons habituellement enseignées pendant les 
autres classes).438 

1888, 4 décembre L’avocat Baxter E. Perry rachète à Nathan Matthews l’hypothèque sur le 
terrain de l’église au nom de Mary Baker Eddy, qui en détient alors la 
propriété.439 

1889  Publication à Chicago de Hymns and Tunes for the Church Of Christ 
(Scientist) [Cantiques et mélodies pour l’Eglise du Christ (Scientiste)].  
La compilation de ce premier hymnaire spécialement conçu pour les 

                                                
428 « From among the Clouds » [Parmi les nuages], The Christian Science Journal, septembre 1888, 322. 
429 Calvin Frye à Frank E. Mason, 21 août 1888, L13728. 
430 « A New Home » [Un nouveau foyer], The Christian Science Journal, septembre 1888, 317. 
431 « Students’ Association » [Association d’élèves], The Christian Science Journal, février 1891, 503. 
432 Carnet, 17 février 1888 ; Subject File, Eddy, Mary Baker – Students by Classes – Student List Recorded by Calvin 
Frye [Second Copy]. 
433 « Sunday services » [Services du dimanche], The Christian Science Journal, octobre 1888, 374. 
434 Mary Baker Eddy à Mary E. Dillingham, 30 octobre 1888, V03099. 
435 Acte de décès, n.d. ; Subject File, Eddy, E. J. Foster – Misc. 
436 Demande d’adoption, 5 novembre 1888 ; Subject File, Eddy, E. J. Foster – Misc. 
437 William B. Johnson à Mary Baker Eddy, 20 juin 1899, IC001dP1.01.032. 
438 Carnet, 12 novembre 1888 ; Subject File, Eddy, Mary Baker – Students by Classes – Student List Recorded by 
Calvin Frye [Second Copy]. 
439 Baxter Perry à Mary Baker Eddy, 5 décembre 1888, IC453.53.002. 
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services de la Science Chrétienne a été réalisée à la propre initiative de 
Jessie Day et publiée par sa mère, O. W. Day.440 

1889 janvier La Société d’édition s’installe à l’hôtel Boylston, au 24 Boylston Street, 
renuméroté plus tard 62.441 

1889 février Joshua F. Bailey est nommé rédacteur en chef du Journal.442 Il restera à ce 
poste jusqu’en novembre 1890.443 

1889, 15 février Elle s’adresse à un auditoire de plus d’un millier de personnes au Steinway 
Hall, à New York, sur le thème « Science et christianisme ». La réunion 
est annoncée seulement 24 heures à l’avance.444  

1889, 25 février-mars Elle enseigne son dernier Cours Primaire en sept leçons à 65 élèves.445 

Joshua F. Bailey prend des notes à sa demande.446  

1889 mars Publication des premiers opuscules de la Science Chrétienne sur une base 
irrégulière – 30 seront publiés au total.447 Certains titres demeurent en 
vente jusqu’à fin avril 1903.448 Ce sont les précurseurs des brochures  
de la Science Chrétienne.  

1889, 5 mars Elle annonce aux élèves du Cours Primaire que les scientistes chrétiens 
peuvent devenir membres de l’« église mère » à Boston même « sans leur 
présence personnelle ».449 Le terme « église mère » apparaît pour la 
première fois dans le Journal d’août 1887.450  

1889 avril Lors du service du dimanche de Pâques, on annonce que « les réunions 
régulières du vendredi soir à l’église se tiendront désormais en public à 
Steinhert Hall [Hôtel Boylston] et comprendront une allocution, le récit 

                                                
440 Jessie Day, compilatrice, Hymns and Tunes for the Church of Christ (Scientist) [Cantiques et musiques pour 
l’Eglise du Christ (Scientiste)] (Chicago: Mrs. O. W. Day, 1889). 
441 The Christian Science Journal, février 1889, en couverture. 
442 Calvin A. Frye à Ellen Brown Linscott, 5 février 1889, L06454. 
443 « Editorial Notice » [Note de la rédaction], The Christian Science Journal, février 1891, 503. 
444 « Editor’s Note Book », The Christian Science Journal, mars 1889, 633. 
445 Carnet, 25 février 1889 ; Subject File, Eddy, Mary Baker – Students by Classes – Student List Recorded by Calvin 
Frye [Second Copy]. 
446 Joshua Bailey, 5 mars 1889, A12065. 
447 « Editorial and Other Notices » [Editorial et autres avis], The Christian Science Journal, mars 1889, 641. 
448 « Literature for Distribution » [Littérature pour la distribution], Christian Science Sentinel, 25 avril 1903, 547. 
449 Joshua Bailey, 5 mars 1889, A12065. 
450 A. M. Harvey, « Cincinnati Pluck » [Courage à Cincinnati], The Christian Science Journal, août 1887, 265. 
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d’expériences et des questions de l’auditoire ».451 L’hôtel Boylston est 
également l’adresse de la Société d’édition et de la salle de lecture. Les 
services du dimanche ont toujours lieu à Chickering Hall.452  

 Lors de ce service de Pâques, on annonce également « qu’une mission de 
la Science Chrétienne ouvrira un dispensaire durant la semaine de Pâques 
pour travailler avec ceux qui ne peuvent payer pour être guéris, et que les 
circonstances empêchent d’entendre “la bonne nouvelle” à moins que des 
messagers de la Vérité ne la leur apportent ».453  

1889, 1er mai Parution du premier numéro du Christian Science Series. Ce périodique 
bimensuel paraît jusqu’au 15 avril 1891. Cette publication est l’idée du 
rédacteur en chef Joshua F. Bailey.454  

1889, 21 mai Elle enseigne le Cours Normal durant une journée.455 Joshua F. Bailey 
prend à nouveau des notes.456 Elle n’enseigne plus jusqu’en novembre 
1898.457 (Ebenezer J. Foster Eddy enseigne les autres jours de ce dernier 
cours, qui s’achève le 25 mai.)458 

1889, 22 ou 23 mai Elle quitte Boston pour séjourner à Barre, dans le Vermont, durant quatre 
semaines.459 

1889, 28 mai Elle renonce à être pasteur de l’Eglise du Christ (Scientiste) de Boston.460 

Lanson P. Norcross d’Oconto, dans le Wisconsin, assume cette charge à 
partir du 25 août.461 Il démissionnera en février 1893.462 

1889, 31 mai L’Association du dispensaire de la Science Chrétienne est organisée.463 

Elle fonctionne sous l’égide de l’Eglise. Les salles d’accueil et le 
dispensaire de la Science Chrétienne sont ouverts au public au  

                                                
451 « Editor’s Note Book », The Christian Science Journal, mai 1889, 100-101. 
452 « Editorial and Other Notices », The Christian Science Journal, avril 1889, 50. 
453 « Editor’s Note Book », The Christian Science Journal, mai 1889, 101. 
454 Mary Baker Eddy à William Nixon, 27 septembre 1889, N00029. 
455 Mary Baker Eddy et Joshua Bailey, 21 mai 1889, A10273. 
456 Ibid. 
457 « An important Event » [Un événement important], The Christian Science Journal, décembre 1898, 588-590. 
458 Mary Baker Eddy à Clara M. S. Shannon, 19 mai 1889, V04976. 
459 Calvin Frye, carnet, 23 mai 1889, EF007. 
460 Mary Baker Eddy à l’Eglise du Christ, Scientiste, 28 mai 1889, L02658. 
461 Lanson Norcross à Mary Baker Eddy, 26 août 1889, IC306.43.007. 
462 Mary Baker Eddy à Lanson Norcross, 4 mars 1893, L11126. 
463 Association du dispensaire de la Science Chrétienne, compte rendu de réunion, 31 mai 1889, EOR01.01, 1. 
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7 Temple Street, à Boston.464 A cette date il existe deux dispensaires à 
Boston.465 Celui qui se trouve au 3 Boylston Place n’est plus annoncé dans 
le répertoire du Journal après le mois de novembre. 

1889 juin Elle annonce dans le Journal la cessation de ses activités de professeure au 
Massachusetts Metaphysical College et de pasteur de l’Eglise du Christ 
(Scientiste), à Boston.466 

 Elle donne le Journal à l’Association nationale des scientistes chrétiens 
lors de la réunion de ses membres, à Cleveland, dans l’Ohio.467 Le Comité 
de Publication de la NCSA est chargé de sa publication jusqu’en 1897.468  

 Elle demande qu’on organise les églises de la Science Chrétienne. Ces 
églises seront finalement des églises filiales de L’Eglise Mère, elle-même 
réorganisée en tant que Première Eglise du Christ, Scientiste, à Boston, 
Massachusetts, en 1892.469 La NCSA est chargée de créer un comité pour 
« veiller sur le travail et l’organisation de l’église ».470 

1889 fin juin Elle loue une maison au 62 North State Street, à Concord, dans le New 
Hampshire, et y reste pendant deux ans et onze mois.471 

1889 juillet L’église est incapable de payer l’hypothèque du terrain situé à l’angle de 
Falmouth Street,472 acheté en juillet 1886, afin d’y construire un édifice 
d’église.473 

1889, 4 juillet Elle passe le Jour de l’Indépendance dans une ferme à Silver Hill, dans le 
New Hampshire.474 

                                                
464 The Christian Science Journal, juillet 1889, 193-201. 
465 The Christian Science Journal, juin 1889, i. 
466 « Editorial and Other Notices », The Christian Science Journal, juin 1889, 156. 
467 « Official Minutes of Fourth Annual Meeting, N.C.S. Association », The Christian Science Journal, juillet 1889, 
172-173. 
468 Mary Baker Eddy à Edward Bates, Joseph Armstrong et Eugene Greene, 17 janvier 1898, L02848. 
469 Association nationale des scientistes chrétiens, compte rendu de réunion, 13 juin 1889, EOR31, 66. 
470 « Official Minutes of Fourth Annual Meeting, N.C.S. Association », The Christian Science Journal, juillet 1889, 
178. 
471 Lewis Strang à Hermann Hering, 20 août 1906, L12352. 
472 Baxter E. Perry à Mary Baker Eddy, 2 juillet 1889, IC453.53.006. 
473 Acte de fiducie, 1er juillet 1886 ; Subject File, The First Church of Christ, Scientist – Edifices – Land. 
474 Mary Salchow, « My Ponderings of Our Great Leader Mary Baker Eddy » [Mes réflexions sur notre grand leader, 
Mary Baker Eddy], 12 février 1936, Souvenirs, Mary Salchow, 1. 
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1889 fin juillet Elle demeure à Boston pendant deux mois.475 

1889 août Elle publie une note sur l’« Ordre des services de l’Eglise » à la page 210 
du Journal d’août. 

1889, 1er septembre Les services de l’église à Boston n’ont plus lieu l’après-midi, mais à 
10h30 du matin, l’école du dimanche étant à 12h.476 

1889, 23 septembre L’Association scientiste chrétienne est dissoute.477 Après la dissolution de 
la CSA, l’« Association Métaphysique de [Emma Curtis] Hopkins » 
décide, lors de sa réunion mensuelle le 30 décembre 1889, de s’appeler 
désormais « L’Association de la Science Chrétienne »,478 nom proche de 
l’association de Mary Baker Eddy, d’autant plus que les initiales, 
identiques, prêtent à confusion. 

1889 fin septembre Elle retourne au 62 North State Street, à Concord.479 

1889 octobre William G. Nixon devient l’éditeur de ses écrits.480 

1889, 29 octobre Dissolution du Massachusetts Metaphysical College.481 

1889, 2 décembre L’Eglise du Christ (Scientiste), Boston, renonce à son organisation 
congrégationaliste suite au vote unanime des membres. Elle conserve son 
nom et continue de tenir ses services du dimanche et ses réunions du 
vendredi soir en tant qu’association bénévole.482 

1889, 9 décembre On apprend par une annonce dans le Boston Herald que la parcelle de 
terrain achetée pour la construction de l’édifice original et qu’elle a 
acquise à la levée de l’hypothèque est disponible à l’achat.483 

                                                
475 Calvin Frye à Frank Mason, 9 septembre 1889, L13740. 
476 The Christian Science Journal, septembre 1889, 338. 
477 « Editor’s Note Book », The Christian Science Journal, décembre 1889, 459. 
478 « “The Hopkins Metaphysical Association” is changed to “The Christian Science Association” » [ « The Hopkins 
Metaphysical Association » est rebaptisée « The Christian Science Association » ], Christian Science: My Words 
Shall Not Pass Away [Science Chrétienne : Mes paroles ne passeront pas], février 1890, 194-195. 
479 Mary Baker Eddy à Laura E. Sergent, 24 septembre 1889, L05954. 
480 « To the Public » [A l’attention du public], The Christian Science Journal, octobre 1899, insertion. 
481 Massachusetts Metaphysical College, compte rendu de réunion, 29 octobre 1889, EOR39. 
482 Mary Baker Eddy à La Première Eglise du Christ, Scientiste, 28 novembre 1889, L00008. 
483 « Notice » [Avis], The Boston Herald, 9 décembre 1889 ; Subject File, The First Church of Christ, Scientist – 
Edifices – Land. 
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1889, 10 décembre A sa demande, Ira Oscar Knapp achète la parcelle de terrain 
originellement acquise pour la construction de l’édifice original.484  

Baxter E. Perry transfère la parcelle à Knapp.485 

1889, 18 décembre Par un acte de fiducie au nom d’Oscar Knapp, le terrain pour une église 
est transféré à trois fidéicommissaires : Alfred Lang, Marcellus Munroe et 
William G. Nixon. Ce même acte établit un Conseil de directeurs chargé 
de veiller à la tenue de services d’église réguliers et d’engager un pasteur 
dont les sermons seront strictement conformes à la Science Chrétienne. 
Les directeurs désignés sont David Anthony, Joseph S. Eastaman,  
Eugene H. Greene, William B. Johnson et Knapp.486 

1890  Durant l’année, elle se rend brièvement à Boston487 et à Tilton, dans le 
New Hampshire.488 

1890 janvier Lancement d’une publication mensuelle, Christian Science Bible Lessons 
[Leçons bibliques de la Science Chrétienne].489 Au bout de trois numéros, 
cette publication paraît en avril sous une forme trimestrielle et porte en 
couverture le nom de Livret trimestriel de la Science Chrétienne (publié à 
l’origine en anglais avec le titre Christian Science Quarterly).490 Le 
Journal de décembre 1889 annonce que les Leçons bibliques qui vont 
paraître en janvier sont préparées par quelques scientistes chrétiens 
fervents, et qu’ils incluront des choses nouvelles.491 Les leçons de 
décembre avaient été préparées par Frank E. Mason, dont les Leçons 
bibliques paraissaient dans le Journal depuis août 1888 (mais de façon 
discontinue).492 

1890 mai Le dispensaire de la Science Chrétienne logé au 7 Temple Street s’installe 
au 24 Boylston Street,493 à la même adresse que la Société d’édition et la 
salle de lecture. La rue sera renumérotée en janvier 1891, l’adresse 

                                                
484 Ira Knapp à Calvin Frye, 14 décembre 1889, IC83a.18.009. 
485 Ibid. 
486 Acte de fiducie, 18 décembre 1889 ; Subject File, The First Church of Christ, Scientist – Edifices – Land. 
487 Laura Sargent, 12 septembre 1939, Souvenirs, Laura Sargent, 15. 
488 Ibid. 
489 « Editor’s Note Book », The Christian Science Journal, décembre 1889, 461. 
490 Livret trimestriel de la Science Chrétienne, publié à l’origine en anglais avec le titre Christian Science Quarterly, 
avril 1890, en couverture. 
491 « Editor’s Note Book », The Christian Science Journal, décembre 1889, 461. 
492 Frank Mason, « Christian Science Bible Lessons » [Leçons bibliques de la Science Chrétienne], The Christian 
Science Journal, novembre 1889, 411-428. 
493 The Christian Science Journal, mais 1890, iv. 
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devenant alors 62 Boylston Street.494 

1890, 27-28 mai L’Association nationale des scientistes chrétiens se réunit et, à la  
demande de Mary Baker Eddy, est dissoute. En fait, elle est mise  
en sommeil jusqu’en 1893.495 

1890, 6 juin La cinquantième édition de Science et Santé est protégée par le droit 
d’auteur.496 

1890 septembre Elle publie dans le Journal « Seven Fixed Rules » [Sept règles fixes], où 
elle déclare qu’on ne doit plus la consulter au sujet des praticiens de la 
Science Chrétienne inscrits dans le Journal, du contenu des périodiques, 
des relations conjugales, du choix des pasteurs, des désaccords entre 
scientistes chrétiens, de l’admission des membres, des questions de 
discipline et du traitement des malades.497 

1890 novembre Le Journal annonce la parution du premier Hymnaire de la Science 
Chrétienne publié par la Société d’édition de la Science Chrétienne sous la 
forme d’une brochure de quatre pages contenant 17 cantiques (par la suite 
ils seront au nombre de 25).498 Le premier hymnaire au format livre ne 
sera publié qu’en 1892.499 

1890 décembre Sarah J. Clark est nommée rédactrice en chef du Journal.500 (Elle restera à 
ce poste jusqu’en décembre 1891.)501 

1891, 19 janvier Publication de la cinquantième édition de Science et Santé, avec une 
révision majeure.502 Trois mille exemplaires sont imprimés.503 Introduction 
des notes marginales. Le « procès » est retiré (dans l’édition courante voir 
pages 430-442), mais il sera inclus à nouveau dans la quatre-vingtième 

                                                
494 The Christian Science Journal, février 1891, iv. 
495 Mary Baker Eddy, « To the National Christian Scientist Association », The Christian Science Journal, juillet 
1890, 139-140. 
496 Ainsworth Spofford, formulaire de copyright, 6 juin 1890 ; Subject File, Eddy, Mary Baker – Writings – Science 
and Health – Copyrights. 
497 Mary Baker Eddy, « Open Letters » [Lettres ouvertes], The Christian Science Journal, septembre 1890, 249. 
498 « Publisher’s Department » [Le service de l’éditeur], The Christian Science Journal, novembre 1890, 367-368. 
499 Alice Dayton, « A Word of Thanksgiving for the Christian Science Hymnal » [Un mot de remerciement pour 
l’Hymnaire de la Science Chrétienne], The Christian Science Journal, décembre 1892, 406-407. 
500 Société d’édition de la Science Chrétienne, compte rendu de réunion, 22 novembre 1890, EOR02, 18. 
501 Société d’édition de la Science Chrétienne, compte rendu de réunion, 31 octobre 1891, EOR02, 37. 
502 Mary Baker Eddy à Ruth Ewing, 18 janvier 1891, L08500. 
503 Ibid. 
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édition, en 1894.504 La cinquantième édition est commentée dans le 
Journal de mars et réimprimée en avril.505 

1891, 1er mars L’idée de créer un fonds des enfants pour l’aménagement d’une 
« Chambre de Mère » dans l’édifice original (idée proposée par Maurine 
R. Campbell le 3 octobre 1890)506 est exposée aux douze enfants de 
l’école du dimanche à Boston.507 Le fonds des enfants est appelé « les 
Abeilles diligentes »508 Dans le Journal d’avril, tous les enfants sont 
invités à se joindre aux Abeilles diligentes.509 Lorsque la chambre est 
terminée, les enfants offrent régulièrement quelques centimes pour 
alimenter un fonds permettant de fleurir la chambre et d’y garder une 
lampe allumée.510 Leur contribution cesse à la demande de Mary Baker 
Eddy le 30 août 1895.511 Elle dédie Pulpit and Press [La chaire et la 
presse] à ces enfants.512 

1891, 15 avril Publication du dernier numéro du Christian Science Series. 

1891, 23 mai Elle quitte Concord pour emménager au 175 Poplar Street, à Roslindale, 
un quartier de Boston,513 mais elle n’y reste qu’un mois à cause du 
bruit.514 

1891 fin juin Elle retourne au 62 North State Street, Concord.515 

1891 octobre Elle demande que l’« Ordre des services de l’Eglise » soit réimprimé dans 

                                                
504 Mary Baker Eddy, Science et Santé avec la Clef des Ecritures, 81e éd. (Boston: E. J. Foster Eddy, M. D., C. S. D., 
1894), 428-439. 
505 Rev. P. Norcross, « Science and Health by Mary Baker G. Eddy » [Science et Santé de Mary Baker Eddy], The 
Christian Science Journal, avril 1891, 1-7. 
506 Maurine Campbell, « The Story of the Busy Bees » [L’histoire des Abeilles diligentes], 1918, Souvenirs, Maurine 
R. Campbell, 23. 
507 Ibid., 24. 
508 Maurine Campbell à Mary Baker Eddy, 7 avril 1891, IC51.16.003. 
509 Maurine Campbell, « Home and Children’s Department » [Service de l’enfance et du foyer], The Christian 
Science Journal, avril 1891, 21-22. 
510 Maurine Campbell, « To the Busy Bees » [Aux Abeilles diligentes], The Christian Science Journal, mars 1895, 
522. 
511 Mary Baker Eddy à Maurine Campbell, 30 août 1895, V03073. 
512 Mary Baker Eddy, Pulpit and Press [La chaire et la presse], 1ère éd. (Concord, New Hampshire, Mary Baker Eddy, 
1895), 2. 
513 Mary Baker Eddy à George H. et Nellie J. Moore, 22 mai 1891, L13114. 
514 Mary Baker Eddy à Laura Sargent, 8 juillet 1891, L05962. 
515 Lewis Strang à Hermann Hering, 20 août 1906, L12352. 
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le Journal d’octobre.516 

1891 novembre Publication de Rétrospection et Introspection517 Il s’agit d’une révision 
très étoffée de Historical Sketch of Metaphysical Healing [Aperçu 
historique de la guérison métaphysique] (voir sous « février 1885 »). 

1892 janvier Julia Field-King est nommée rédactrice du Journal et reste neuf mois à ce 
poste.518 

1892, 30 mars On lui donne le statut de membre des Filles de la Révolution 
américaine.519 

1892, 29 mai Elle donne sa première allocution à Concord, dans le New Hampshire, 
dans les locaux de son élève Ann Otis, dans le Fowler Building.520 

1892, 20 juin Elle emménage au 188 Pleasant Street, aux abords de Concord.521 

« Pleasant View », ainsi qu’elle appelle cette ancienne ferme, a été achetée 
au mois de décembre précédent.522 Elle y vivra quinze ans et demi, 
jusqu’en janvier 1908.523 

1892 août Les conditions définies par l’acte fiduciaire relatif à l’achat du terrain de 
l’édifice original ne sont pas respectées par les administrateurs lors de leur 
collecte de fonds pour la construction d’un complexe englobant l’église  
et la société d’édition.524 L’acte stipule que seule une église doit être 
construite sur le terrain.525 La propriété du terrain revient donc à  
Ira Oscar Knapp.526 

                                                
516 Mary Baker Eddy, « Order of Church Service » [Ordre des services de l’Eglise], The Christian Science Journal, 
octobre 1891, 284. 
517 The Christian Science Journal, décembre 1891, 394. 
518 Société d’édition de la Science Chrétienne, 7 novembre 1891, EOR02, 39 ; Société d’édition de la Science 
Chrétienne, 27 août 1892, EOR02, 51. 
519 Mary L. Shields à Mary B. G. Eddy, 30 mars 1892 ; Subject File, Mary Baker Eddy – Ancestry – General. 
520 Laura E. H. Plumer, 11 octobre 1932, Souvenirs, Laura E. H. Plumer, 4. 
521 Calvin Frye, carnet, 20 juin 1892, EF067. 
522 Etat du New Hampshire, acte de garantie, 3 décembre 1891 ; Subject File, Eddy, Mary Baker – Residences – 
Pleasant View, New Hampshire – Legal Documents. 
523 « Mrs. Eddy Moves to Greater Boston » [Mary Baker Eddy emménage dans le Grand Boston], Christian Science 
Sentinel, 1er février 1908, 423-427. 
524 Alfred Lang, Marcellus Monroe, W. G. Nixon, circulaire, 25 mai 1891 ; Subject File, The First Church of Christ, 
Scientist – Edifices – Original – Building Fund – Circular and Flyers, 1887, 1891, 1892. 
525 Acte de fiducie, 18 décembre 1889 ; Subject File, The First Church of Christ, Scientist – Edifices – Land. 
526 Acte de fiducie, 19 août 1982 ; Subject File, The First Church of Christ, Scientist – Edifices – Land. 
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1892, 19 août Ira Knapp cède à Mary Baker Eddy le terrain pour l’édifice original.527 

1892, 1er septembre Par un acte de fiducie, elle attribue le terrain au Conseil des directeurs de 
la Science Chrétienne.528 Le Conseil, créé par l’acte, constitue « une 
instance ou une corporation perpétuelle », ayant pour objet la construction 
d’un édifice d’église sur le terrain. Comme le commissaire d’Etat a refusé 
d’accorder une charte à l’Eglise, ce sont des statuts d’Etat autorisant les 
fiduciaires d’une association religieuse non constituée à recevoir et à 
conserver des biens comme s’il s’agissait d’un corps constitué, qui lui 
fournissent une base juridique pour mener à bien son projet.529 Ira Oscar 
Knapp, William B. Johnson, Joseph S. Eastaman et Stephen A. Chase 
constituent le Conseil des directeurs.530 

1892, 23 septembre L’Eglise du Christ (Scientiste) est réorganisée avec douze membres sous 
le nom de L’Eglise Mère, La Première Eglise du Christ, Scientiste, à 
Boston, Massachusetts.531 Alors que l’organisation précédente était 
démocratique, le gouvernement de l’église est à présent réparti entre  
Mary Baker Eddy, le Conseil des directeurs et les Premiers Membres.532  

Le 10 janvier 1901, les Premiers Membres renoncent au rôle qu’ils avaient 
jusque-là dans le gouvernement de l’Eglise ;533 le 17 mars 1903, ils sont 
désignés sous le nouveau nom de « Membres exécutifs » ;534 le 8 juillet 
1908, le groupe est dissous.535 

1892 octobre Emma E. Cooley est rédactrice en chef par intérim du Journal pendant  
un mois.536 

1892 octobre ou novembre La Société d’édition de la Science Chrétienne publie le premier  
Hymnaire de la Science Chrétienne officiel avec paroles et musique 
(publié à l’origine en anglais avec le titre Christian Science Hymnal).537  

                                                
527 Mary Baker Eddy à Ira O. Knapp, 25 août 1892, L03429. 
528 Mary Baker Eddy, Manuel de L’Eglise Mère, publié à l’origine en anglais avec le titre Manual of The Mother 
Church, 89e éd. (Boston: The First Church of Christ, Scientist, 1908), 128. 
529 Ibid., 130. 
530 Ibid., 128-130. 
531 Ebenezer J. Foster Eddy à William B. Johnson, 25 septembre 1892, F00689. 
532 Clifford P. Smith, « Our Church’s Constitution » [La constitution de notre Eglise], n.d. ; Subject File, The First 
Church of Christ, Scientist – Organization – General. 
533 Mary Baker Eddy, Manuel de l’Eglise, 20e éd., 30. 
534 Mary Baker Eddy, Manuel de l’Eglise, 29e éd., 66. 
535 Mary Baker Eddy au Conseil des directeurs de la Science Chrétienne, 3 juillet 1908, L00985. 
536 Société d’édition de la Science Chrétienne, compte rendu de réunion, 27 août 1892, EOR02, 56. 
537 Alice Dayton, « A Word of Thanksgiving for the Christian Science Hymnal », The Christian Science Journal, 
décembre 1892, 406-407. 
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Cet hymnaire contient 221 arrangements pour cantiques.538 

1892 novembre Septimus J. Hanna est nommé rédacteur en chef du Journal.539 Il restera à 
ce poste jusqu’en juin 1902.540 

1893 janvier Ebenezer J. Foster est nommé éditeur de Science et Santé et des autres 
écrits de Mary Baker Eddy ; Joseph Armstrong est nommé éditeur du 
Journal et directeur de la société d’édition de la Science Chrétienne,  
en remplacement de William G. Nixon.541 

1893 février Le nom « Mary Baker Eddy » apparaît sur le certificat des Filles de la 
Révolution américaine.542 Un an plus tard, elle commence à retirer 
l’initiale « G » (pour Glover) dans sa correspondance.543 

 Lanson P. Norcross démissionne de sa fonction de pasteur de L’Eglise 
Mère.544 

1893 mars Elle confie à James F. Gilman l’illustration de Christ and Christmas  
[Le Christ et Noël] peu de temps après avoir écrit ce poème.545  
Joseph Armstrong remplace Joseph S. Eastman en tant que directeur.546 

1893, 1er mars David A. Easton devient Pasteur de L’Eglise Mère.547 Il meurt le  
1er mars 1894.548 

1893, 27 avril George Washington Glover Jr. et son fils de quatre ans, George, lui 
rendent visite à Pleasant View.549 

1893, 11 septembre Réunion du premier Parlement des religions dans le cadre de l’Exposition 

                                                
538 Hymnaire de la Science Chrétienne, publié à l’origine en anglais avec le titre Christian Science Hymnal (Boston: 
The Christian Science Publishing Society, 1892). 
539 Société d’édition de la Science Chrétienne, compte rendu de réunion, 24 septembre 1892, EOR02, 60. 
540 « Editorial Department » [Service de la rédaction], Christian Science Sentinel, 26 juin 1902, 688. 
541 « Publisher’s Department », The Christian Science Journal, janvier 1893, 479. 
542 La Bibliothèque Mary Baker Eddy, 16 février 1893, Collection d’objets, 0.1967. 
543 Mary Baker Eddy, Ecrits divers, x. 
544 Mary Baker Eddy à Lanson Norcross, 4 mars 1893, L11126. 
545 James Franklin Gilman à Mary Baker Eddy, 29 mars 1893, IC353.48.026. 
546 Mary Baker Eddy à Joseph Armstrong, 24 mars 1893, L02690. 
547 David A. Easton à Mary Baker Eddy, 1er mars 1893, IC275.41.035. 
548 « Editor’s Table » [De la part de la rédaction], The Christian Science Journal, avril 1894, 35-39. 
549 Calvin Frye, carnet, 4 avril 1893, EF067 ; Irving C. Tomlinson, « The Woman and the Revelator » [La femme et 
le Révélateur], 12 mai 1932, Souvenirs, Irving C. Tomlinson, 656. 

mailto:recherche@mbelibrary.org
https://www.marybakereddylibrary.org/fr/


 
 

210 Massachusetts Avenue, Boston, MA 02115, Etats-Unis ∙ +1 617 450 7218 
recherche@mbelibrary.org ∙ marybakereddylibrary.org/fr/ 

© 2002, 2017, traduction française © 2021 The Mary Baker Eddy Library 
 

49 

universelle à Chicago.550 Edward A. Kimball supervise la participation des 
scientistes chrétiens à cet événement.551 

1893, 20 septembre A l’occasion de la réunion du Parlement des religions, un Congrès de la 
Science Chrétienne est organisé sous les auspices de la NCSA, qui a 
suspendu ses activités trois ans auparavant.552 Mary Baker Eddy demande 
à certains élèves de prononcer douze discours sur des sujets choisis par 
elle.553 A sa demande, la NCSA la désigne, par un vote, propriétaire du 
Journal.554 Elle charge alors la NCSA d’en assurer la publication.555 

1893, 22 septembre Septimus J. Hanna lit son discours devant le Parlement des religions.556 

1893, 29 septembre Elle conseille aux directeurs de commencer la construction de l’église à 
Boston.557 Les travaux débutent le 1er octobre.558 

1893, 3 octobre La première Assemblée annuelle de l’Eglise réorganisée se tient au 
Chickering Hall, à Boston.559 Avant la construction de l’extension de 
l’église, qui s’achèvera en 1906, les Assemblées annuelles auront lieu au 
Copley Hall,560 dans l’édifice original de L’Eglise Mère,561 à Tremont 
Temple,562 au Mechanics Building563 et au Symphony Hall.564 

1893 décembre Publication de Christ and Christmas.565 

1894, 10 janvier Elle suspend la vente de Christ and Christmas.566  

                                                
550 « Dawn of Love » [L’aube de l’Amour »], Boston Daily Globe, 12 septembre 1893. 
551 Edward Kimball à Septimus J. Hanna, 16 juin 1893, IC155aP1.24.026. 
552 « Christian Science at the World’s Religious Congress » [La Science Chrétienne au Congrès des religions du 
monde], The Christian Science Journal, novembre 1893, 337-346. 
553 Ibid. 
554 Ibid. 
555 Ibid. 
556 « Religions of the World » [Religions du monde], The Boston Daily Globe, 23 septembre 1893. 
557 Mary Baker Eddy au Conseil des directeurs de la Science Chrétienne, 29 septembre 1893, L00053. 
558 Ibid. 
559 William B. Johnson, « Annual Church Meeting » [Assemblée annuelle de l’Eglise], The Christian Science 
Journal, novembre 1893, 371-373. 
560 William B. Johnson, « Annual Church Meeting », The Christian Science Journal, novembre 1894, 311-314. 
561 « Annual Church Meeting », The Christian Science Journal, novembre 1895, 312-315. 
562 « The Annual Church Meeting », The Christian Science Journal, juillet 1899, 238-247. 
563 « Annual Church Meeting », Christian Science Sentinel, 7 juin 1900, 643-645. 
564 « The Annual Church Meeting », Christian Science Sentinel, 18 juin 1904, 660-662. 
565 The Christian Science Journal, décembre 1893, 398. 
566 Mary Baker Eddy, « Hear, O Israel » [Ecoute, O Israël], The Christian Science Journal, février 1894, 471. 
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 Le livre sera réédité en décembre 1897.567 

1894, 1er mars Les services d’église se tiennent au Copley Hall, dans Clarendon Street, 
jusqu’au 30 décembre 1894, date à laquelle l’édifice original est 
diponible.568 Décès de David A. Easton.569 

1894, après le 1er mars Septimus J. Hanna est nommé Pasteur de L’Eglise Mère.570 En janvier 
1895, il devient Premier Lecteur, le premier à occuper ce poste.571 

1894 avril-mai Publication de la quatre-vingt-unième édition de Science et Santé – 
révision dans laquelle elle réintroduit le « procès » dans le chapitre 
« Pratique de la Science Chrétienne », après une omission de quelque  
trois années. C’est aussi la première édition dans laquelle figurent les 
« Articles de foi ».572 

1894, 21 mai Pose de la pierre angulaire de l’édifice original de L’Eglise Mère à 7h du 
matin. Elle contient la Bible, la quatre-vingt-unième édition de Science et 
Santé et d’autres livres de Mary Baker Eddy.573 

1894, 10 juillet Elle demande la fermeture du dispensaire du 62 Boylston Street,  
à Boston.574 

1894, 24 juillet Elle demande la fermeture de la salle de lecture du 62 Boylston Street.575 

1894, 30 juillet A sa demande, l’Association scientiste chrétienne vote la fermeture du 
dispensaire et de la salle de lecture du 62 Boylston Street.576 

1894, 2 octobre L’Assemblée annuelle de L’Eglise Mère se tient au Copley Hall.577 

1894, 7 octobre Le service de Communion de L’Eglise Mère a lieu au Copley Hall.578 

                                                
567 « Christ and Christmas » [Le Christ et Noël], The Christian Science Journal, décembre 1897, 539. 
568 Mary Baker Eddy, Miscellanées, 55. 
569 « Editor’s Table », The Christian Science Journal, avril 1894, 35-39. 
570 S. J. Hanna, 15 mars 1894, 033a.13.049. 
571 Mary Baker Eddy au Conseil des directeurs de la Science Chrétienne, 9 janvier 1895, L02702. 
572 « Editor’s Table », The Christian Science Journal, juin 1894, 128-129. 
573 Joseph Armstrong à Mary Baker Eddy, 21 mai 1894, IC003aP1.03.025. 
574 Mary Baker Eddy au directeur de l’Association du dispensaire de la Science Chrétienne, 10 juillet 1894, L00062. 
575 Calvin Frye à Mary M. W. Munroe, 24 juillet 1894, L01120. 
576 Association scientiste chrétienne, compte rendu de réunion, 30 juillet 1894 ; Subject File, Christian Scientist 
Association – Meetings –1891-1896. 
577 William B. Johnson, « Annual Church Meeting », The Christian Science Journal, novembre 1894, 311-314. 
578 « Communion Service » [Service de Communion], The Christian Science Journal, novembre 1894, 315-319. 
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1894, 19 décembre Elle ordonne la Bible et Science et Santé avec la Clef des Ecritures en tant 
que Pasteur de L’Eglise Mère.579 

1894, 30 décembre Premier service dans l’édifice original ; c’est un service de 
Communion.580 Présentation du nouveau Pasteur.581 Le Premier Lecteur, 
Septimus J. Hanna, conduit seul le service du 30 décembre.582 

1895, 6 janvier Dédicace de l’édifice original de L’Eglise Mère (dont la construction a 
coûté plus de 250 000 $). Ebenezer J. Foster Eddy et Septimus J. Hanna 
lisent respectivement et alternativement des passages de la Bible et de 
Science et Santé. Son sermon pour la dédicace est lu par Henrietta Clark 
Bemis, une oratrice professionnelle qui n’est pas membre de l’Eglise.  
Cinq services ont lieu, dont un exclusivement pour les enfants.583 

1895, 20 janvier La lecture de passages de la Bible et de Science et Santé remplace le 
sermon personnel, et les lecteurs (Septimus J. Hanna, en tant que Premier 
Lecteur,584 et Eldora O. Gragg, en tant que Deuxième Lectrice)585 
remplacent les prédicateurs lors des services de L’Eglise Mère.586  

Mary Baker Eddy a ordonné ces deux livres Pasteur le 19 décembre 
précédent.587 Jusqu’au 16 mars 1899, le Premier Lecteur lira la Bible et  
le Deuxième Lecteur Science et Santé.588 En avril 1895, les églises filiales 
adoptent cette forme de service.589 On adapte les Leçons bibliques 
internationales aux sermons de la Science Chrétienne. 

1895 mars La Société d’édition emménage au 95 Falmouth Street.590 

1895, 25 mars Elle refuse d’être Pasteur de La Première Eglise du Christ, Scientiste, à 
Boston, comme le lui propose le Conseil des directeurs,591 et elle suggère 

                                                
579 Mary Baker Eddy au Conseil des directeurs de la Science Chrétienne, 19 décembre 1894, L00653. 
580 « First Services in the New Church » [Premiers services dans la nouvelle Eglise], The Christian Science Journal, 
février 1895, 464. 
581 Ibid. 
582 Ibid. 
583 « The Dedication of The Mother Church » [La dédicace de L’Eglise Mère], The Christian Science Journal, février 
1895, 451-460. 
584 Mary Baker Eddy au Conseil des directeurs de la Science Chrétienne, 9 janvier 1895, L02702. 
585 William B. Johnson à Eldora Gragg, 15 janvier 1895 ; Subject File, Gragg, Eldora O. W. 
586 « Editor’s Table », The Christian Science Journal, février 1895, 489-491. 
587 Mary Baker Eddy au Conseil des directeurs de la Science Chrétienne, 19 décembre 1894, L00653. 
588 « Notices » [Avis], Christian Science Sentinel, 16 mars 1899, 15. 
589 Mary Baker Eddy, « Church and School » [L’Eglise et l’école], The Christian Science Journal, avril 1895, 1-3. 
590 The Christian Science Journal, mars 1895, en couverture. 
591 Mary Baker Eddy au Conseil des directeurs de la Science Chrétienne, 25 mars 1895, L00095. 
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aux directeurs de la nommer « Pasteur Emérite ».592 Elle reçoit ce titre  
le 23 avril.593 

1895 en avril Dans le Journal d’avril, elle fait savoir qu’elle ordonne la Bible et  
Science et Santé en tant que Pasteur de toutes les églises filiales.  
Les lecteurs remplacent désormais les prédicateurs.594 

1895, 1er avril Elle se rend en privé dans l’édifice original pour la première fois et  
passe la nuit dans la « Chambre de Mère ».595 

1895, 15 avril Des travaux sont entrepris à Pleasant View (ils seront achevés  
le 14 mai).596 Dans l’intervalle, elle loge avec Calvin A. Frye et  
Clara S. Shannon dans le cottage du gardien.597 

1895, 20 avril Josephine Curtis Woodbury, élève indocile de Mary Baker Eddy, qui lui 
intentera plus tard un procès,598 est de nouveau admise au sein de l’Eglise 
pendant une période d’épreuve.599 Elle sera exclue le 6 novembre 1895,600 

puis à nouveau réintégrée le 24 mars 1896, en tant que membre mis à 
l’épreuve.601 Elle sera excommuniée le 4 avril 1896.602 

1895 avril (3e semaine)  Publication de Pulpit and Press.603 

1895, 23 avril Le Conseil des directeurs vote pour lui donner le titre de « Pasteur 
Emérite ».604 

1895, 25-26 mai (dimanche) Elle se rend pour la deuxième fois à L’Eglise Mère.605 Elle prononce le 
premier des deux discours qu’elle fera dans l’édifice original.606  

                                                
592 Le Conseil des directeurs de la Science Chrétienne à Mary Baker Eddy, 20 avril 1895, IC 002a.02.006. 
593 Mary Baker Eddy au Conseil des directeurs de la Science Chrétienne, 23 avril 1895, L00101. 
594 Mary Baker Eddy, « Church and School », The Christian Science Journal, avril 1895, 1-3. 
595 « The Mother’s Visit » [La visite de Mère], The Christian Science Journal, mai 1895, 45-46. 
596 Calvin Frye, carnet, 15 avril 1895, EF067. 
597 Ibid. 
598 S. J. Hanna à Mary Baker Eddy, 31 juillet 1899, IC33c.13.023. 
599 Mary Baker Eddy à La Première Eglise du Christ, Scientiste, 17 avril 1895, L00100. 
600 « Notice », The Christian Science Journal, juin 1896, 122. 
601 William B. Johnson à Mary Baker Eddy, 24 mars 1896, IC001cP2.01.009. 
602 « Notice », The Christian Science Journal, juin 1896, 122. 
603 Mary Baker Eddy à Laura Sargent, 15 avril 1895, L05976. 
604 Mary Baker Eddy au Conseil des directeurs de la Science Chrétienne, 23 avril 1895, L00101. 
605 « The Mother’s First Appearance in the New Church » [La première visite de Mère dans la nouvelle Eglise], The 
Christian Science Journal, juillet 1895, 139-140. 
606 Mary Baker Eddy, Ecrits divers, 106. 
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Elle passe la nuit du samedi (25 mai) dans la « Chambre de Mère ».607 

1895, 6 juin Elle s’adresse à 180 membres de son Association scientiste chrétienne 
venus la voir à Pleasant View.608 

1895 milieu de l’été Etablissement du Conseil des missionnaires. La disposition statutaire 
relative au « Conseil des missionnaires » figure dans la 1ère édition du 
Manuel de l’Eglise.609 Cette disposition disparaît de la deuxième à la 
cinquième édition, mais elle est réintégrée dans la sixième.610 En février 
1906 (cinquante-quatrième édition), la fonction des missionnaires 
change.611 La disposition sera supprimée le 31 mai 1909.612 Elle sera 
retirée de la quatre-vingt-unième édition du Manuel de l’Eglise. 

1895, 10 septembre Publication de la première édition du Manuel de L’Eglise Mère.613 

1895, 1er octobre L’Assemblée annuelle de L’Eglise Mère est la première réunion  
tenue dans l’édifice de l’église.614 

1895, 6 octobre L’école du dimanche accueille maintenant les enfants uniquement.615 

1895, 20 octobre Ezra M. Buswell commence à tenir des services du dimanche à 
Concord.616 

1895, 6 novembre Josephine Curtis Woodbury se voit retirer son statut de membre de 
l’Eglise.617 

1896 janvier Les premiers services publics et réguliers de la Science Chrétienne  

                                                
607 Clara M. S. Shannon, « De précieux souvenirs », Nous avons connu Mary Baker Eddy, édition augmentée, tome II, 
214. 
608 « Meeting of the College Association » [Réunion de l’Association du College], The Christian Science Journal, 
juillet 1895, 141-143. 
609 Mary Baker Eddy, Manuel de l’Eglise, 1ère éd., 23. 
610 Mary Baker Eddy, Manuel de l’Eglise, 6e éd., 19-20. 
611 Mary Baker Eddy, Manuel de l’Eglise, 54e éd., 93. 
612 Le Conseil des directeurs de la Science Chrétienne à Mary Baker Eddy, 31 mai 1909, IC L00606. 
613 The Christian Science Journal, septembre 1895, 231. 
614 « Annual Church Meeting », The Christian Science Journal, novembre 1895, 312-315. 
615 Mary Baker Eddy, « What We Can Do For The Children » [Ce que nous pouvons faire pour les enfants], The 
Christian Science Journal, octobre 1895, 268. 
616 Ezra Buswell à Mary Baker Eddy, 24 octobre 1895, IC047.15.016. 
617 « Notice », The Christian Science Journal, juin 1896, 122. 
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ont lieu à Londres.618 L’année suivante, une ancienne synagogue est 
achetée et réaménagée. Les services d’église y auront lieu à partir du  
7 novembre 1897.619 

1896, 5 janvier Mary Baker Eddy prononce son deuxième discours dans l’édifice original, 
lors du service de communion (et du premier anniversaire de la dédicace 
de l’église).620 C’est sa troisième et dernière visite à L’Eglise Mère. 

1896, 29 janvier Elle écrit à Julia Field-King pour lui demander d’aller à Londres, en 
Angleterre, afin d’y établir la Science Chrétienne par la guérison et 
l’enseignement, avant de créer une église.621 Julia Field-King part  
pour l’Angleterre en mars.622 

1896, 24 mars Josephine Curtis Woodbury est réintégrée en tant que membre mise à 
l’épreuve.623 

1896, 4 avril Josephine Curtis Woodbury est excommuniée pour toujours de l’Eglise.624 

1896, 19 avril Deux services du dimanche ont lieu dans l’édifice original à 10h30 et 
15h.625 Le deuxième service du dimanche est annoncé pour la première 
fois dans le répertoire du Journal de juin 1896.626 Trois services du 
dimanche auront lieu à partir du dimanche 1er octobre 1905.627 

1896 mai Elle publie l’« Ordre des services » pour les services de Communion et  
du dimanche, ainsi que l’ordre des réunions du vendredi soir.628 

1896 août Elle envoie Ebenezer J. Foster Eddy à Philadelphie,629 et nomme Joseph 
Armstrong en tant qu’éditeur de ses écrits.630 

                                                
618 « Dedication of a Church in London, England » [Dédicace d’une église à Londres, en Angleterre], The Christian 
Science Journal, janvier 1898, 593-598. 
619 Ibid. 
620 Mary Baker Eddy, Ecrits divers, 120–125. 
621 Mary Baker Eddy à Julia Field-King, 29 janvier 1896, F00115. 
622 Julia Field-King à Mary Baker Eddy, 5 avril 1896, IC214b.35.035. 
623 William B. Johnson à Mary Baker Eddy, 24 mars 1896, IC001c.P2.01.009. 
624 « Notice », The Christian Science Journal, juin 1896, 122. 
625 William B. Johnson à Mary Baker Eddy, 13 avril 1896, IC001c.P2.01.012. 
626 The Christian Science Journal, juin 1896, iii. 
627 « Services in The Mother Church » [Services dans L’Eglise Mère], Christian Science Sentinel, 7 octobre 1905, 89. 
628 Mary Baker Eddy, « Take Notice » [Avis], The Christian Science Journal, mai 1896, 51-52. 
629 Dr. E. J. Foster Eddy, « From Dr. Eddy » [De la part du Dr Eddy], The Christian Science Journal, octobre 1896, 
341. 
630 « Notice », The Christian Science Journal, octobre 1896, 326. 
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1896, 14 août Daniel Patterson meurt à Saco, dans le Maine, sans qu’elle en soit 
informée.631 

1896, 4 octobre L’Eglise Mère tient un service de Communion.632 

1896, 6 octobre Assemblée annuelle de L’Eglise Mère.633 

1896, 7 décembre Installation d’un téléphone interne à Pleasant View et dans les écuries.634 

1897, 2 janvier Adoption d’une résolution par laquelle l’Assemblée annuelle devient une 
assemblée bisannuelle. Il n’y a donc pas d’assemblée en 1897.635 

1897, 10 février Parution d’Ecrits divers 1883-1896, publié à l’origine en anglais avec le 
titre Miscellaneous Writings 1883–1896.636 Il s’agit d’une compilation de  
ses écrits pour le Journal de 1883 à 1896, mais elle y inclut également 
quelques nouveaux articles. (Son allocution de juillet 1897, que l’on 
trouve aux pages 251-253, viendra remplacer plus tard trois articles.)637 

1897 mars A la suite de la publication d’Ecrits divers, elle demande que les 
professeurs de Science Chrétienne aux Etats-Unis et au Canada cessent 
d’enseigner pendant un an. « La Bible, Science et Santé avec la Clef des 
Ecritures et mes autres écrits publiés sont les seuls instructeurs appropriés 
à l’heure actuelle », déclare-t-elle.638 

1897, 3 avril La Société d’édition de la Science Chrétienne devient une entité juridique 
en se dotant d’une charte reçue de l’Etat,639 à la demande de Mary Baker 
Eddy.640 

1897, 4 juillet Un service de Communion a lieu dans L’Eglise Mère, mais il n’y a pas 
d’Assemblée annuelle cette année-là.641 

                                                
631 Etat du Maine, acte de décès, n.d., Subject File, Patterson, Daniel – Papers – Decease. 
632 « Editor’s Table », The Christian Science Journal, novembre 1896, 415-416. 
633 « The Annual Church Meeting », The Christian Science Journal, novembre 1896, 365-373. 
634 Calvin Frye, carnet, 7 décembre 1896, EF071. 
635 Mary Baker Eddy, 2 janvier 1987, L00699D. 
636 Edwards Bates, « Opinions of the New Book » [Opinions concernant le nouveau livre], The Christian Science 
Journal, mars 1897, 585-586. 
637 Mary Baker Eddy, Ecrits divers, 28e éd. 
638 Mary Baker Eddy, « Notice », The Christian Science Journal, mars 1897, 575. 
639 Edward P. Bates à Mary Baker Eddy, 3 avril 1897, IC19c.009.055. 
640 Mary Baker Eddy à William P. McKenzie, 22 février 1897, L04856. 
641 « Our Fourth of July » [Notre 4 juillet], The Christian Science Journal, août 1897, 261-265. 
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1897, 5 juillet Elle fait un discours devant 2500 membres de L’Eglise Mère rassemblés  
à Pleasant View. C’est la première visite de ce genre faite à son 
invitation.642 

1897, 21 juillet Elle rompt définitivement tout lien avec Ebenezer J. Foster Eddy.643 

1897 novembre ou Elle réimprime Christ and Christmas dans une version révisée.644 
     décembre 

1897, 5 décembre Christian Science Hall, à Concord, voit se tenir le premier service.645 

1898 janvier Etablissement du Conseil des conférences de la Science Chrétienne. Il est 
composé de cinq membres : Irving C. Tomlinson de Concord, Edward A. 
Kimball de Chicago, George Tomkins de New York, William P. 
McKenzie de Boston et Carol Norton de New York. Kimball est nommé 
président du Conseil des conférences et Tomlinson secrétaire.646 

1898, 2 janvier Service de Communion à L’Eglise Mère.647 

1898, 21 janvier A sa demande, la Société d’édition de la Science Chrétienne lui vend tous 
ses biens, et elle est dissoute.648 

1898, 25 janvier Création de la Société d’édition de la Science Chrétienne sous sa forme 
actuelle par un acte de Fiducie avec trois administrateurs.649 Elle fait don 
de tous les biens de la Société d’édition de la Science Chrétienne à 
L’Eglise Mère. Edward P. Bates, James A. Neal et William P. McKenzie 
constituent le Conseil d’administration.650 

1898, 14 février Irving C. Tomlinson donne la première conférence de la Science 
Chrétienne à Lynn, dans le Massachusetts.651 

                                                
642 Ibid. 
643 Mary Baker Eddy à Ebenezer J. Foster Eddy, 21 juillet 1897, L02006. 
644 « Christ and Christmas », The Christian Science Journal, décembre 1897, 539. 
645 « The New Hall at Concord » [Le nouveau Hall de Concord], The Christian Science Journal, janvier 1898. 
646 « Church Rule » [Une disposition statutaire de l’Eglise], février 1898, 666. 
647 « Mrs. Eddy’s Letter to The Church » [Lettre de Mary Baker Eddy à l’Eglise], The Christian Science Journal, 
février 1898, 664-666. 
648 Acte de vente, 21 janvier 1898 ; Subject file, The Christian Science Publishing Society – Deeds. 
649 Mary Baker Eddy, Manuel de l’Eglise, 89e éd., 79. 
650 « A Gift to The Mother Church, and a Grant of Trusteeship » [Un don à L’Eglise Mère et l’octroi d’une fiducie], 
The Christian Science Journal, février 1898, 661-663. 
651 Mary Baker Eddy à Irving Tomlinson, 14 février 1898, L03639. 
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1898, 24 février Mary Baker Eddy rédige la disposition statutaire établissant le Conseil 
d’Instruction.652 Cette disposition statutaire figure à la page 6 du  
Christian Science Weekly du 29 septembre 1898. Un avis publié dans le 
Journal de juillet mentionne pour la première fois la « création récente » 
du Conseil, qui n’est pas encore « organisé officiellement ».653 

 Le premier Cours Normal organisé sous les auspices du Conseil 
d’Instruction a lieu en janvier 1899, avec Edward. A. Kimball pour 
professeur.654 (Mary Baker Eddy a enseigné le premier Cours Normal en 
août 1884.)655 Septimus J. Hanna est le président du Conseil d’Instruction, 
Kimball le secrétaire, Laura Lathrop la trésorière, Alfred E. Baker y 
enseigne l’obstétrique.656 Le Conseil d’Instruction organise également 
cinq Cours Primaires entre octobre 1903 et décembre 1905.657  

1898, 27 février Elle prononce un sermon au Christian Science Hall, à Concord. Elle se 
base sur le psaume 91. Quarante-sept Premiers Membres ont été invités à 
l’écouter.658 

1898 mars Organisation de la première église de la Science Chrétienne en Allemagne, 
à Hanovre.659 

 Reprise de l’enseignement du Cours Primaire.660 

1898, 26 avril Elle demande au Comité des Leçons bibliques d’établir les 26 sujets de 
Leçon biblique qu’elle a définis.661 La liste est imprimée pour la première 
fois dans le Livret trimestriel de la Science Chrétienne de juillet. On les 
utilise lors des services du matin, à la place des Leçons bibliques 
internationales spécialement adaptées, et qui constituent toujours la base 
des services du soir. 

                                                
652 Mary Baker Eddy à William B. Johnson, 24 février 1898, L00714. 
653 Le Conseil d’Instruction, « Notice », The Christian Science Journal, juillet 1898, 255. 
654 Calvin A. Frye à Edward A. Kimball, 17 février 1899, V03686. 
655 Carnet, 8 août 1884 ; Subject File, Eddy, Mary Baker – Students by Classes – Student List Recorded by Calvin 
Frye [Second Copy]. 
656 Livre de classe, 9 janvier 1899 ; Subject File, The First Church of Christ, Scientist – Board of Education – 
Classbook – 1899–1910 Photocopy. 
657 Livre de classe, octobre 1903 ; Subject File, The First Church of Christ, Scientist – Board of Education – 
Classbook – 1899–1910 Photocopy ; ibid., décembre 1903 ; ibid., 7 décembre 1904 ; ibid., mai 1905 ; ibid., décembre 
1905. 
658 « A Memorable Occasion » [Une occasion mémorable], The Christian Science Journal, avril 1898, 3. 
659 « Notes from the Field » [Témoignages du Champ], The Christian Science Journal, avril 1898, 65. 
660 Mary Baker Eddy, « Notice », The Christian Science Journal, mars 1898, 781. 
661 Calvin Frye au Comité des Leçons bibliques, 26 avril 1898, L07294. 
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1898, 11 mai Elle rédige l’« Avis » dans le Journal de juin, annonçant le passage des 
réunions du vendredi soir au mercredi.662 

1898, 5 juin Deux services de Communion ont lieu au cours de cette journée. Son 
message à L’Eglise Mère, « Not Pantheism, but Christian Science »  
[Pas le panthéisme, mais la Science Chrétienne] est lu par le Premier 
Lecteur, Septimus J. Hanna, à la fin du service de Communion.663 (Il est 
publié sous le titre « Science Chrétienne contre panthéisme », en anglais 
Christian Science versus Pantheism, et a déjà fait l’objet d’une annonce 
dans le Sentinel.)664 Il n’y a pas d’Assemblée annuelle cette année-là. 

1898 juillet Elle ajoute Annie M. Knott et Sue Harper Mims au nombre des membres 
du Conseil des conférences.665 

1898, 30 juillet Edward P. Bates démissionne du Conseil d’administration de la Société 
d’édition.666 Sa démission prend effet le 9 septembre, jour de la 
nomination de Thomas W. Hatten à ce poste.667 

1898, 11 août Les statuts sont modifiés afin de rétablir l’Assemblée annuelle, mais  
celle-ci est déplacée d’octobre à juin, si bien qu’aucune assemblée n’est 
possible en 1898.668 (Note : Il n’y a pas eu d’assemblées en 1897, 1898, 
1901.) Les assemblées ont lieu le jeudi à différentes dates du mois de juin, 
jusqu’à une nouvelle modification de la disposition statutaire en juillet 
1908. 

1898, 20 août Elle écrit à William P. McKenzie, l’un des administrateurs de la Société 
d’édition, au sujet de la nécessité de publier un « journal hebdomadaire ». 
Elle en donne le titre : The Christian Science Messenger.669 

1898, 1er septembre Lancement du Christian Science Weekly.670 Quatre mois plus tard il sera 
rebaptisé Christian Science Sentinel (26 janvier 1899).671 

                                                
662 Mary Baker Eddy, « Notice », juin 1898, V00107. 
663 « Communion of Christian Scientists » [Communion de scientistes chrétiens], The Christian Science Journal, 
juillet 1898, 269-271. 
664 « New Pamphlet » [Nouvelle brochure], Christian Science Sentinel, 29 septembre 1898, 7. 
665 « The Board of Lectureship » [Le Conseil des conférences], The Christian Science Journal, juillet 1898, 272. 
666 Edward P. Bates à Mary Baker Eddy, 30 juillet 1898, IC19.09.074. 
667 Mary Baker Eddy à James A. Neal et William P. McKenzie, 8 septembre 1898, L07207. 
668 Mary Baker Eddy, 11 août 1898, L00723. 
669 Mary Baker Eddy à William P. McKenzie, 20 août 1898, L04871B. 
670 « Salutary » [Salutaire], Christian Science Weekly, 1er septembre 1898, 1. 
671 « Our Third Bow » [Une troisième révérence], Christian Science Sentinel, 26 janvier 1899, 4. 
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1898, 9 septembre Nomination de Thomas W. Hatten au Conseil d’administration de la 
Société d’édition.672 

1898, 28 septembre Irving C. Tomlinson donne la première conférence dans l’édifice  
de L’Eglise Mère.673 

1898, 29 septembre Publication de Science Chrétienne contre panthéisme.674 

1898, 21 octobre James A. Neal démissionne du Conseil d’administration de la Société 
d’édition. Joseph B. Clark est nommé en remplacement.675 

1898, 20-21 novembre Elle enseigne son dernier cours – un Cours Normal en deux sessions –  
au Christian Science Hall, à Concord, à 66 scientistes chrétiens et deux 
journalistes (George H. Moses, plus tard Sénateur du New Hampshire,  
et Allan H. Robinson).676 Soixante-dix personnes ont été invitées à suivre 
le cours. Ayant eu un empêchement, William G. Ewing et Ruth B. Ewing 
ne peuvent y assister.677 

1898, 13 décembre Le Conseil des directeurs adopte la disposition statutaire établissant le 
Comité pour la Publication,678 rebaptisé par la suite Committee on 
Publication [Comité de Publication].679 

1898, 2-7 janvier Le Conseil d’Instruction enseigne pour la première fois le Cours Normal à 
une classe. Le professeur est Edward A. Kimball.680 

1899, 26 janvier Le Weekly est rebaptisé le Christian Science Sentinel.681 

1899 fin février Lecture d’une allocution de Mary Baker Eddy au Christian Science Hall, 
après que les membres de Concord ont achevé d’organiser l’église,  

                                                
672 Mary Baker Eddy à James A. Neal et William P. McKenzie, 8 septembre 1898, L07207. 
673 « Editorial », Christian Science Weekly, 6 octobre 1898, 4. 
674 « New pamphlet », Christian Science Weekly, 29 septembre 1898, 7. 
675 Mary Baker Eddy au Conseil d’administration de la Société d’édition de la Science Chrétienne, 21 octobre 1898, 
L07210. 
676 « An Important Event », The Christian Science Journal, décembre 1898, 588-590. 
677 Mary Baker Eddy à William G. et Ruth B. Ewing, 22 novembre 1898, L15649. 
678 Mary Baker Eddy, 13 décembre 1898, L00737. 
679 Mary Baker Eddy au Conseil des directeurs de la Science Chrétienne, 4 septembre 1906, L00929. 
680 Livre de classe, 9 janvier 1899 ; Subject File, The First Church of Christ, Scientist – Board of Education – 
Classbook – 1899–1910 Photocopy. 
681 « Our Third Bow », Christian Science Sentinel, 26 janvier 1899, 4. 
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le 22 février.682 

1899, 16 mars Publication de la dixième édition du Manuel de l’Eglise.683 Les révisions 
de cette édition portent notamment sur la permutation des devoirs des 
lecteurs : le Premier Lecteur doit désormais lire Science et Santé, et le 
Deuxième Lecteur la Bible. 

1899 avril Abandon définitif des Leçons bibliques internationales. La Leçon biblique 
indiquée dans le Livret trimestriel, utilisée le matin, remplace également 
les Leçons internationales lors du deuxième service.684 

1899 mai Le magazine Arena publie des critiques virulentes de la part de Josephine 
Curtis Woodbury et de Julius A. Dresser (un ancien élève de Phineas 
Parkhurst Quimby).685 

 Publication de la brochure Christian Science History [Histoire de la Science 
Chrétienne] de Septimus J. Hanna, en réponse aux accusations de Josephine 
Curtis concernant Mary Baker Eddy et Phineas Parkhurst Quimby.686 

1899 juin Le Journal de juin publie la liste définitive des dispensaires de la Science 
Chrétienne.687 

1899, 4 juin Message de Communion de Mary Baker Eddy à L’Eglise Mère688 lu lors 
des quatre services tenus pendant cette journée.689 

1899, 5 juin Elle se rend à Boston, et passe la nuit au 385 Commonwealth Avenue, 
chez Septimus J. Hanna et Camilla Hanna.690 

1899, 6 juin Elle s’adresse à 3000 personnes lors de la session du matin de l’Assemblée 

                                                
682 Mary Baker Eddy, « Address by Rev. Mary Baker G. Eddy » [Allocution de la Rév. Mary Baker G. Eddy], 
Christian Science Sentinel, 2 mars 1899, 4. 
683 « Notices », Christian Science Sentinel, 16 mars 1899, 15. 
684 « Note », Livret trimestriel de la Science Chrétienne, avril-juin 1899, page liminaire. 
685 Horatio W. Dresser, « Christian Science and its Prophetess : I. The Fact of the Case » [La Science Chrétienne et sa 
prophétesse : I. Présentation des faits], The Arena, mai 1899, 537-570. 
686 Septimus Hanna, Christian Science History [Histoire de la Science Chrétienne] (Boston: The Christian Science 
Publishing Society, 1899). 
687 The Christian Science Journal, juin 1899, xv-xvi. 
688 « Communion Service at The Mother Church » [Service de Communion à L’Eglise Mère], The Christian Science 
Journal, juillet 1899, 231-237. 
689 Ibid. 
690 « The Annual Church Meeting », The Christian Science Journal, juillet 1899, 238-247. 
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annuelle qui se tient à Tremont Temple, à Boston.691 

1899, 8 juin Des membres se rendent en visite à Pleasant View.692 

1899, 20 juin Ebenezer J. Foster Eddy est radié de la liste des membres de L’Eglise 
Mère.693 

1899, 31 juillet Josephine Curtis Woodbury intente un procès en diffamation à Mary 
Baker Eddy pour le contenu de son allocution de Communion du 4 juin.694 

Josephine Woodbury intente six autres procès contre l’Eglise et ses 
officiers.695 Ils se termineront tous le 10 avril 1902.696 

1899, 31 août Mary Baker Eddy invite quatre cents scientistes chrétiens à Concord à 
l’occasion de la Old Home Week [n.d.r. une fête originaire de la Nouvelle-
Angleterre]. Elle les voit au Christian Science Hall, mais ne prononce 
aucun discours. Ils sont invités à Pleasant View l’après-midi.697 C’est la 
première Old Home Week fêtée dans le New Hampshire.698 

1899 octobre Début de la procédure judiciaire engagée par Josephine Curtis Woodbury 
à Boston.699 

 Publication dans le Cosmopolitan de la première diatribe de Mark Twain 
contre la Science Chrétienne et Mary Baker Eddy.700 

1899, 19 octobre Le Sentinel commence à réimprimer des conférences, sous la forme d’un 
supplément, à un rythme irrégulier, à partir de cette date et jusqu’au  
5 février 1903. 

                                                
691 Ibid. 
692 « A Pilgrimage to Concord » [Pèlerinage à Concord], The Baltimore Sun, 9 juin 1899 ; Subject File, Eddy, Mary 
Baker – Visits of. 
693 William B. Johnson à Mary Baker Eddy, 20 juin 1899, IC001c.P1.01.032. 
694 S. J. Hanna à Mary Baker Eddy, 31 juillet 1899, IC33c.13.023. 
695 Allen M. Bearse, dépositions, 21 avril 1902 ; Subject File, Eddy, Mary Baker – Lawsuits – Woodbury vs. Eddy – 
Misc. 
696 Ibid. 
697 « Christian Scientists Visit Concord » [Les scientistes chrétiens en visite à Concord], Christian Science Sentinel, 7 
septembre 1899, 4. 
698 Etat du New Hampshire, Reports to the Legislature of the State of New Hampshire [Rapports à l’Assemblée 
législative de l’Etat du New Hampshire] (Manchester, NH: Arthur E. Clarke, 1901), 199. 
699 Allen M. Bearse, dépositions, 21 avril 1902, Subject File, Eddy, Mary Baker – Lawsuits – Woodbury vs. Eddy – 
Misc. 
700 Mark Twain, « Christian Science and the Book of Mrs. Eddy » [La Science Chrétienne et le livre de Mary Baker 
Eddy], Cosmopolitan, octobre 1899, 585-594. 
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1899, 7 novembre Tenue d’une assemblée semestrielle de L’Eglise Mère.701 

1899 décembre Susan B. Anthony fait l’éloge de Mary Baker Eddy en tant que leader 
religieux dans un article de presse. Susan Anthony répond aux attaques du 
politicien John Ingalls contre Mary Baker Eddy. L’article est reproduit 
dans le Sentinel.702 Susan Anthony a suivi le Cours Primaire avec  
Laura Lathrop.703 

1899, 15 décembre Adoption de la disposition statutaire établissant les salles de lecture.704  

Elle figure dans la quatorzième édition du Manuel de l’Eglise.705 

1899, 24 décembre Elle offre à son fils et à sa famille une nouvelle maison à Lead, dans le 
Dakota du Sud, comme cadeau de Noël.706 

1899, 28 décembre Josephine Curtis Woodbury est condamnée à une amende pour outrage  
au tribunal.707 

1899 fin Les deux premiers chapitres de Rétrospection et Introspection sont 
réinsérés dans le livre.708 

1900, 11 janvier Elle remplace les trois membres du Comité de Publication par un seul et 
nomme Alfred Farlow à ce poste, en vertu des nouveaux statuts.709 

1900, 16 mai Elle demande au Conseil des directeurs d’ouvrir une salle de lecture  
à Boston.710 

1900, 1er juin Ouverture de la première salle de lecture de L’Eglise Mère, telle que 
définie par le Manuel de l’Eglise, au 194 Boylston Street, à Boston.711 

                                                
701 « Among the Churches » [Au sein des églises], Christian Science Sentinel, 16 novembre 1899, 171. 
702 « The Work of Eddy » [L’œuvre de Mary Baker Eddy], Christian Science Sentinel, 14 décembre 1899, 245. 
703 Laura Lathrop à Mary Baker Eddy, 20 février 1887, IC161A.27.016. 
704 Mary Baker Eddy, 15 décembre 1899, L00759. 
705 Mary Baker Eddy, Manuel de l’Eglise, 14e éd., 63. 
706 Mary Baker Eddy à Charles M. Howe, 15 décembre 1899, L05318. 
707 « Mrs. Josephine C. Woodbury Is Fined $50 for Contempt » [Madame Josephine C. Woodbury est condamnée à 
une amende de 50 $ pour outrage], Boston Herald, 29 décembre 1899 ; Subject File, Eddy, Mary Baker – Lawsuits – 
Woodbury vs. Eddy – Misc. 
708 Mary Baker Eddy, Rétrospection et Introspection, 15e éd. (Boston: Joseph Armstrong, C. S. D., 1899). 
709 Mary Baker Eddy, 11 janvier 1900, L00762. 
710 Mary Baker Eddy au Conseil des directeurs de la Science Chrétienne, 16 mai 1900, L00247. 
711 « Reading Room » [Salle de lecture], The Christian Science Journal, juillet 1900, 230. 
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1900, 3 juin Lecture de son message à L’Eglise Mère lors de cinq services de 
Communion (9h, 11h, 14h, 16h et 17h30) par John W. Reeder, Premier 
Lecteur de l’église de Roxbury.712 Septimus J. Hanna conduit les 
services.713 Le « Message » est publié intégralement dans les journaux.714 

1900, 4 juin Elle accueille des membres à Pleasant View. Ils font la visite de sa 
maison. Les visites se poursuivent les 6 et 7 juin durant l’après-midi.715 

Aucune invitation officielle n’est lancée cette année-là. 

1900, 5 juin L’Assemblée annuelle de L’Eglise Mère se tient au Mechanics Hall.716 

1900 début juillet Son Message à L’Eglise Mère de 1900 (publié à l’origine en anglais avec 
le titre Message to The Mother Church of 1900) paraît sous forme de 
brochure.717 

1900, 10 août Elle invite les Premiers Membres et tous les membres locaux de L’Eglise 
Mère à se rassembler au Christian Science Hall le 17 août pour célébrer la 
fête de la Old Home Week.718 

1900, 5 septembre Elle prononce sa dernière allocution en dehors de chez elle, au Christian 
Science Hall, à Concord, devant les Premiers Membres.719 

1900, 6 septembre Elle se rend à la Foire d’Etat de Concord sur invitation spéciale.  
Escortée par l’assistant du gouverneur, elle fait le tour de la piste de course 
en calèche.720 Septimus J. et Camilla Hanna l’accompagnent dans  
sa calèche.721 

1900, 7 décembre Joseph R Clarkson lui conseille vivement de nommer un homme comme 
leader.722 

1901, 10 janvier Elle demande aux Premiers membres de transférer au Conseil des 

                                                
712 « Communion Service at The Mother Church », The Christian Science Journal, juillet 1900, 197-201. 
713 Ibid. 
714 Ibid. 
715 « Scientists at Pleasant View » [Des scientistes à Pleasant View], Christian Science Sentinel, 28 juin 1900, 696. 
716 « Annual Church Meeting », Christian Science Sentinel, 7 juin 1900, 643-645. 
717 « Our Leader’s Message » [Message de notre Leader], The Christian Science Journal, août 1900, i. 
718 Mary Baker Eddy à La Première Eglise du Christ, Scientiste, 10 août 1900, L00255. 
719 Calvin Frye, carnet, 5 septembre 1900, EF074. 
720 « The New Hampshire Fair » [La Foire du New Hampshire], Christian Science Sentinel, 13 septembre 1900, 24. 
721 Ibid. 
722 Calvin Frye, carnet, 7 décembre 1900, EF074. 
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directeurs leurs pouvoirs concernant les affaires de l’Eglise.723 

1901, 17 janvier Edward A. Kimball est chargé de suivre l’affaire Josephine Curtis 
Woodbury.724 

1901, 5 juin Le procès intenté par Josephine Curtis Woodbury tourne en faveur de 
Mary Baker Eddy.725 Ne souhaitant pas que le verdict tombe au moment 
de l’Assemblée annuelle, Mary Baker Eddy demande le report de 
l’Assemblée jusqu’en octobre.726 L’Assemblée est ensuite repoussée à  
juin 1902 ;727 il n’y a donc pas d’Assemblée en 1901. (Ce n’est qu’à partir 
de 1909 que l’Assemblée annuelle se tiendra, comme c’est actuellement le 
cas, le lundi suivant le premier dimanche de juin.)728 

1901, 23 juin Son message à L’Eglise Mère, de 90 minutes, est lu lors des quatre 
services de Communion. John W. Reeder lit le message.729 Septimus J. 
Hanna conduit les services.730 Ce « Message » est imprimé dans son 
intégralité dans les journaux.731 Il n’y a pas d’Assemblée annuelle cette 
année-là. 

1901, 25 juin Elle accueille 2500 à 3000 scientistes chrétiens à Pleasant View, sur 
invitation.732 

1901, 1er août Publication de la brochure Message à L’Eglise Mère de 1901 (qui paraît 
à l’origine en anglais avec le titre Message to the Mother Church of 
1901).733 

1901, 28 août Elle fait une deuxième visite à la Foire d’Etat de Concord. William G. et 

                                                
723 Mary Baker Eddy, 10 janvier 1901, L00785. 
724 Mary Baker Eddy à William B. Johnson, 17 janvier 1901, L00267 ; Mary Baker Eddy à Samuel J. Elder, 17 
janvier 1901, L05335. 
725 Allen M. Bearse, dépositions, 21 avril 1902 ; Subject File, Eddy, Mary Baker – Lawsuits – Woodbury vs. Eddy – 
Misc. 
726 Mary Baker Eddy au Conseil des directeurs de la Science Chrétienne, 17 juin 1901, L00279. 
727 William B. Johnson, « The Annual Church Meeting » [L’Assemblée annuelle de l’Eglise], The Christian Science 
Journal, octobre 1901, 404. 
728 « Mother Church Annual Meeting » [L’Assemblée annuelle de L’Eglise Mère], The Christian Science Monitor, 7 
juin 1909. 
729 « Message from Mrs. Eddy » [Message de Mary Baker Eddy], Christian Science Sentinel, 4 juillet 1901, 704. 
730 Ibid. 
731 « Communion Service », Christian Science Sentinel, 27 juin 1901, 684-686. 
732 « The Visit to Pleasant View » [La visite à Pleasant View], Christian Science Sentinel, 4 juillet 1901, 702-703. 
733 « Notices », Christian Science Sentinel, 1er août 1901, 763. 
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Ruth B. Ewing l’accompagnent dans sa calèche.734 

1901, 12 décembre La 226e édition de Science et Santé obtient la protection du droit 
d’auteur.735 

1902, 30 janvier La 226e édition de Science et Santé est annoncée pour la première fois 
dans les périodiques de la Science Chrétienne.736 L’ordre des chapitres est 
le même qu’aujourd’hui. Les lignes sont numérotées dans la marge. Elle 
inclut pour la première fois le chapitre « Les fruits de la Science 
Chrétienne ». L’index est supprimé car une Concordance est en 
préparation.737 Des révisions mineures seront apportées ponctuellement au 
cours des neuf années suivantes. 

1902, 13 février Footprints Fadeless [Empreintes indélébiles] obtient la protection du droit 
d’auteur.738 Le livre vise à apporter « des éléments supplémentaires relatifs 
à ses premiers combats dans l’établissement de la Science Chrétienne ».739 

Il sert également à contrer les accusations mensongères de Frederick W. 
Peabody dans ses conférences publiques au sujet de la vie et de l’œuvre de 
Mary Baker Eddy. Elle fait appel à Irving C. Tomlinson « pour l’aider à 
préparer le sujet pour la presse. Une fois le manuscrit achevé, son 
conseiller juridique lui a recommandé de ne pas publier le livre tout de 
suite. Le manuscrit a été soigneusement mis de côté en vue d’une 
publication ultérieure. »740 

1902, 10 avril Le tribunal déboute Josephine Curtis Woodbury des poursuites intentées 
contre L’Eglise Mère.741 

1902 juin Archibald McLellan succède à Septimus J. Hanna en tant que rédacteur en 
chef du Journal et du Sentinel.742 McLellan demeure à ce poste jusqu’à sa 

                                                
734 « The Concord Fair » [La Foire de Concord], Christian Science Sentinel, 5 septembre 1901, 8-11. 
735 Henry M. Baker, Archibald McLellan et Josiah Fernald, cession de droit d’auteur, 30 décembre 1909 ; Subject 
File, Eddy, Mary Baker – Writings – Copyright. 
736 « New Edition of Science and Health » [Une nouvelle édition de Science et Santé], Christian Science Sentinel, 30 
janvier 1902, 347. 
737 « The New Edition of Science and Health », The Christian Science Journal, mars 1902, 786-788. 
738 Henry M. Baker, Archibald McLellan et Josiah Fernald, cession de droit d’auteur, 30 décembre 1909 ; Subject 
File, Eddy, Mary Baker – Writings – Copyright. 
739 Calvin Frye à Allison V. Stewart, 25 mars 1913, L12614. 
740 Ibid. 
741 Allen M. Bearse, dépositions, 21 avril 1902, Subject File, Eddy, Mary Baker – Lawsuits – Woodbury vs. Eddy – 
Misc. 
742 « Editorial Department », Christian Science Sentinel, 26 juin 1902, 688. 
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mort en juillet 1917.743 

1902, 15 juin Lecture de son message à L’Eglise Mère par le professeur Richard Wood 
Cone lors de deux services de Communion qui se tiennent à 10h et 15h,  
au Mechanics Hall, à Boston (l’édifice original étant trop petit).744  

Ce « Message » est publié dans son intégralité dans les journaux.745 

1902, 18 juin Sur sa recommandation et sur une motion proposée par Edward A. 
Kimball, les scientistes chrétiens présents à l’Assemblée annuelle qui  
se tient au Mechanics Hall, à Boston, s’engagent à récolter 2 000 000 $  
pour la construction de l’extension de L’Eglise Mère.746 Les membres  
ne se rendent pas à Pleasant View cette année-là. 

 Le mandat des lecteurs est limité à trois ans.747 Cela met fin au long 
service de Septimus J. Hanna, Premier Lecteur de L’Eglise Mère depuis 
1895 (et Pasteur en 1894). Hermann S. Hering est élu pour lui succéder.748 

1902, 26 juin Le Sentinel annonce la publication du Message à L’Eglise Mère de 1902 
sous forme de brochure (il paraît à l’origine en anglais avec le titre 
Message to The Mother Church of 1902).749 

1902, 27 novembre Premier service d’Actions de Grâces à L’Eglise Mère et dans ses filiales.  
 
Les passages de la Leçon sermon de ce service spécial sont publiés dans  
le Sentinel.750 

1902 décembre Publication du premier des quatre articles de Mark Twain sur la Science 
Chrétienne dans le North American Review.751 

1903  Début de la construction de l’édifice de Première Eglise, Concord, sur le 

                                                
743 Annie M. Knott et William D. McCrackan, « Archibald McLellan, C. S. B. », Christian Science Sentinel, 28 juillet 
1917, 950. 
744 « Communion Service of The Mother Church » [Le service de communion de L’Eglise Mère], Christian Science 
Sentinel, 19 juin 1902, 672-674. 
745 Ibid. 
746 « The Annual Meeting », Christian Science Sentinel, 26 juin 1902, 688-691. 
747 Mary Baker Eddy, « Afterglow » [Splendeur crépusculaire], The Christian Science Journal, août 1902, 265-266. 
748 « The New Readers » [Les nouveaux lecteurs], Christian Science Sentinel, 26 juin 1902, 688. 
749 « Notices », Christian Science Sentinel, 26 juin 1902, 687. 
750 « Thanksgiving Day » [Jour d’Actions de Grâces], Christian Science Sentinel, 30 octobre 1902, 131. 
751 Mark Twain, « Christian Science I » [Science Chrétienne I], The North American Review, décembre 1902, 
756-768. 
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site du Christian Science Hall.752 

1903 février Mary Baker Eddy ajoute un cinquième membre, Archibald McLellan,  
au Conseil des directeurs.753 

1903, 17 mars George Washington Glover, Jr., et sa fille, Mary, rendent visite à Mary 
Baker Eddy.754 Les Premiers Membres sont renommés « Membres 
exécutifs ».755 

1903, 29 mars Elle commence une révision majeure du Manuel de l’Eglise.756  

Elle termine ce travail le 28 juillet.757 La 29e édition est publiée en  
août 1903.758 

1903 avril Lancement de l’édition allemande du futur Héraut de la Science 
Chrétienne : Der Christian Science Herold,759 renommé plus tard  
Der Herold der Christian Science.760 Il s’agit là de la première publication 
en langue étrangère, mis à part quelques brochures dont « Evil is not 
power » (en traduction française « Le mal n’est pas un pouvoir », qui n’a 
jamais été protégée par le droit d’auteur ni mise en vente),761 et « The Way 
to Begin in Christian Science » [Comment commencer en Science 
Chrétienne] (en allemand et en norvégien).762 Le Sentinel a également 
publié la traduction allemande d’une conférence d’Irving Tomlinson.763 

1903, juin Publication de la Complete Concordance to Science and Health 
[Concordance complète de Science et Santé].764 

                                                
752 « Corner-Stone Laid at Concord » [Pose de la pierre angulaire à Concord], The Christian Science Journal, août 
1903, 297-299. 
753 Mary Baker Eddy au Conseil des directeurs de la Science Chrétienne, 5 février 1903, L00323. 
754 Calvin Frye, carnet, 17 mars 1903, EF078. 
755 Mary Baker Eddy, Manuel de l’Eglise, 29e éd., 66. 
756 Mary Baker Eddy au Conseil des directeurs de la Science Chrétienne, 24 mars 1903, L00332 ; Calvin Frye à 
William B. Johnson, 29 mars 1903, L01298. 
757 Mary Baker Eddy à Joseph Armstrong, 28 juillet 1903, L02953. 
758 M., « The Revised Church Manual » [L’édition révisée du Manuel de l’Eglise], Christian Science Sentinel, 15 août 
1903, 796. 
759 « Important Announcement » [Annonce importante], Christian Science Sentinel, 7 mars 1903, 423. 
760 Der Herold der Christian Science, avril 1905, en couverture. 
761 La Société d’édition de la Science Chrétienne à Mary Baker Eddy, 2 décembre 1907, IC094b.21.021. 
762 The Christian Science Journal, juillet 1890, quatrième de couverture. 
763 Irving Tomlinson, « Die Christliche Wissenschaft, Das Christenthum Christi » [La Science Chrétienne et le 
christianisme du Christ], Christian Science Sentinel, 10 avril 1902, 517-520. 
764 « The New Concordance » [La nouvelle Concordance], Christian Science Sentinel, 27 juin 1903, 684. 
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1903, 28 juin L’Eglise Mère tient trois services de Communion au Mechanics Hall.765 

1903, 29 juin Elle s’adresse à près de mille scientistes chrétiens venus l’entendre à 
Pleasant View. C’est à cette occasion qu’est prise la célèbre photo du 
balcon.766 Pareille invitation a été faite en 1897 et en 1901.767  

Des scientistes chrétiens sont venus à Pleasant View en 1900,768 mais  
sans invitation. A la demande de Mary Baker Eddy, aucune visite n’a lieu 
en 1902.769 

1903, 30 juin L’Eglise Mère tient son Assemblée annuelle au Mechanics Hall.770 

1903, 1er juillet Les scientistes chrétiens diplômés du Cours Normal se réunissent dans 
l’édifice de L’Eglise Mère.771 

1903 octobre La Société d’édition s’installe au 250 Huntington Avenue.772 Début des 
travaux de déblaiement du terrain pour la construction de l’extension.773 

1903, 26 octobre Première assemblée de l’Association générale des professeurs, à 
Boston.774 L’assemblée se tient à Chicago en octobre 1904,775 puis à New 
York en 1905.776 Selon les statuts de la 56e édition du Manuel de l’Eglise, 
les assemblées sont bi-annuelles,777 puis deviennent triennales dans la  
69e édition (il n’y a donc pas d’assemblée en 1906 ni en 1907).778 

                                                
765 « The Communion and Annual Meeting » [Communion et Assemblée annuelle], Christian Science Sentinel, 4 
juillet 1903, 695-698. 
766 Ibid. 
767 « Our Fourth of July », The Christian Science Journal, août 1897, 261-265 ; « The Visit to Pleasant View », 
Christian Science Sentinel, 4 juillet 1901, 702-703. 
768 « Scientists at Pleasant View », Christian Science Sentinel, 28 juin 1900, 696. 
769 « Communion Service of The Mother Church », Christian Science Sentinel, 19 juin 1902, 674. 
770 « The Communion and Annual Meeting », Christian Science Sentinel, 4 juillet 1903, 695-698. 
771 « Meeting of Normal Graduates » [Réunion des élèves diplômés du Cours Normal], Christian Science Sentinel, 13 
juin 1903, 651. 
772 Christian Science Sentinel, 24 octobre 1903, en couverture. 
773 Charles C. Coveney, « The Designing and Building of The Mother Church Extension » [La conception et la 
construction de l’extension de L’Eglise Mère], Souvenirs, Charles C. Coveney, 37. 
774 « General Association of Teachers » [Association générale des professeurs], Christian Science Sentinel, 31 
octobre 1903, 138. 
775 « The General Association of Teachers », Christian Science Sentinel, 5 novembre 1904, 152. 
776 « Meeting of General Association of Teachers » [Réunion de l’Association générale des professeurs], The 
Christian Science Journal, octobre 1905, 454. 
777 Mary Baker Eddy, Manuel d’Eglise de La Première Eglise du Christ, Scientiste à Boston, Massachusetts, publié à 
l’origine en anglais avec le titre Church Manual of The First Church of Christ, Scientist, in Boston, Massachusetts, 
56e éd. (Boston: Joseph Armstrong, 1906), 87. 
778 Mary Baker Eddy, Manuel d’Eglise de La Première Eglise du Christ, Scientiste à Boston, Massachusetts, 69e éd. 
(Boston: Allison V. Stewart, 1908), 90. 
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L’Association est dissoute en juin 1908.779 

1903, 29 novembre Dédicace du nouvel édifice de Première Eglise du Christ, Scientiste, New 
York. Sa construction a coûté près de deux millions de dollars.780 C’est 
l’église d’Augusta E. Stetson. 

1904  L’« Ordre actuel des services » selon la 45e édition du Manuel de l’Eglise 
est le même que l’ordre actuel, à l’exception du prélude et du postlude à 
l’orgue, ajoutés plus tard.781 

1904 mars La disposition statutaire « Privilège des membres » prévoit la création  
des organisations universitaires.782 La première organisation est créée à 
l’Université d’Harvard, à Cambridge, dans le Massachusetts.783 

1904 mai Edward A. Kimball démissionne du Conseil d’Instruction.784  

Il est remplacé par Eugene H. Greene.785 

1904, 12 juin Trois services de Communion ont lieu dans l’auditorium de L’Eglise 
Mère.786 

1904, 13 juin Les scientistes chrétiens se rendent à Concord pour voir l’édifice de 
l’église, qui est presque achevé.787 Mary Baker Eddy offre un marteau  
à Edward P. Bates, président de L’Eglise Mère.788 L’événement a lieu  
sur North State Street, devant un public rassemblé sur les pelouses qui 
bordent l’Eglise unitarienne et le lycée.789 

1904, 14 juin L’Assemblée annuelle de L’Eglise Mère se tient au Symphony Hall.790 

                                                
779 William B. Johnson à Mary Baker Eddy, 17 juin 1908, L07190. 
780 « Built From Plans “Divinely Revealed” » [Une église construite selon des plans « divinement révélés »], The New 
York Times, 30 novembre 1903 ; Subject File, Stetson, Augusta E. 
781 Mary Baker Eddy, Manuel d’Eglise de La Première Eglise du Christ, Scientiste, à Boston, Massachusetts, 45e éd. 
(Boston: Joseph Armstrong, 1904). 
782 Mary Baker Eddy au Conseil des directeurs de la Science Chrétienne, 4 mars 1904, L00850. 
783 « Christian Science Society of Harvard University » [Société de la Science Chrétienne à l’Université d’Harvard], 
The Christian Science Journal, mai 1912, 100. 
784 Mary Baker Eddy à Edward A. Kimball, 27 avril 1904, L02613. 
785 Mary Baker Eddy au Conseil des directeurs de la Science Chrétienne, 20 mai 1904, L00383. 
786 « The Annual Communion Service » [Le service annuel de Communion], Christian Science Sentinel, 18 juin 1904, 
659-660. 
787 « The visit to Concord » [La visite à Concord], The Christian Science Journal, juillet 1904, 196-197. 
788 Ibid. 
789 « The visit to Concord », Christian Science Sentinel, 18 juin 1904, 660. 
790 « The Annual Meeting », Christian Science Sentinel, 18 juin 1904, 660-662. 
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1904, 16 juillet Pose de la pierre angulaire de l’extension de L’Eglise Mère.791 

1904, 17 juillet Dédicace de Première Eglise du Christ, Concord, New Hampshire. 
L’église n’a aucune dette, en grande partie grâce à un don de Mary  
Baker Eddy (elle a donné 100 000 $ aux trois administrateurs pour la 
construction d’une église en granite).792 Elle vient voir l’église  
une seule fois, en septembre 1905.793 

1905, 28 avril Elle achète la maison sise au 387 Commonwealth Avenue, à Boston, juste 
à côté de la résidence du Premier Lecteur.794 

1905, 11 juin L’Eglise Mère tient trois services de Communion dans l’édifice de 
l’église.795 

1905, 13 juin L’Assemblée annuelle de L’Eglise Mère a lieu dans l’édifice de 
l’église.796 

1905, 17 juin-1er juillet Elle demande que l’on prie tout spécialement pour la fin de la guerre 
russo-japonaise.797 Elle annule cette demande le 1er juillet.798 

1905, 12 septembre Elle visite pour la seule et unique fois Première Eglise du Christ, 
Scientiste, Concord. Elle ne fait aucun discours.799 

1905, 1er octobre L’Eglise Mère tient à présent trois services : à 9h, 11h30 et 15h.800 

1906, 10 juin Les services de Communion et de dédicace sont les deux premiers services 
organisés dans l’extension de L’Eglise Mère. Publication d’un avis 
informant que l’église dispose des fonds suffisants pour couvrir le coût de 

                                                
791 « The Corner-Stone Laid » [Pose de la pierre angulaire], The Christian Science Journal, août 1904, 272. 
792 « Dedication of the Church in Concord » [Dédicace de l’église à Concord], Christian Science Sentinel, 23 juillet 
1904, 740. 
793 « Mrs. Eddy Pays First Visit to New Church in Concord » [Mary Baker Eddy se rend pour la première fois dans la 
nouvelle église à Concord], Christian Science Sentinel, 23 septembre 1905, 54. 
794 Calvin A. Frye à Hermann S. Herring, 7 juin 1905, L12317. 
795 « The Communion Service », Christian Science Sentinel, 17 juin 1905, 674-675. 
796 « The Annual Meeting of The Mother Church », Christian Science Sentinel, 17 juin 1905, 675-677. 
797 Mary Baker Eddy, « To My Church » [A mon Eglise], Christian Science Sentinel, 17 juin 1905, 674. 
798 Mary Baker Eddy, « Hear, O Israel : the Lord our God is one Lord » [Ecoute, Israël ! L’Eternel, notre Dieu, est le 
seul Eternel], Christian Science Sentinel, 1er juillet 1905, 708. 
799 « Mrs. Eddy Pays First Visit to the New Church in Concord », Christian Science Sentinel, 23 septembre 1905, 54. 
800 « Services in The Mother Church », Christian Science Sentinel, 7 octobre 1905, 89. 
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la construction de l’édifice.801 Six services identiques sont tenus ce même 
jour pour accueillir tous ceux qui sont venus y assister. Son message, 
« Choisissez », est lu par William Denison McCrackan, le Premier 
Lecteur.802 

1906, 12 juin L’Assemblée annuelle se déroule deux fois de suite dans l’extension,  
ce mardi-là, à 10h et à 14h, afin que tous les membres qui sont venus  
à Boston puissent y assister.803 

1906, 30 juillet Elle demande au Conseil des directeurs d’ajouter dans Pulpit and Press 
tout ce qu’ils ont écrit et tout ce qui a été imprimé dans les autres 
périodiques concernant la nouvelle extension de L’Eglise Mère.804  

Elle autorise l’utilisation de son message de dédicace, « Choisissez ».805 

1906, 8 septembre Mort de Joseph B. Clark, administrateur de la Société d’édition.806 

1906, 25 septembre Allison V. Stewart est élu en tant qu’administrateur de la Société d’édition 
par le Conseil des directeurs de la Science Chrétienne.807 Mary Baker 
Eddy n’a pas souhaité combler elle-même le poste vacant.808  

1906, 8 octobre Elle demande à Joseph Armstrong de lui envoyer tous les documents qu’il 
a réunis pour The Mother Church of Christ, Scientist, and Miscellany 
[L’Eglise Mère du Christ, Scientiste, et Miscellanées].809 

1906, 11 octobre Elle demande à la Bibliothèque du Congrès la protection du droit d’auteur 
pour le livre La Première Eglise du Christ, Scientiste, et Miscellanées 
(publié à l’origine en anglais avec le titre The First Church of Christ, 
Scientist, and Miscellany).810 

                                                
801 « Notices to the Contributors to the Building Fund » [Avis aux donateurs qui contribuent au Fonds de 
Construction], Christian Science Sentinel, 9 juin 1906, 648. 
802 « The Communion Service and Dedication » [Le service de Communion et la dédicace], Christian Science 
Sentinel, 16 juin 1906, 660. 
803 « The Annual Meeting », Christian Science Sentinel, 23 juin 1906, 675. 
804 Lewis C. Strang à William B. Johnson, juillet 1906, L15638A-S. 
805 Mary Baker Eddy au Conseil des directeurs de la Science Chrétienne, 30 juillet 1906, L15638A ; Lewis C. Strang 
à William B. Johnson, juillet 1906, L15638A. 
806 Commonwealth du Massachusetts, acte de décès, 8 septembre 1906 ; Subject File, Clark, Joseph P. 
807 Mary Baker Eddy, Deed of Trust [Acte de fiducie] (Boston: The Christian Science Publishing Society, 2004), 10. 
808 Mary Baker Eddy au Conseil d’administration de la Société d’édition de la Science Chrétienne, 14 septembre 
1906, L07257. 
809 Mary Baker Eddy à Joseph Armstrong, 8 octobre 1906, L03007. 
810 Mary Baker Eddy à la Bibliothèque du Congrès, 11 octobre 1906, L09759. 
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1906, 19 octobre L’édition actuelle de Science et Santé est protégée par le droit d’auteur.811 

Ce droit d’auteur est renouvelé en 1934.812 

1906, 28 octobre Le New York World lance une série d’attaques contre elle.813 Les reporters 
se sont rendus à Concord à la demande de Joseph Pulitzer, et ils ont 
obtenu un court entretien avec elle afin de réfuter la rumeur de sa mort,  
et la prétention qu’on fait passer pour elle un mannequin ou un membre de 
sa maisonnée, Pamelia J. Leonard, lors de sa promenade quotidienne en 
calèche.814 

1906, 30 octobre Elle rencontre onze ou douze représentants de la presse venus à Concord 
après les attaques du New York World. Sibyl Wilbur leur sert 
d’intermédiaire en lui présentant quatre questions. Après avoir répondu à 
la troisième question, Mary Baker Eddy les quitte pour faire sa promenade 
quotidienne en calèche. Elle ne répond pas à la quatrième question.815 

1906 novembre Le New York World contacte George Washington Glover Jr. afin d’avoir 
son appui pour mener une action en justice contre sa mère.816 

1906 décembre Annonce de la parution prochaine d’une série d’articles hostiles à Mary 
Baker Eddy, écrits par Georgine Milmine pour McClure’s Magazine.817 

1907  L’édition de 1907 porte la date du dernier copyright (1906) protégeant 
Science et Santé du vivant de Mary Baker Eddy.818 

 Dernière révision majeure de Science et Santé.819 

                                                
811 Service des droits d’auteur de la Bibliothèque du Congrès, Catalogue of Copyright Entries [Catalogue des 
attributions de droits d’auteur] (Washington, DC: Government Printing Office, 1907) ; Subject File, Eddy – Writings 
– Science and Health – Copyrights. 
812 Ibid. (1935) ; Subject File, ibid. 
813 Calvin Frye, 29 octobre 1906, L15766. 
814 « Baseless Charges Refuted » [Réfutation d’accusations sans fondement], Christian Science Sentinel, 3 novembre 
1906, 147-154. 
815 Ibid., 153-154. 
816 William E. Chandler à John W. Kelley, 20 novembre 1906, Chandler Papers, Société historique du New 
Hampshire. 
817 « Editorial Announcement: Mary Baker G. Eddy: The Story of Her Life, and the History of Christian Science » 
[Annonce de la rédaction : Mary Baker G. Eddy : L’histoire de sa vie et l’histoire de la Science Chrétienne], 
McClure’s Magazine, décembre 1906, 211-217. 
818 Mary Baker Eddy, Science et Santé avec la Clef des Ecritures (Boston: Joseph Armstrong, 1907). 
819 « A New Edition of Science and Health » [Une nouvelle édition de Science et Santé], Christian Science Sentinel, 7 
septembre 1907, 10. 
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1907 janvier Les articles de Georgine Milmine sur Mary Baker Eddy paraissent dans 
McClure’s Magazine à compter de ce numéro et jusqu’au mois de juin 
1908 (excepté en novembre et décembre 1907 et en janvier 1908).820  

Mary Baker Eddy y répond par un article publié dans les journaux du New 
Hampshire et dans le Sentinel.821 B.O. Flower [journaliste d’investigation], 
fait un commentaire favorable à Mary Baker Eddy et à la Science 
Chrétienne dans l’Arena de janvier,822 de même que Charles Klein  
dans le Cosmopolitan de février.823 

 Les articles biographiques de Sibyl Wilbur sur Mary Baker Eddy, 
« Glimpses of a Great Personality » [Aperçus d’une personnalité 
exceptionnelle], paraissent à partir de cette date dans le magazine  
Human Life, et ce jusqu’en décembre.824 

1907 janvier-février Publication du livre de Mark Twain, Christian Science [La Science 

                                                
820 Georgine Milmine, « Mary Baker G. Eddy: The Story of her Life and the History of Christian Science » [Mary 
Baker G. Eddy : L’histoire de sa vie et l’histoire de la Science Chrétienne], « I. Forty Years of Obscurity » 
[I. Quarante ans d’obscurité], McClure’s Magazine, janvier 1907, 227-242 ; ibid., « II. Mrs. Eddy and Phineas 
Parkhurst Quimby » [II. Mary Baker Eddy et Phineas Parkhurst Quimby], février 1907, 339-354 ; ibid., « III. The 
Quimby Controversy » [III. La controverse à propos de Quimby], mars 1907, 506-524 ; ibid., « IV. Six Years of 
Wandering » [IV. Six années d’errance], avril 1907, 608-627 ; ibid., « V. Mrs Eddy and Her First Disciples » [V. 
Mary Baker Eddy et ses premiers disciples], mai 1907, 97-116 ; G. Milmine, « Editorial Announcement [Annonce de 
la rédaction]: Mary Baker G. Eddy : The Story of her Life and the History of Christian Science », McClure’s 
Magazine, juin 1907, 134 ; G. Milmine, « Mary Baker G. Eddy: The Story of her Life and the History of Christian 
Science », « The Revival of Witchcraft » [Le renouveau de la sorcellerie], McClure’s Magazine, juillet 1907, 333-
348 ; ibid., « The Church and the Mesmerists » [L’Eglise et les mesméristes], août 1907, 447-458 ; ibid., « The 
Massachusetts Metaphysical College and Calvin Frye » [Le Massachusetts Methaphyscal College et Calvin Frye], 
septembre 1907, 567-581 ; ibid., « Literary Activities » [Activités littéraires], octobre 1907, 686-699 ; ibid., « The 
Schism of 1888, The Growth of Christian Science Healing, and the Apotheosis of Mrs. Eddy » [Le schisme de 1888, 
La croissance de la guérison par la Science Chrétienne et l’apothéose de Mary Baker Eddy], février 1908, 387-401 ; 
ibid., « The Adoption of a Son and the Founding of The Mother Church » [L’adoption d’un fils et la fondation de 
L’Eglise Mère], mars 1908, 577-590 ; ibid., « Life at Pleasant View and “War in Heaven” » [La vie à Pleasant View 
et “Guerre dans le ciel”], avril 1908, 699-712 ; ibid., « Training the Vine – A Study in Mrs. Eddy’s Prerogatives and 
Power » [Prendre soin de la vigne – Etude des prérogatives et des pouvoirs de Mary Baker Eddy], mai 1908, 16-31 ; 
ibid., « “Mrs. Eddy’s Books and Doctrine” » [Les livres et la doctrine de Mary Baker Eddy], juin 1908, 179-189. 
821 « Mrs. Eddy’s Reply to the January McClure Article », Christian Science Sentinel, 5 janvier 1907, 311-312 ; 
« Mrs. Eddy’s Reply to the January McClure Article », Christian Science Sentinel, 12 janvier 1907, 331-333. 
822 B. O. Flower, « The Recent Reckless and Irresponsible Attacks on Christian Science and Its Founder, With a 
Survey of the Christian Science Movement » [Les récentes attaques inconsidérées et irresponsables contre la Science 
Chrétienne et sa fondatrice, avec une enquête sur le mouvement de la Science Chrétienne], The Arena, janvier 1907, 
47-67. 
823 Charles Klein, « Christian Science: An Impartial Estimate » [La Science Chrétienne : un regard impartial], 
Cosmopolitan, février 1907, 458-463. 
824 Sibyl Wilbur, « Glimpses of a Great Personality » [Aperçus d’une personnalité exceptionnelle], Human Life, 
janvier 1907, 3-5, 22 ; S. Wilbur, « The Story of the Real Mrs. Eddy » [L’histoire de la vraie Mary Baker Eddy], 
Human Life, février 1907, 11-13, 26 ; ibid., mars 1907, 9-10 ; ibid., avril 1907, 11-12, 25 ; ibid., mai 1907, 7-8, 16 ; 
ibid., juin 1907, 11-12 ; ibid., juillet 1907, 7-8, 18 ; ibid, août 1907, 9-10 ; ibid., septembre 1907, 13-14, 34 ; ibid., 
octobre 1907, 13-14, 34 ; ibid., novembre 1907, 14-15, 32 ; ibid., décembre 1907, 19-21. 
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Chrétienne].825 Ce livre est basé sur sa série d’articles publiés dans le 
North American Review. 

1907, 2 janvier George Washington Glover, Jr., et sa fille, Mary, rendent à nouveau visite 
à Mary Baker Eddy.826 

1907, 1er mars Début du procès des « Proches » à Concord.827 Les demandeurs affirment 
que Mary Baker Eddy souffre d’incapacité mentale et que plusieurs 
membres de sa maisonnée et de son Eglise ont la haute main sur ses biens 
financiers. Le procès est intenté par William E. Chandler auprès du 
tribunal de New Hampshire, au nom et pour le compte de George 
Washington Glover, Jr. et des « Proches », en l’occurrence Mary Baker 
Glover (petite-fille) et George W. Baker (neveu).828 Frederick W. Peabody 
est leur avocat conseil.829 Les audiences commencent le 13 août.830 

1907, 6 mars Elle désigne trois administrateurs pour gérer ses biens.831 

1907, 11 mars Ebenezer J. Foster et Fred W Baker (cousin) se joignent au procès des 
« Proches ».832 Ce dernier se désiste deux mois plus tard.833 

1907, 14 avril Réunion en faveur de la paix dans l’extension de L’Eglise Mère en 
réponse à la demande du Comité d’arbitrage national et du Congrès de la 
paix à New York.834 Il est fait état, au sujet de Mary Baker Eddy, de sa 
qualité de membre « fondateur » de l’Association pour la conciliation 
internationale.835 Un an plus tard, elle ajoute un amendement à l’article 

                                                
825 Mark Twain, Christian Science [La Science Chrétienne] (New York: Harper & Brothers, 1907), Préface. 
826 Calvin Frye, carnet, 2 janvier 1907, EF079. 
827 Etat du New Hampshire, archives (Concord, NH: Rumford Printing Company, 1907), 1 ; Subject File, Eddy, Mary 
Baker – Lawsuits – “Next Friends” – Court Records – Clerk’s Files – Copies Part I. 
828 Ibid. 
829 Frederick Peabody à William E. Chandler, 3 janvier 1907, Chandler Papers, Société historique du New 
Hampshire. 
830 Le litige M. B. E., 27 septembre 1907, 1 ; Subject File, Eddy, Mary Baker – Lawsuits – “Next Friends” – Court 
Proceedings – Printed Materials – September 1907. 
831 « Card » [Annonce], Christian Science Sentinel, 6 avril 1907, 578. 
832 Etat du New Hampshire, archives (Concord, NH: Rumford Printing Company, 1907), 17 ; Subject File, Eddy, 
Mary Baker – Lawsuits – “Next Friends” – Court Records – Clerk’s Files – Copies Part I. 
833 Ibid., 135 ; Subject File, ibid. 
834 « Peace Meeting in the Mother Church » [Réunion en faveur de la paix à L’Eglise Mère], Christian Science 
Sentinel, 20 avril 1907, 611. 
835 « Membership for Mrs. Eddy » [Mary Baker Eddy, membre], Christian Science Sentinel, 27 avril 1907, 640 ; 
Mary Baker Eddy, « Mrs. Eddy’s Letter » [Lettre de Mary Baker Eddy], Christian Science Sentinel, 4 mai 1907, 662 ; 
Archibald McLellan, « Mrs. Eddy’s Relation to the Peace Movement » [Liens de Mary Baker Eddy avec le 
Mouvement pour la paix], Christian Science Sentinel, 11 mai 1907, 682. 
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XX, section 14, du Manuel de l’Eglise. La disposition statutaire 
« Promotion de la paix » stipule qu’il n’est pas nécessaire de devenir 
membre d’autres organisations pour promouvoir la paix.836 

1907, 3 mai L’éditeur de Human Life, W. F. Smith, se rend à Pleasant View sans y 
avoir été invité. Mary Baker Eddy le reçoit.837 

1907, 18 mai Une annonce dans le Sentinel, « No large gathering in Boston this year » 
[Pas de grande réunion à Boston cette année] mentionne la disposition 
statutaire en vigueur depuis presque une année, selon laquelle le service  
de Communion général, qui se tient dans l’édifice de L’Eglise Mère, aura 
lieu tous les trois ans, à compter de 1909.838 Un service de Communion 
pour les membres locaux de L’Eglise Mère a néanmoins lieu le 9 juin.839  

 En juin 1908, elle supprime complètement le service de Communion à 
L’Eglise Mère.840 

1907, 9 juin Deux services de Communion ont lieu dans l’extension de L’Eglise 
Mère.841 

1907, 10 juin « Avant [cette date], elle n’avait jamais lu ce livre [Science et Santé] d’un 
bout à l’autre afin de rendre clair son idéalisme. »842 

1907, 11 juin L’Assemblée annuelle de L’Eglise Mère se tient dans l’extension.843 

1907, 10 juillet Le médecin Edward French s’entretient avec elle dans le cadre du procès 
des « Proches ».844 

1907, 12 août Allan McLane Hamilton, médecin aliéniste (psychiatre) lui rend visite à la 
                                                
836 « Amendment to By-Law » [Modification d’une disposition statutaire], Christian Science Sentinel, 2 mai 1908, 
690. 
837 W. F. Smith, « My Meeting with Mrs. Mary B. G. Eddy » [Ma rencontre avec Mary B. G. Eddy], Human Life, juin 
1907, 17. 
838 « No Large Gathering in Boston This Year » [Pas de grand rassemblement à Boston cette année], Christian 
Science Sentinel, 18 mai 1907, 702. 
839 « Communion in The Mother Church » [Service de Communion à L’Eglise Mère], Christian Science Sentinel, 15 
juin 1907, 783. 
840 « Communion Season is Abolished » [Suppression de la célébration de la Communion], Christian Science 
Sentinel, 27 juin 1908, 850. 
841 « Communion in The Mother Church », Christian Science Sentinel, 15 juin 1907, 783. 
842 Mary Baker Eddy, Science et Santé, xii. 
843 « The Annual Meeting of The Mother Church », Christian Science Sentinel, 15 juin 1907, 784-786. 
844 Calvin Frye, carnet, 10 juillet 1907, EF079. 
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demande de ses avocats.845 

1907, 13 août Début des audiences du procès des « Proches ».846 

1907, 14 août Les experts désignés par le juge Robert N. Chamberlin pour déterminer 
son acuité mentale se rendent à Pleasant View.847 

1907, 21 août Son acuité mentale étant fermement établie, le procès des « Proches »  
n’a plus lieu d’être, mais il n’y est officiellement mis fin que le  
30 septembre.848 

1907 octobre Ouverture du chantier pour le nouveau bâtiment de la Société d’édition  
au 107 Falmouth Street.849  

1907, 12 octobre Annonce est faite de la nécessité d’une nouvelle maison d’édition. Une 
collecte de fonds est organisée pour récolter environ 200 000 $.850 

1907, 23 octobre L’exposition de la Société d’édition remporte le Grand prix à l’Exposition 
internationale du livre et des industries du papier, organisée à Paris.851 

Mary Baker Eddy reçoit un diplôme d’honneur.852 Le gouvernement 
français, qui parraine l’exposition, lui décerne le titre d’« Officier 
d’Académie » en reconnaissance de son « œuvre utile et remarquable ».853 

Les membres de Première Eglise du Christ, Scientiste, Concord, reçoivent 
la médaille de la France et la lui remettent le 30 janvier 1908.854 

1907 novembre Elle écrit l’article « Youth and Young Manhood » [La jeunesse et les 

                                                
845 « Dr. Allan McLane Hamilton Finds Mrs. Eddy Competent » [Le Dr Allan McLane Hamilton constate que Mary 
Baker Eddy est mentalement alerte], Christian Science Sentinel, 24 août 1907, 985-986. 
846 Le litige M. B. G., 27 septembre 1907,1 ; Subject File, Eddy, Mary Baker – Lawsuits – “Next Friends” – Court 
Proceedings – Printed Materials – September 1907. 
847 Calvin Frye, carnet, 14 août 1907, EF079. 
848 « Unconditional Surrender of “Next Friends” » [Reddition inconditionnelle des « Proches »], Christian Science 
Sentinel, 24 août 1907, 983-985, 987 ; Archibald McLellan, « The Suit Formally Dismissed » [Le procès est 
officiellement radié], Christian Science Sentinel, 5 octobre 1907, 90. 
849 Le Conseil des directeurs de la Science Chrétienne à Mary Baker Eddy, 1er octobre 1907, L00550. 
850 « A New Publishing House » [Une nouvelle maison d’édition], Christian Science Sentinel, 12 octobre 1907, 110. 
851 « Diploma of Honor Awarded to Mrs. Eddy » [Un diplôme d’honneur décerné à Mary Baker Eddy], Christian 
Science Sentinel, 9 novembre 1907, 190. 
852 Ibid. 
853 Ibid. ; « France Honors The Rev. Mary Baker G. Eddy by Conferring Decoration » [La France honore la révérende 
Mary Baker Eddy en lui décernant une médaille], Christian Science Sentinel, 7 décembre, 1907, 270. 
854 Christian Science Sentinel, 8 février 1908, 444 ; Christian Science Sentinel, 4 avril 1908, 611. 
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jeunes adultes] pour le magazine Cosmopolitan.855 

1907, 6 décembre Publication de Christian Science: The Faith and Its Founder [La Science 
Chrétienne : La foi et sa fondatrice] de Lyman P. Powell.856 

1907, 9 décembre Mort de Joseph Armstrong.857 (A l’époque, il est membre du Conseil des 
directeurs, éditeur des écrits de Mary Baker Eddy et directeur de la  
Société d’édition.) 

1907, 12 décembre Septimus J. Hanna enseigne le Cours Normal.858 A partir de cette date, les 
cours donnés par le Conseil d’Instruction ont lieu tous les trois ans et les 
classes ne comptent pas plus de 30 élèves.859 Il était déjà stipulé dans la 
41e édition du Manuel de l’Eglise que le Conseil d’Instruction 
n’accepterait aucun élève pour le Cours Normal pendant trois ans à partir 
de décembre 1903.860 De 1903 à 1905, seuls des Cours Primaires sont 
enseignés.861 

 Elle appelle à la création d’« une institution de la Science Chrétienne au 
profit des pauvres et pour le bien général de toute l’humanité ».862 Cela 
suscite beaucoup de commentaires dans la presse. Alfred Farlow publie 
une déclaration concernant ce projet d’un Fonds de Charité.863 Elle 
renonce par la suite à créer une telle institution.864 

1908, 6 janvier Allison V. Stewart succède à Joseph Armstrong en tant que directeur et 

                                                
855 « Mrs. Eddy’s Article in the Cosmopolitan » [Un article de Mary Baker Eddy dans le Cosmopolitan], Christian 
Science Sentinel, 2 novembre 1907, 171. 
856 Bibliothèque du Congrès, Catalogue of Copyright Entries (Washington, DC: Government Printing Office, 1908), 
26 ; Subject File, Powell, Lyman P. – Papers – General. 
857 Commonwealth du Massachusetts, certificat de décès, 14 décembre 1907 ; Subject File, Armstrong, Joseph and 
Mary E. 
858 Livre de classe, 12 décembre 1907 ; Subject File, The First Church of Christ, Scientist – Board of Education – 
Classbook – 1899–1910 Photocopy. 
859 Mary Baker Eddy, Manuel d’église de la Première Eglise du Christ, Scientiste à Boston, Massachusetts, 57e éd. 
(Boston: Joseph Armstrong, 1906), 85. 
860 Mary Baker Eddy, Manuel de l’Eglise, 41e éd., 85. 
861 Livre de classe, octobre 1903 ; Subject File, The First Church of Christ, Scientist – Board of Education – 
Classbook – 1899–1910 Photocopy. ; ibid., décembre 1903 ; ibid., 7 décembre 1904 ; ibid., mai 1905 ; ibid., 
décembre 1905. 
862 Mary Baker Eddy à Archibald McLellan, 12 décembre 1907, L07116. 
863 « Mrs. Eddy’s Charitable Fund » [Le Fonds de charité de Mary Baker Eddy], Christian Science Sentinel, 11 
janvier 1908, 366. 
864 Adam Dickey au Conseil des directeurs de la Science Chrétienne, 11 août 1908, L01457. 
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éditeur.865 David B. Ogden est élu directeur de la Société d’édition 
quelques jours plus tard, succédant ainsi à Armstrong.866 

 William D. McCrakan succède à Stewart au Conseil d’administration de la 
Société d’édition de la Science Chrétienne.867 

 Clara Barton fait l’éloge de Mary Baker Eddy, dans un article de Viola  
Rodgers pour le New York American, le New York Evening Journal  
et le Boston American.868 

1908, 26 juin Elle emménage en ce dimanche à Chestnut Hill, près de Boston.869 Elle 
habite dans cette maison pendant deux ans et dix mois, jusqu’à son décès. 

1908, 30 janvier Le gouvernement français lui décerne officiellement la distinction 
d’Officier d’Académie.870 

1908, 5 février Adam H. Dickey vient rejoindre sa maisonnée à Chestnut Hill.871 

1908, 6 février Sa calèche « est passée au ralenti dans Falmouth Street », devant 
l’extension de L’Eglise Mère, comme le rapporte le Boston Herald  
et d’autres journaux de Boston le lendemain.872 

1908 avril Apparition d’un nouveau dessin de la Croix et de la Couronne sur la 
littérature de la Science Chrétienne.873 

1908, 4 avril Annonce de la publication d’une nouvelle édition révisée de la Concordance 
de Science et Santé, qui prend en compte les dernières modifications 

                                                
865 William B. Johnson à Mary Baker Eddy, 6 janvier 1908, L00559 ; Allison V. Stewart à Mary Baker Eddy, 17 
décembre 1907, IC004aP1.04.007. 
866 Le Conseil des directeurs de la Science Chrétienne à Mary Baker Eddy, 7 janvier 1908, L00560. 
867 Mary Baker Eddy à William P. McKenzie et Thomas W. Hattan, 5 janvier 1908, L07264. 
868 « Christian Science, Most Potent Factor in Religious Life, Says Clara Barton » [La Science Chrétienne, un facteur 
extrêmement marquant dans la vie religieuse, déclare Clara Barton [n.d.r. fondatrice de la Croix-Rouge américaine]], 
Christian Science Sentinel, 18 janvier 1908, 383-384. 
869 « Mrs. Eddy Moves to Greater Boston » [Mary Baker Eddy déménage à côté de Boston], Christian Science 
Sentinel, 1er février 1908, 423-427. 
870 « Mrs. Eddy Receives Insignia of “Officier D’Academie”, France » [La France décerne à Mary Baker Eddy la 
médaille d’Officier d’Académie], The Boston Post, 31 janvier 1908 ; Subject File, Eddy, Mary Baker – Awards and 
Honors – Diploma of honor and Officier d’Académie Pin (Order of Academic Palms). 
871 Calvin Frye, carnet, 5 février 1908, EF079. 
872 « Mrs. Eddy Sees Church » [Mary Baker Eddy voit l’église], Boston Herald, 6 février 1908 ; Subject File, Eddy, 
Mary Baker – Visits To: The Mother Church. 
873 « The Cross and Crown » [La Croix et la Couronne], Christian Science Sentinel, 30 mai 1908, 770. 
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apportées au livre.874 

1908 mai Etablissement de l’acte de propriété de la maison de Chestnut Hill,  
dans le comté de Middlesex, afin de le transférer aux administrateurs de 
ses biens.875 

1908, 14 juin L’Eglise Mère organise deux services de Communion dans l’extension.876 

Ce sont les derniers services de Communion de L’Eglise Mère. Les 
services de Communion ont toujours lieu dans les églises filiales. 

1908, 16 juin Assemblée annuelle de L’Eglise Mère dans l’extension.877 

1908, 17 juin Dissolution de l’Association générale des professeurs.878 

1908, 8 juillet Dissolution du groupe des Membres exécutifs (Premiers Membres).879 

1908, 28 juillet Elle demande au Conseil des directeurs de créer un quotidien 
d’information et de l’appeler The Christian Science Monitor.880 

1908 août La Société d’édition s’installe à l’angle de Falmouth Street et de  
St. Paul Street.881 Ouverture d’une deuxième salle de lecture au 
15 Exchange Street.882 

1908, 8 août Elle demande au Conseil d’administration de la Société d’édition de lancer 
le Christian Science Monitor.883 

1908, 18 août Publication de la biographie La vie de Mary Baker Eddy de Sybil Wilbur 
aux éditions Concord Publishing Company (John Dittemore et deux 
autres) (publié à l’origine en anglais avec le titre The Life of Mary Baker 

                                                
874 « New Concordance to Science and Health » [Nouvelle Concordance de Science et Santé], Christian Science 
Sentinel, 4 avril 1908, 610. 
875 SF – Eddy, Mary Baker – Residences – Chestnut Hill, MA – Legal documents. 
876 William B. Johnson, « Annual Communion in The Mother Church » [Communion annuelle dans L’Eglise Mère], 
Christian Science Sentinel, 20 juin 1908, 823-824. 
877 « Annual Meeting of The Mother Church », Christian Science Sentinel, 20 juin 1908, 824-825. 
878 William B. Johnson à Mary Baker Eddy, 17 juin 1908, L07190. 
879 Mary Baker Eddy au Conseil des directeurs de la Science Chrétienne, 3 juillet 1908, L00985. 
880 Mary Baker Eddy au Conseil des directeurs de la Science Chrétienne, 28 juillet 1908, L00596. 
881 The Christian Science Journal, septembre 1908, en couverture. 
882 Ibid., septembre 1908, xii. 
883 Mary Baker Eddy au Conseil d’administration de la Société d’édition de la Science Chrétienne, 8 août 1908, 
L07268. 
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Eddy).884 La Société d’édition de la Science Chrétienne en rachète les 
droits de publication en 1913.885 

1908 octobre Elle ferme la « Chambre de Mère » dans l’édifice original.886 

1908, 25 novembre Mise en vente du premier numéro du Christian Science Monitor. 

1908, 9 décembre Augusta E. Stetson rencontre Mary Baker Eddy pour la dernière fois.887 

1909 avril Irving C. Tomlinson commence à lire la biographie de Sybil Wilbur à 
Mary Baker Eddy.888 

1909, 31 mai John V. Dittemore remplace William B. Johnson en tant que directeur et 
secrétaire,889 après la démission de ce dernier.890 

1909, 7 juin L’Assemblée annuelle se réunit le lundi suivant le premier dimanche de 
juin, conformément à l’article XIII, section 1, adopté au mois de juin 
précédent.891 Le Monitor en fait état.892 

 Des journalistes envoyés par des journaux de Boston et d’ailleurs se 
rendent à Chestnut Hill, sur invitation, afin de voir Mary Baker Eddy et 
avoir la confirmation qu’elle est toujours en vie.893 Dans une lettre publiée 
dans le Sentinel, elle déclare que la Science Chrétienne demeure pour 
toujours, qu’elle-même soit présente ou non dans la chair.894 

1909, 13 juin Dédicace de Première Eglise du Christ, Scientiste, Londres, en Angleterre. 
La construction de l’église a coûté 400 000 dollars.895 

                                                
884 John Benbow à William R. Brown, 18 août 1908 ; Subject File, Wilbur, Sybil – Papers – Correspondence Re: 
Concord Publishing Company. 
885 « Notice », Christian Science Sentinel, 2 août 1913, 951. 
886 Mary Baker Eddy, « New By-Laws » [De nouveaux statuts], Christian Science Sentinel, 21 novembre 1908, 230. 
887 Mary Baker Eddy à Augusta Stetson, 9 décembre 1908, H00127. 
888 Irving C. Tomlinson, « The Woman and the Revelator », 12 mai 1932, Souvenirs, Irving C. Tomlinson, 822. 
889 Archibald McLellan, Ira Oscar Knapp, Stephen A. Chase et Allison V. Stewart à Mary Baker Eddy, 28 mai 1909, 
L00605. 
890 Ibid. 
891 Mary Baker Eddy au Conseil des directeurs de la Science Chrétienne, 13 juin 1908, L00974. 
892 « Mother Church Annual Meeting », The Christian Science Monitor, 7 juin 1909. 
893 « Misstatements Refuted » [Réfutation de déclarations inexactes], Christian Science Sentinel, 12 juin 1909, 804. 
894 Mary Baker Eddy, « Mrs. Eddy’s Statements » [Déclarations de Mary Baker Eddy], Christian Science Sentinel, 12 
juin 1909, 810. 
895 « Dedication of Church in London » [Dédicace de l’église à Londres], Christian Science Sentinel, 3 juillet 1909, 
870. 
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1909 août Mort d’Edward A. Kimball.896 

1909, 21 août Elle scelle le paquet renfermant le contenu de La Première Eglise du 
Christ, Scientiste, et Miscellanées.897 Elle écrit : « Nul n’ouvrira ni ne lira 
son contenu durant ma vie sans mon consentement écrit. »898 

1909, 25 septembre Publication d’un avis informant que la croissance rapide de la Science 
Chrétienne rend opportune la présence permanente d’un autre membre du 
Conseil des conférences en Europe.899 (La présence de Woodbury à 
Londres explique également cette décision.) Désigné pour cette mission, 
Bicknell Young s’installe à Londres.900 

 Le Conseil des directeur retire à Augusta E. Stetson son statut de 
praticienne et professeure de Science Chrétienne autorisée.901 

1909, 16 octobre Publication d’un « Avis » concernant l’approbation des statuts de L’Eglise 
Mère par Mary Baker Eddy et le fait qu’elle s’attend à ce que les 
directeurs soient garants de leur pérennité. En tant que leader du 
mouvement de la Science Chrétienne, elle n’est pas personnellement 
impliquée dans les affaires de l’Eglise, si ce n’est à travers ces statuts 
officiellement publiés.902 

1909 novembre Elle approuve la proposition du Premier Lecteur (Clifford P. Smith) de 
faire une collecte en novembre, lors des réunions du mercredi soir à 
L’Eglise Mère, afin de distribuer l’argent récolté tant aux employés 
(anciens et actuels) qu’aux membres de la congrégation qui se trouveraient 
dans le besoin.903 

1909, 17 novembre Augusta E. Stetson est radiée de la liste des membres de L’Eglise Mère. 
La fin de l’histoire est rapportée dans le Sentinel du 17 juillet.904  

                                                
896 Archibald McLellan, « Edward A. Kimball, C. S. D. » The Christian Science Journal, septembre 1909, 378-379. 
897 Lewis Strang, 21 août 1909, L00621B. 
898 Ibid. 
899 « Mr. Young to Work in Europe » [M. Young va travailler en Europe], Christian Science Sentinel, 25 septembre 
1909, 71. 
900 Ibid. 
901 Le Conseil des directeurs de la Science Chrétienne, 25 septembre 1909, IC002dP2.03.036. 
902 Mary Baker Eddy, « Take Notice », The Christian Science Journal, 16 octobre 1909, 130. 
903 Clifford P. Smith, « As I Recall It » [Comme je m’en souviens] n.d., Souvenirs, Clifford P. Smith 1, 40. 
904 Mary Baker Eddy, « A letter by Mrs. Eddy » [Une lettre de Mary Baker Eddy], Christian Science Sentinel, 17 
juillet 1909, 910 ; M. B. Eddy, « A New By-Law », [Une nouvelle disposition statutaire], Christian Science Sentinel, 
31 juillet 1909, 950 ; Archibald McLellan, « None Good but One » [Un seul est bon], Christian Science Sentinel, 31 
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Le Conseil des directeurs dépose une plainte contre elle le 8 novembre ;905 

les audiences commencent le 15 novembre,906 et la procédure s’achève le 
17 novembre.907 

1909, 1er décembre Publication de The Life of Mary Baker Eddy and the History of Christian 
Science [La vie de Mary Baker Eddy et l’histoire de la Science 
Chrétienne] de Georgine Milmine.908 

1909, 18 décembre La nouvelle édition de l’Hymnaire de la Science Chrétienne est annoncée 
dans le Sentinel. Il contient cinquante nouveaux cantiques.909 

1910 janvier Le service du dimanche après-midi devient un service du dimanche soir à 
L’Eglise Mère.910 

1910, 5 janvier La New England Women’s Press Association [Association de la presse 
féminine de Nouvelle-Angleterre] lui décerne le titre de membre 
d’honneur.911 

1910, 8 janvier Elle fait un don de 2 250 dollars pour l’agrandissement de la maison 
d’édition.912 

                                                
juillet 1909, 950 ; McLellan, « “Meek and Lowly in Heart” » [« Les humbles et les débonnaires »], Christian Science 
Sentinel, 16 octobre 1909, 130 ; « Two letters » [Deux lettres], Christian Science Sentinel, 16 octobre 1909, 131 ; 
« Correspondence between a Committee of Inquiry and the Directors » [Correspondance entre une Commission 
d’enquête et le Conseil des directeurs], Christian Science Sentinel, 30 octobre 1909, 170 ; « Further Correspondence 
between a Committee of Inquiry and the Board of Directors » [Nouvelle correspondance entre une Commission 
d’enquête et le Conseil des directeurs], Christian Science Sentinel, 6 novembre 1909, 190-191 ; The Christian 
Science Board of Directors, « To Whom It May Concern » [A toute personne intéressée], Christian Science Sentinel, 
13 novembre 1909, 210 ; « Letters to Our Leader » [Lettres à notre Leader], Christian Science Sentinel, 13 novembre 
1909, 211-212 ; M. B. Eddy, « A Letter By Mrs. Eddy », Christian Science Sentinel, 20 novembre 1909, 230 ; 
« Dropped from Membership » [Radiée de la liste des membres], Christian Science Sentinel, 27 novembre 1909, 
251 ; « Letters to Our Leader », Christian Science Sentinel, 27 novembre 1909, 251-252 ; Eddy, « A Letter by Mrs. 
Eddy », Christian Science Sentinel, 4 décembre 1909, 270 ; « Letters to Our Leader », Christian Science Sentinel, 4 
décembre 1909, 271-272. 
905 « Dropped from Membership », Christian Science Sentinel, 21 novembre 1909, 251. 
906 Ibid. 
907 Ibid. 
908 Service des droits d’auteur de la Bibliothèque du Congrès, Catalogue of Copyright Entries (Washington, DC: 
Government Printing Office, 23 décembre 1909), 1309 ; Subject File, Milmine, Georgine Collection – Book 
Copyright. 
909 « Special Announcements » [Annonces spéciales], Christian Science Sentinel, 18 décembre 1909, 318. 
910 The Christian Science Journal, janvier 1910, xxi. 
911 « Women Writers honor Mrs. Eddy » [Les femmes écrivaines honorent Mary Baker Eddy], The Christian Science 
Monitor, 6 janvier 1910. 
912 « Mrs Eddy’s Generous Contribution » [Une généreuse contribution de la part de Mary Baker Eddy], Christian 
Science Sentinel, 8 janvier 1910, 370. 
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1910, 15 janvier Dans un message important, portant la signature d’Adam H. Dickey,  
elle demande que les églises filiales adoptent une forme de gouvernement 
véritablement démocratique.913 

1910, 7 février Elle déclare qu’il faudrait plus d’hommes dans la pratique de la Science 
Chrétienne.914 

1910, 12 mars Elle publie dans le Sentinel un avis concernant la biographie de Sybil 
Wilbur.915 (Ses propos sont réimprimés dans Miscellanées, 297-298.) 

1910, 31 mars Elle donne son approbation pour la première traduction de Science et 
Santé en allemand.916 

1910, 4 juin Elle demande que désormais il soit de règle qu’aucune des lettres qui lui 
sont adressées ne soit publiée dans les périodiques, ce qui met fin à une 
rubrique apparue pour la première fois dans le Journal en 1886, puis dans 
le Sentinel.917 

1910, 11 juin Le compte rendu de l’Assemblée annuelle fait état de la croissance 
importante du mouvement, car 104 nouvelles églises filiales et sociétés se 
sont inscrites depuis le mois de juin de l’année précédente.918 

1910, 16 juillet Ses petits-fils, George Washington Glover III et Andrew J. Glover, lui 
rendent visite à Chestnut Hill.919 

1910, 29 juillet Elle se rend en voiture à sa maison du 385 Commonwealth Avenue et 
aperçoit l’extension de L’Eglise Mère depuis Fenway.920 

1910, 22 août Elle ajoute une dernière disposition statutaire au Manuel de l’Eglise 
(article VIII, section 22), stipulant que les praticiens doivent garder 

                                                
913 Adam Dickey, « Democracy in Church Government » [La démocratie dans le gouvernement des églises], 
Christian Science Sentinel, 15 janvier 1910, 390. 
914 Mary Baker Eddy, Miscellanées, 355. 
915 Mary Baker Eddy, « Mrs. Eddy’s History » [L’histoire de Mary Baker Eddy], Christian Science Sentinel, 12 mars 
1910, 550. 
916 Mary Baker Eddy à Allison V. Stewart, 31 mars 1910, L03271. 
917 Adam Dickey, « Take Notice », Christian Science Sentinel, 4 juin 1910, 790. 
918 « The Annual Meeting », Christian Science Sentinel, 18 juin 1910, 810. 
919 Calvin Frye, carnet, 16 juillet 1910, EF085. 
920 Calvin Frye, carnet, 29 juillet 1910, EF085. 
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confidentielles toutes les communications avec leurs patients.921 

1910 octobre Elle apporte quelques modifications à Science et Santé, qui seront prises 
en compte dans l’édition publiée en janvier 1911. En novembre, elle 
demande que sa photo soit retirée de Science et Santé, d’Ecrits divers  
et de tous ses livres parus ou à paraître.922 

1910, 1er octobre Elle fait publier un « Avis » : toutes les demandes concernant la pratique 
de la Science Chrétienne, le Comité de Publication, l’activité des salles de 
lecture, la qualité de membre de L’Eglise Mère, etc., doivent être 
adressées au Conseil des directeurs. Toutes les réponses aux questions 
sont traitées par le secrétaire de L’Eglise Mère.923 

1910, 5 novembre Elle fait savoir qu’un recueil de ses poèmes, intitulé Poems, est  
en cours d’impression.924 

1910, 11 novembre Mort d’Ira Oscar Knapp.925 

1910, 21 novembre Adam H. Dickey succède à Ira Oscar Knapp en tant que membre du 
Conseil des directeurs.926 

1910, 23 novembre Le Monitor publie un numéro spécial de 96 pages pour le jour d’Actions 
de Grâces. 

1910 fin novembre Elle donne son approbation à la révision finale du Manuel de l’Eglise  
(89e édition).927 

1910, 1er décembre Elle écrit ses derniers mots : « Dieu est ma vie. » Elle les écrit à son retour 
d’une promenade en calèche, qu’elle a faite en ce jeudi après-midi.928  

Ce sera sa dernière promenade. 

                                                
921 John Higdon à Mary Baker Eddy, 29 juin 1910, L07181 ; Mary Baker Eddy, 29 juin 1910, L07181A ; Mary Baker 
Eddy à Archibald McLellan, 29 août 1910, L07025. 
922 Adam H. Dickey à Allison V. Stewart, 10 novembre 1910, L07287. 
923 Mary Baker Eddy, « Take Notice », The Christian Science Sentinel, 1er octobre 1910, 90. 
924 Archibald McLellan, « Our Leader’s Poems » [Les poèmes de notre leader], Christian Science Sentinel, 
5 novembre 1910, 190 ; « Poems by Mary Baker Eddy » [Poèmes de Mary Baker Eddy], Christian Science Sentinel, 
ibid., 193. 
925 Calvin Frye, carnet, 11 novembre 1910, EF085. 
926 Ibid., 21 novembre 1910. 
927 Mary Baker Eddy, A09003.04, 204. 
928 Mary Baker Eddy, 1er décembre 1910, L00637. 
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1910, 3 décembre Elle dit à ceux qui l’entourent : « J’ai tout dans l’Amour divin ; c’est tout 
ce dont j’ai besoin. »929 Elle meurt dans sa maison de Chestnut Hill dans la 
nuit du samedi. 

1910, 7 décembre Bicknell Young enseigne le Cours Normal.930 

1910, 8 décembre Un service de funérailles a lieu dans la journée, qui est un jeudi.931 Des 
éditoriaux provenant du monde entier, ainsi que certains de ses anciens 
écrits, seront publiés dans le Sentinel jusqu’en mars 1911. 

                                                
929 Ella S. Rathvon, 3 décembre 1910, L13841. 
930 Livre de classe, 7 décembre 1910 ; Subject File, The First Church of Christ, Scientist – Board of Education – 
Classbook – 1899–1910 Photocopy. 
931 « Mary Baker Eddy », Christian Science Sentinel, 10 décembre 1910, 283 ; « Mary Baker Eddy », Christian 
Science Sentinel, 17 décembre 1910, 303. 
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